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STARTING WITH PHOTOSHOP ELEMENTS

What is Photoshop
Flements?

Let's take a moment to get to know a little more about the software
and how it can help you with your day to day image editing.

Adﬂbe Photoshop Elements is a
great option for those who want
an extensive toolset that can take
on most of their image editing needs,
without the requirement of highly
advanced features such as you would
find in Photoshop CC. It is also a great
choice for those who only need one-
click solutions to their image editing
needs, or perhaps want to start to

learn how to take on the more involved
technigues and tools that Elements has Ad O bE’ = h otos h 0O P - le ments 2019
to offer. Another big plus point in its
favour is that it is one of the very few
remaining Adobe products that can be
purchased outright, without the need
for subscription.

A Worthy Alternative

There was a time when, in certain
quartars, Elements was considered a
dumped-aown version of Photoshop
with a limited toolset, that was

only meant for beginners with no
aspirations to aavance to the more
technically advanced techniques seen
in Photoshop. However, recent versions

of Elerments have shown that it is a

wortny standalone alternative to using ‘jh
Photoshop, It is a focused image editor
and cataloging application that is more QD
than capable of taking on any iImage
aditing task you care to send ks way

In Its current form, Adobe Photoshop
Flerments is comprised of two main
components. One is the image editing
moduie of the saftware where you
CAn [OUSN LR WoUr DROLOS Or evern
manipulate and transform them beyvond
recognition. The Edit section is broken
down into three sections. The first is
the Guick Edit mode, then comes the
Guided Mode section and finally thare is
the Expert mode.

Make the Most of Modules

Each moadule has its own set of tools
and preset options that can quickly get
the job done. Quick Edit, as the name
suggests, cantains the basic editing

Adobe Elements

Organizer 2019
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The Adobe Photoshop Elements and Organiser interfaces are
designed to be as intuitive as possible with plenty of options
for beginners and experienced users alike.

tools such as colour correction, cropping.
guick selection, spot healing, sharpening and
lighting fixes. You can also apply some ane-
click presets such as Smart Fix, Exposure
and Lighting.

Helping Hand

The Guided module s also fairly self-
explanatory, Here you can make any numiber
of popular image adjustments to your
photos, with guided step-by-step tutorials,
such as altering brightness and contrast,
resizing photos, rotating and straightening
vour images and adding vignettes. It also
fhas a number of specalised and fun options
for restoring old photas, creating your own
frames and replacing backgrounds,

More Advanced Options

Finally comes the Expert mode. This has
more of the feel of its big brother, Photoshop
to 1L It has a toolbar rangea down the left
hand side of the workspace and on the right
Is the layers panel that behaves much in the
sarme way as Photoshop's lavers palette. Here
VOou alse have access to a number of photo
colour presets such as Faded Photo, Glow
and Monotaone Color, There are also a numbear
of filters for maore artistic effects such as
coloured pencils, watercolours, distortion
effects and sketch filters. You can also add
Bevels, Patterns, Strokes, Photographic
Effects and much more by accessing the
icons in the lower right of the taskbar at the
bottorm of your workspace. Expert mode

Is the most hands-on of the three modes

YOU can employ and gives you access to

all the tools, so you can apply all your own
advanced edits to your photos.

Getting Organised

The second main component of the latest
Adobe Photoshop Elements s the Elements
2NS Crrganiser. At Its heart, this 15 a
cataloguing and photo crganising program
that lets vou import, sort, tag and rate your
photos. If you wish, you can create albums
and uUse names, |locations, date, time and GPS
data to sort them, The program can even
employ face recognition to find and sort
photos of people and tag them much as you
would in Facebook. Indeed, you can actually
import your list of Facebook friends as an
aid to tagging the people in vour photos. If

wonw . bdmpublications.com
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it detects a similar name being entered
as a taq, it will display those existing
names similar enoughn as a match to be
an option for tagging

The two components of Photoshop
Elements and Elements Organiser
are saparate programs, which can be
a bit of nuisance if vou need to keep
switching baetween them but you nave
at vour disposal a set of paowerful

editing tools that will keep beginner and
expert hapoy.

Owver the page we'll begin to delve
deeper into the workspaces offared by
the Editor and Elemeants Organiser. It is
Best to consider the Editor module as your
chgital darkroom and design stucho and to
think of Elements Organiser as yvour liorary,
where you keep all your media items such
as photos and videos.

BOM's Made Eagy Series | Volumsa 21 'E
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STARTING WITH PHOTOSHOP ELEMENTS

The Elements
Home Screen

We start the journey by becoming more familiar with all the module
environments you will be working with.

Welcome Home

When you open Adobe Photoshop
Elements 2019, you are presented with a
Home screen. This simple screen is your
gateway to the Photo Editor program or
the Organiser. The third option available
is to activate the Adobe Premiere
Elements Video Editor, if you have
purchased that as well. If not, it will ask
if you want to download a trial version.

You also have the option at the
top of the Home screen to search for
help on things you want to achieve in
the programs or to click on any of the
featured Try This guides and What's Maw
itermns and Inspiration articles ranged
across the screen.

o the extreme top right of the page
are buttons for Facebook and Twitter
and a Help button that takes you to
Adobe Customer Support.

o Search Option

From the home page you can can search
For things vou need to learn more about.
If you want to learn how to make a
calendar for instance, type that in the
search bar and it will show yvou links to
help files that can tell you more.

9 Featured Guides

Ranged along the top of the home page
are a number of clickable guides and
inspirationzl meadia that gets you into the
heart of what Photoshop Elements 2019
is all about. There are several themes
vou can access. Try This are guided
tutarials that help you create exciting
media and art. What's New highlights all
the step-by-step features that are new
to this versicon. Inspiration is a collection
of stories and articles to get you in a
creative mood.

BDOM's Made Easy Series | Violume 21
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o Auto Creations

When vou open the home page for the
first time, you will be prompted to add
media for Auto Creations to make 3
series of personalised creations, such as
slide shows that use your own photos
and videos.

o Add Media

Auto Creations are created with media
(photos or videos) that you've imported.
If vou haven't imported any media yvet,
click Add media under Auto Creations on
the Home screen and relaunch the apn.
You can open and ecit any Aulto Creation
and instantly share It with your family
and friends.

o Program Chooser

To the right of the home page are the
icons for Organiser, Photo Editor and
Video Editor, You can click on these to
activate the relevant program. If you do
not have the Adcbe Premiere Elements
video editor program for instance, it will
ask you If vou want to try If for free with
the option to purchase later if you wish.

o Recent Files

Any images you have been working on
recently will be displayed here for guick
access. Click on the image yvou want
to continue working on and it will be
opened within the relevant program

WHAT'S NEW

Add luma fade transitions

000

£ v o

Add a spei

THE ELEMENTS HOME SCREEN

o Facebook Button

Click this button to go to the Adobe
Chotoshop Elements Facebook page,

o Twitter Button

When vou click this button, it will take
vou to the Photoshop Elements Twitter
feed where oL can view, reply to,
retweet and like tweets,

o Help Button

If vou need further assistance, you can
click this button to be directed to the
Adobe Customer Support webpage.

Explore the Guides

For those who are in need of more guidance, or just
some creative inspiration, go ahead and click on any of
the featured guides and articles to explore more of the
online world of features Adobe Photoshop Elements has

to offer.

Adobe Premiere Elc:

fande

¥ mtreduction 1o AdoSe Premiesre Bements

5 Fade Transition effect - Guided E

¥tic scene transition by feding in the colors!

d edit to create a cool transition effect between two video clips, two imag
on effect creates a dramatic scene transition by fading In the colors from d:

information, see Create d Luma Fode Transiron effect - Guided Edit.

5

Video
Editor

Photo

Organizer Editor

o RECENT FILES

T dawtish 1.jpg
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STARTING WITH PHOTOSHOP ELEMENTS

The Quick
Mode Workspace

For fast and simple edits, this is the mode to get you editing
quickly, with one-click results for better photos.

OnE':IiCk Puwer l. .IrdnhemtnuhupElzmun 1 ¢ File Edit image Enbsnce Lmer Select  Fillss Ve Window  Hedp

Although this mode is designed to :

be quick and simple to use, it is still a Oy ([ LEaum S s B
powerful method to rapidly improve D 7‘

your photos with easy one-click Retore
presets that give you instant feedback >~ '
on how your image will look with the

new adjustments applied. There are
many filters to choose from and many
ways you can adjust your image to
make it perfect, so you can share it
with the world.

e ol R

o

o The File Menu

Although a number of file menu option
will not be accessible, the main ones
that vou need will be available. All the
Enhance options are thare as well as the
Filter Gallery presets.

o Mode Selector

Here can vou can exit the current maode
and choose to enter the Guided or
Expert modes.

o The Open Button

This is a simple button to specify a new
proyect to work on. Click it to create a
new document at the size Wiol want.
When you click OK, the document will be
created and can be worked on in either
Guick mode or Expert mode.

o The Toolbar

The Quick modea tooibar has a core set
of tools to get yvour image looking great Hand

with rmimimal effort. You can make gquick m
selections to specific areas of the ghoto, e :
crop it straighten the horizon, whiten
teeth and fix eyes as well a5 addaing text

|_-ﬂ

i1 Serepn 7l Sewen Print Sine

; e aap i ; == r ..
and a number of varied filters, textures B 5. D C B 4
and adjustments. Phots Bin Too Options. Undo  Fndo  Soisin  Onganizer Home Screan o
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o The Tool Options Bar

For every tool you activate in the toocibar,
vou have another panel called the Tool
Options bar that gives you many more
choices as to how that tool can be
madified and controlled. There are also
adaitional tools that can be accessed in
the Tool Cptions bar.

G The Taskbar

The taskbar is situated at the botbtom

of the workspace and contains all the
mast frequently used actions, which are
displayed as buttons. Click each one
and you can see all the images yvou are
working onat that time, display or hide
the Toolbar Options bar and Undo or

redo any steps you have performeag on
YauUr image. You also have the option
to rotate the Image and activate the
Elements Organiser if you need to,

o View Options

Clicking on this button reveals the View
options. This is useful f you want to
compare a before and after view of your
currently active image, to see how much
the image has changead from its original
untouched state

o Active Image Area

The iImage vou are woarking on is
displayed in this area. It will either be as
|

3 single image ar, if you nave chosen 3

s A B OO

bdlumimes  Effects Texbies Frames

wonw bdmpublications.com

THE QUICK MODE WORKSPACE

different view option, as two images that
represent the before ana after state of
the photo.

o Zoom Slider

This slider lets yvou quickly zoom your
mage from 1% all the way up to 3200%.

@ Create and Share

These two dropdown menus display
opticns for creating slide shows, photo
books, greetings cards, calendars,
Facebook Covers and much more, You
can also share yvour works of art on
Facebook, Flickr and Twilter.

0 The Panel Bar

This panel changes content depending
on what adjustment or effect you are
wsing. If yvou are Jsing the Adjustment
tools, then they will be displayed in

the right hand panel bar. lterms such as
Smart Fix, Exposure, Lighting and Colour
will be avalzble here and each can he
clicked to reveal (ks availlable options, The
Effects menu, Textures and Frames are
aiso available to be accessed here,

Create and Share

Don't forget to check out the Create and Share
options. Whether you want to share your creation
oniine and on social media or make prints of your
photos or even calendars, click the buttons to
explare further,

= L

—= Photo Collage

=
@ Photo Prints
IE]  Photo Book
l Greeting Card
&< Photo Calendar
= D Jacket

o, DVD Jacket

D/DVD Label

BOM's Made Eagy Series | Volumsa 21
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STARTING WITH PHOTOSHOP ELEMENTS

The Guided

Mode Workspace

This mode is great for accomplishing a variety of effects, with
a handy guide for each one you use.

o Category Selector

Here can yvou can select which effect you
want te apply to yvour image, There are
six categories of effects to choose from.

o Basics

Contains the Basic effects Brightness
anga Contrast, Correct Skin Tone, Crop
Photo, Levels, Lighten and Darken, Resize
Your Photo, Rotate and Straighten,
Sharpen and Vignette Effect

o Colour

This category contains Enhance Colour,
Lomo Camera Effect, Rernove Colour
Cast and Saturated Film Effect,

B Ak Bemrdog Plaerasis Wil i

By or pEwia o wrm awa
G 0 Reatild

L'rerm w bm rovlame o e o
VT B D P T

7, T T

e % T

u"“ A"

Tad g dulie bl el el

T P e ke e
T

AR e L WAL RO L AT b el D T T DT L2

R e e o sowed

o Black & White

This seclion has a number of effects
centred around monochrome. Black and
White, B&W Colour Pop, B&W Selection,
Hicih Key, Line Drawing and Low Key,

9 Fun Edits

You can find a lot more creative edits
under this category. You have some
diverse effects to try out such as Double
Exposure, Effects Collage, Meme Maker,
Multi-photo Text, Old Fashioned Photo,
Qut of Bounds, Painterly, Fartial Sketch,
Photo Text, Picture Stack, Pop Art,
Puzzle Effect, Reflaction, Shape Overlay
Effect, Speed Effect, Speed Pan and
Zoom Burst Effect

reees [P TER taper
. s e B - e ¥
LS
] . b= " TR il
| y

o

ML -PHOD TEAT

e e Ll et T TR
R

- - i
"0 FREHITH ER MSOTR

yEE pekn e e e by ey i mn
2 Bl

= e

el pn i (G o g s s

o Special Edits

More specialised image manipulation
aeffects are kept in this section of the
Guided edit workspace. It contains
Replace Backaround, Depth Of

Field, Frame Creator, Orton Effect,
Perfect Portrait, Recompose, Replace
Background, Restore Old Photo,
Scratches And Blemishes, Text

and Border Overlay, Tilt-shift and
Watercolour Effect

o Photomerge

The Photomerge section mainly
concentrates on blending two or more
phwolos or extracting and merging
subjects from one shot into another

Famr b wg g o e e E
S Wil T A L

i e i @ ke pank

NEE ETINN

Bl o e e i s
il LA,

B Do N
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There's Photomerge Compose,
FPhotomerge Exposure, Photomerge
Faces, Photomerge Group Shot,
Photomerge Scene Cleaner and
Photomerge Panorama.

o Open

fwou choose to select a new image from
the Lpen meani d4r|r‘|g a guided edit, you
will be asked If you want to discard the
current guide, in order to start a new one
with the image you are about to open.

o Zoom Tool

Click the Zoom Tocl icon or press Z to
activate the zoom tool, You can magnify
the image up to 3200%. Wherever you
click with the mouse, the image will be
magnified and the point you clicked will
he placed in the centre of the workspace,
Press the Alt key on your keyboard to
decrease the magnification factor.

@ Hand Tool

Click the Hand Tool icon or press H to
be able to move your magnifiad iImage
around. With the Hand Tool active, click
and drag your photo to mowve it around
within the active image area:

0 View Options

Clicking on this bullton reveals the View
options. This is useful if you want to

ompare a before and after view of your
currentty active iImaage, to see how much
the image has changed

THE GUIDED MODE WORKSPACE

@ Photo Bin view

Where appropriate, this menu button
displays options an how to view

any currently active images that are
contained in your Photo Bin.

@ The Taskbar

The taskbar is situated at the bottom of
the workspace and contains all the most
frequently Used actions,

@ Active Image Area

This is where the image you are working
an will be displayed,

@ Zoom Slider

This slider |laets you guickly zoom your
image from 1% all the way up to 3200%

@ Guided Steps Panel

Whichever effect you choose to apply
to your image, the steps required to
complete it are displayed as numbered
steps in the guidance panel on the

right of the active Image area. You can
follow the steps, clicking the appropriate
buttons and altering parameters until
vou are ready to commit the changes

@ Next and Cancel

Click Next to commit the changes of the
guided edit you have st applied or click
Cancel to cancel the edit entirely and V’
beqgin again.

@ Save

Once you have clickeg MNext, you can
choose to save your image or save it
under a new name and/or image format
You can also elect to continue working
on the image in either Expert or Quick
mode, You can also choaose Share to
upload it to Facebook, Twitter or Flickr.

@ Done

Simply returns you to the Guided
category page. If vou look in your

Photo Bin, vour image will have a small
brush iconin its top right corner, which
indicates it has edits applied. If vou close
the image and haven't saved it, you will
be prompted to do so if you wish.

Create = Share -
Picture Stack &

What would you like to do next?

Save:

View: After Only

LR S ) e T R

2 Rl Beedis BR2T

Frw carm o
i Chymgm Emppams

e o Loor

After (Roll over to

1. Select Number

I!"l

» Q
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STARTING WITH PHOTOSHOP ELEMENTS

The Expert
Mode Workspace

For those who have developed their skills to the point where they
are comfortable getting more hands-on with their images.

# Adobe Photoshop Elements 201 1 File Edit image Enhance Laysr  Select  Fier  View  Window
The File Menu - >
Dpen
i . VIEW .

Mast of the File menu cotions will be Q&
made available to you in this particular iR
workspace, since all the tools and ['—
effects parameters are there to be used ] -
manually with little or no guicance from = 5
the program. EWHANCE

-I} I
) The Open Button P

o =

Commaon to each workspace, click on =
the Open button to view any recently 7 3 3

active images you have been working on 5

AR s Elamis AL @ K
or to create a new blank file ready to be

worked on. s R
.-j-'l “"_l
o The Tools Panel o
_ _ O
This panel contains all the essential togls "

you are going to need for powerful and
flexible image editing. It s broken down | !
into View, Enhance, Draw, Maodify and J g e
Colour sections, e ¢

o Document Tab

Each image that is open will be markeg
by a document tab to identify sach
image, It will display the filename cf the
photos currently open

o Active Image Window

This displays the current iImage you are
working on.

9 Document Info

You can choose what information about
WOLIF active document Is UISFS ayeq nere

o Tool Options Panel

This panel 15 context sensitive ang
displays additional options and controls
for each tool that you select from the
tool panal

& 5 ) W OE

Fhaobo Bin - Tiood I:Ip'du.'d: Lo Rpdo Arimin Layout Organker Home Soresn

3 SN o Jioln iz
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o Photo Bin

TI’"“ Photo Bin panel displays thumionatls
of all open |:"“|Cl"l3 currently being used
by the prograr

o Undo/Redo

Clicking the Undo button allows yvou to
step back through any actions you have
performed on your image. Kedo allows
vou to step forward

@ 10 Rotate Tools

Allows you to rotate vour image in 45°
steps alther clockwise or anticlockwise,

Hiastogram |

0 Layout

have a number of documents

.rnan at one time, you can choose from a
number of layout opbions to display them
all at once within your active image araa.

@ Switch to Organiser

L

Clicking on this button will open up the
Elements Organiser program where you
can view and salect images that you
have imported and catalogued.

@ Home Screen

Click this button if you want to return to
the Home screen,

Cranna. | Cokors

Huey Sidwrmtinn

Charne® | Wase:

Huge =

| 1

¥ x @ ¥ + [&E

Lapoes  EHocos Fibers Siyles DGraphics Mo

wnw. bdmpublications.com

THE EXPERT MODE WORKSPACE

@ Layers

Cne of the key aspects of more
advanced image editing is to be able to
work across multiple layers within your
active document

@ Effects

This will display all the effects options
currently installed. They range from
rubber stamp effects 1o pencil sketch
effects and colour tints, which can all be
applhed to yvour photos,

@ Filters

Ranging from artistic effects to brush
strokes and distortion and pixelation
aptions, clicking the Effects icon will
display all the creative effects availaole
to be applied to the image.

@ Styles

Fhare are a numiber of colour, texture
and special effects that can be appliec
to any subject that is currently an a layer
Thay range from fibreglass textures to
fire, chrome, bevelled edges and tints

@ Graphics

These are background graphics that can
e downloaded and used as bhackdrops
iIn Your compaositions.

@ More

A DOp up mend where Yyou can open
more currently hidden panels,

@ Layer Options

This panel allows you to add new layers,
group selected layers, adjustment layers
and masks.

@ Layers Panel

This is Wﬁer-? layvers are viewed and
consists of the base backaround layer
and any subsequent layer copies, brand
new lavers or layer adjustments.

@ Layer Properties

For each layer adjustment yvou add, yvou
have the corresponding properties panal
to control its effect

When you click on any of the Layers, Effects,
Filters Styles and Graphics buttons, the main
panel on the right of the screen will display the
corresponding panel for each one you choose. Our
example is currently displaying the Layers Panel.
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STARTING WITH PHOTOSHOP ELEMENTS

The Expert

Mode Toolbar

All the main editing tools you need in Expert mode are accessible
from the toolbar on the left of the workspace.

or Photoshop, the main components

of the toolbar will be familiar to you.
There have been updates and additions
to the tools available but most will be
recognisable for what they are and you
should be able to get to grips with the
newest ones without too much issue.
Although each tool has additional options
displayed down in the Tools Options
Panel, if you hold the Alt key and click on
a toolbar icon, you can cycle though all
variants of that particular tool to get to
the one you want. Here is a breakdown of
the toolset available in Adobe Photoshop
Elements 2019.

I f you've used older versions of Elements

B Adobe Photoshop Elements £UN8 Edior  Foa  Edil

EDOM's Made Easy Series | Violume 21

VIEW | ENHANCE
Q | &
_ SELECT | |“! -
il e @

0 X

o

H %

DRAW
/ i

I
&
!1

MODIFY

O 5
x I';i;il-

When you click on any of the Layers, Effects,
Filters, Styles and Graphics buttons, the main
panel on the right of the screen will display
the corresponding panel for each one you
choose. Our example is currently displaying

‘| fthe Layers Panel,

The Tool Options bar

The Tool Options bar

appears at the bottom of the
Photoshop Elernents window
and It displays the options for
any selected tool in Expert and
Quick mode

1 Active Tool

The currently active tool 1s
Righlighted.

2 Related Tools

Any related tools associated
with the meain tool, selected
from the toolbar, will be
displayed here.

3 Additional Optiens

For ary tool that you havea
selected and have active, there
are a number of additional
options that let you control
various parameters relating to
that particular tool,

TM | )
Heahgﬂnlsh .
I — .
E O Craste Yol &P s
(O Content Aware ©
= |_| Sample
B 5 ¢ 9D
Tool Options Undo Redo  Rotate Layout Organizet




Key to Symbols

H (@7 [27 [6F &

View Tools

The tools found in the View Tools section
of the toolbar are designed for basic
magnification: zooming in and out of
vaur photo and moving it around the
screen to view a portion of the zoomed
image at your chosen magnification.

1 Zoom (Z)
2 Hand (H)
Select Tools

This section covers all the tools that
allow vou to select all or parts of your
image for targeted editing, cutting out or
duplication to new |layers,

T Move (VD

4 Rectangular Marguee (V)
5 Elliptical Marquee (W)
6 Lasso((bL)

7 Polygon Lasso (L)

B Magnetic Lasso (L)

9 Quick Selection (A)
10 Selection Brush (A)
N Magic Wand (A)

12 Hefined Selection (A)
13 Auto Selection (A

Enhance Tools

use targeted contrast effects on yvour
photos and much more.

14 Eye(Y)

15 Spot Healing Brush (J)
16 Healing Brush (1)

17 Smart Brush £F)

18 Detailed Smart Brush {F)
19 Clone Stamp (5)

20 Pattern Stamp (5)

21 Blur (R

22 Sharpen (R)

23 Smudge (R)

24 Sponge (R

25 Dodge (R

26 Burn (R

Draw Tools

The set of tools found in this section of
the toolbar are for enhancing the image.
You can heal, clone, blur, sharpen and

The Draw section of the toolbar contains
various elements that let you paint, draw,
arase and sample colours in your photos.
Ihe text tools are also in this section.

27 Brush (B)

28 |mpressionist Brush (B)

29 Colour Replacement Brush (B)
30 FEraser (F)

31 Magic Eraser (E}

32 Background Eraser {E)

33 Paint Bucket {K)

34 Gradient (&)

35 Evedropper/Color Picker (I3
36 Custom Shape (L)

37 Rectangle Shage (L)

38 Rounded Rectanale Shape (L)

39 Ellipse Shape (U

40 Polygon Shape (L)

41 Star Shape (W)

42 Line Shape (L)

43 Shape Select (U}

44 Horizontal Type {T)
45 ‘Vertical Type (T)

46 Horizontal Type Mask (1)
47 “ertical Type Mask (T)
48 Text on Selection (1)
49 Text on Shape (T)

80 Text on Path{T)

51 Pencil (M)

Modify Tools

This set of tools is primarily concerned
with how you can affect the crop and
intelligently move items in the frame for
different compositions.

52 Crop (C)

83 Cookie Cutter (C)

54 Perspective Crop (C)

55 Recompose (W)

56 Content-Aware Move (Q)
57 Straighten (&)

Colour Tools

Here you can set your foreground and

background coiours,; swap them over if
required, access the colour picker and

set back to gefault as required.

S8 Colour Tools
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STARTING WITH PHOTOSHOP ELEMENTS

The Flle

Menu Layout

Get yourself familiar with the file menu system and you will see
just how powerful the program can be.

dobe Photoshop

Elements has many one-

click solutions to make
yvour photos look their best
but over time you may find the
need to dig deeper into the
more advanced options that are
on offer with the Photo Editor.
Many options are presented in
the taskbar at the bottom and
the panel bar on the right. If
vou need them however, the
File Menu is where you can find
all the vital tools.

Adobe Photoshop Elements

About Photoshop Elements...
About Plug-in

Legal Notices...

Preferences

Services

~oaH
#H

Hide Photoshop Elements
Hide Others

Quit Photoshop Elements #0

From this menu you can see
the About screen and manage
any Plug-ins as well as update
your Preferences and quit
Fhotoshop clements, You can
a2ls0 view any legal notices or
hide the waorkspace,
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% Adobe Photoshop Elemants 2018 Editor

About This Msc

System Praferances..

App Store..,

Recent [tems

File Edit. Image Enhance Layer

440 jng & BE6 7% [Lovels 1, Layer Mask/a) *

*

Force Cuit Adobe Photoshon Elements 2008 Editor L O8#9

Sleap
Restart...
Shut Down...

Lock Scosen
Log Out Mark Frost...

Open... # 0
Open in Camera Raw... LHO
Open Recently Edited File »
Duplicate...

Close # W
Close All

Save # S
Save As...

Save for Web...
File Info...

Place...

Organize Open Files...
Process Multipie Files...
Import

Print...

Contact Sheet Il...
Picture Package...

One of the key menus you
access at the start and end of
a session. You can create new
documents, open existing ones
and save them, You can also
import or print your documents
and create contact sheets.

Undo Rectangular Marquee 37

Revert {3EA

Cut £ X
Copy ot C
Copy Merged 3 C
Faste #e W
Paste Into Selection {38V
Delete

Fill Selection...
Stroke [(Outline) Selection...

Clear

Color Settings...
Preset Manager...

Start Dictation...

I many ways, Edit 15 guite
similar to the options avallable
on a word processor, You can
copy. paste, delete or merge
images. You can also fill
selections, alter colour settings

and undo actions.

Select  Filver View

Window Help

& meoniemient-uE sy -5 T g & 50 (RGAaE] -

Rotate

Transform

Crop

Recompose

Divide Scanned Photos
Resize

Mode
Convert Color Profile

Here vou can make many
changes to your photos. You
have various rotation and
transformation options along
with cropping and resizing, You
can also convert the colour
mocle or profile of the image.



Auto Smart Fix New oA
Auto Smart Tone... Duplicate Layer... %D Filter Gallery...

Auto Levels Delete Layer —
Auto Contrast Correct Camera Distortion...

Auto Haze Ftemm'a! Rename Layer...
Auto Color Correction Inverse 31 Adjustments

Auto Shake Reduction i Artistic
Auto Sharpen . _ =
Auto Red Eye Fix m:: :';jtaf;; e All Layers Blur
5 Brush Strokes
Adjust Color Deselect La?e rs :
¥ TR Distort
Adjust Lighting _ -
Adjust Smart Flx.. Type Feather... E#ED Noise

Convert to Black and White... - Pixelate
Haze Removal... Refine Edgﬁ Render

Adjust Sharpness... Layer Mask MHliny » Sketch

Open Closed Eyes... Create Cli ina Mask 51}"”3&
Adjust Facial Features. ., FPe Grow Texture

Shake Reduction... Grﬂup LE'!.FEFE Slmliar Other
unsharp Mask...

Deselect

¥ ¥ Y Y Y Y YYIYIYTYYTY

Hide Layers

v

Transform Selection Digimarc
Arrange
Merge Down

Merge Visible
Flatten Image

Save Selection...

Many of the main adjustment A vital aspect of image Every time vou make a This menu has all the creative
opticns are found here. They manipulation s the ability to selection of all or part of yvour and fun filters that can add
range from contrast, brightness add lavers of effects to vour Image, you can modify its new life to yvour photos. Add
tone, sharpnass and colour. Youl Image. Here you can add new propertias here. You can feather  blur, sharpening, distortion
can also access the Open Closed lavers, fill layers and agdjustment  the edages, expand or contract and artistic effects at the
Eves feature and much more. lzyers for non-destructive edits. it, invert it and save it. click of a button.

Shortcuts

New Window for mill-1620440.jpg Images Search

Zoom In i n

Zoom Out A Pth‘ESth Elements Help... ;vr:*‘aﬂn?:;:;ﬂﬁm: Eln:mgig

Fit on Screen Actions Getting Started... each menu and sub-menu will

Actual Pixels Adjustments Key Concepts... always display the keyboard short

cor e aireicbenmotle
Vi Spition A Video Tutorials... a good idea to become familiar with

Rulers EITIS Forum those short cuts

Filters
Graphics
Histogram
History
info

v Layers
MNavigator
Styles

Grid

Home Screen...
Snap To

System Info...
Manage My Account...
Sign Out (mark.frost@bdmpu

Lock Guides

Mew Guide...

+ Panel Bin
Reset Panels

hong-kong-1990268.|pg
v mill-1620440.jpg

some of the basic zoom in This menu lets yvou contro Should you need it, you can
and zoom out cptions are the visibility of certain tools enter search parameters for
kept here including being able and panels and turn them on any issues you encounrtsr There
to view the print size of your and off as neadad. The major are also a number of options
image or turn the visibility of adjustrnent panels, including presented to you that can healp
rulers, grids and selecticns on Effects, Layers and Filters, can vou In certain situations should
and off, oe controlled hera they arise.
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STARTING WITH PHOTOSHOP ELEMENTS

Guided Mode
Categories

Here is a quick reference sheet of all the current guided tutorials
available in Adobe Photoshop Elements 2019.

Your Guide

Easy-to-follow guides

At the time of writing, there are
currently 53 guided edits available in
5. Adobe Photoshop Elements 2019, Just as the name
1 File > They can be accessed from suggests, the Guided
- the Guided workspace mode is designed to help
page and are you produce a number
distributed under of creative and artistic
98\ |3 six categories. effects by taking you

After {Roll over to see Before.

1. Select Number of Pictures

=l B a? N
e Ao~ | @ee

~ ¥ il Each one through the process in 4 Pictures B Pictures 12 Pictures
ny has a small numbered steps. It is
9p G LY before and a semi-automatic edit 2. Change Border Wik
y after slider where you tlick various i
that gives you a available options and . -
guick overview of E_]'EMEntB does the
what each effect is rest for you. Sl it =

designed to achieve.

3. Change Background
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Brightness and Contrast
This lets you adjust the brightness of yvour photo and

o control how much contrast i1s present. You can view the
after image only or view both the before and after images either
vertically or horizontally.

Crop Photo
o A crop box will be drawn on your photo so you can resize

that box to whatever size and proportion yvou like, You can
restrict it to certain proportions and change the overlay to Grid
or Rule of Thirds.

9 The Lighten and Darken option can be viewed as a more
simplified version of the Levels adustrment option. You
are given three sliders that affect the brightness of Shadows,
Midtones and Highlights,

GUIDED MODE CATEGORIES

Correct Skin Tone

o Your photos may suffer from a colour cast that can make
your hurman subject’s skin look a little off in terms of

its colour tone, This guided edit can alter the tan, blush and
lightness of skin.

Levels

o This uses a levels adjustment whereby yvou can alter the
shadows, highlights and middie tones brightness of your
salactad image. Any adustments are made globally across the
entire image.,

1* "

Resize Your Photo

o You can output for web and print and will be presented
with a couple of options that control the final size of your
image. You can specify width and height pixel dimensions and
apply the result,
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STARTING WITH PHOTOSHOP ELEMENTS

Rotate and Straighten Sharpen Photo
o You have the options to rotate vour photo clockwise and o You can use an Auto Fix sharpening effect or vou can use
anticlockwise and if you have a sloping image, you can usa the supplied slider to manually increase the amount of

the Straighten Tool to bring it back to level sharpening until yvou have it how vou want it

Vignette Effect Enhance Colours
o This lets you add a soft dark or light horder to your image. @ You have an Auto Fix option to make a best-guess at
You can control its intensity and use sliders to change the the correct colour balance and contrast in the photo.
softness of the vignette and its roundness. Otherwise, yvou can use the Hue, Saturation and Lightneass sliders
to fine tune i,

Before

A

Lomo Camera Effect Remove a Colour cast

0 This replicates the effect of the popular and cheap cameras @ & colour cast is an unwanted bias towards a tone that
that create a very specific look due to their low guality spoils the look of your photo, You can use the colour picker
manufacture. You can also add a vignette tc the photo. to find an area of pure gray, white or black to remaove the cast
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Saturated Film Effect

@ Applyving this effect makes yvour photo look as though

it was shot on old slide film for a much more saturated
look, You can add the effect a number of times to increase the
intensity of the effect,

M [ | v S < o
SBefore .= & '+ oAfter’

. b

B&W Colour Pop

Select a preset colour or use the colour picker to keep one

colour and turn the rest of the image to black and white.
You can refine the effect and also increase the saturation of the
remaining colaur,

High key images are characterised by their very bright
appearance with very little shadow detail left in the photo.
You can use a colour or black and white high key effect

GUIDED MODE CATEGORIES

Black and White

® This 15 a guick bBlack and white caonversion with four
prasets ranging fram light to darlk, If yvou want, you can
add a diffuse glow to the image for a dreamy effect or increase
the contrast,

B&W Selection

@ You can use a selection brush to selectively pick out

the areas you want converted to black and white whilst
retaining colour elsewheara, You also have the option to invert the
effect if required.

Line Drawing

@ This effect mimics the loolk of a pencil drawing. Click to
convert the photo into a pencil sketch and if you want to,
you can add a small amount of colour back into the image and
darken the lines,
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STARTING WITH PHOTOSHOP ELEMENTS

Double Exposure

@ Works in the opposite manner to a high key image. It is @ You can combine and bBlend two images together far a
characterised by small amounts of highlight detail and is more creative effect. You can use a preset image or one
dominated by darker tones. You have the colour and black ana of yvour own photos and superimpose it over the subject in your
white options, main composition,

Effects Collage Meme Maker

With this effect, your chosen image is split into a number of @ Great for creating memes for social media. This tool guides
sections chosen by yvou and then a number of effect stvles vou Dy letting you create a meme template, edit your text
are added to each section of the collage. and resize the main subject's photo. You can apply new borders
and add effects for a memorable look,

Multi-Photo Text Old Fashioned Photo

@ Yol can create visual text using this guide, placing a Converts your photo using one of three black and white
different photo inside each letter. Add your text and then presets: also lets you adjust the tone of the conversion and
one by ong, you c¢an place a photo Inside each |letter. You can the tint colour of the image to create an old fashioned photo

also add a new background and add effects to the text,
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GUIDED MODE CATEGORIES

Painterly
@ This effect can take vour primary subject and make it look @ Turn your photo into a painting with this artistic effect. It
lika it is escaping from the frame of the photo. You can add provides you with a number of preset brushes to paint onto
a frame and then select the area of the shot you want to extend vour photo, Choose a canvas colour and texture and then add an
outside the frame and add a shadow for more depth, optional effect to enhance the painterly feel.

Partial Sketch Photo Text
@ This gives you a choice of effects that vou can apply to @ Use vour photo as the basis of creating some creative text
vour photo. Then you can simply paint using a brush over effects. Choose your font and how you would like it to
yaur image where yvou want the chosen effect to appear. You appear on your phote, then select the background style. You can
can work with more detail if required and change the size and also choose the intensity of bevel drop shacow and outline of
opacity of the brush you use, your text,

Picture Stack Create Pop Art
@ Turn your photo into a collage with the Picture Stack @ =0 psychedelic and turn yvour photo Iinto some fun pop art.
affect. Choose the number of pictures you want your photo Chooase from the styles available and then caonvert it into
divided intc and then add a border to each element. Then you a monachrome or posterised version. You can also add a neon
can add a solid or gradient background for the finishing touch. glow if you wish, or tint it a single colour,
wiwnw.bdmpublications. com BDM's Made Easy Series | Violume 21
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STARTING WITH PHOTOSHOP ELEMENTS
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Puzzle Effect

9 Your photo can be turned into a jigsaw puzzle with this
effect. Choose the puzzle piece size you want to usa,
Extract pieces for a more creative effect and arrange them by

moving them to another part of the design and rotate the pieces

it neaded.

Shape Overlay Effect

@ Choose from a series of different shapes and then position
it over yvour photo and scale it to the required size. Then
yvou can add an effect to both the inside and outside of the
shape's area, before cropping it to your preferred proportions

Speed Pan

@ Add motion blur to yvour backgrounds to give the
impressian of fast motion, Select your main subject using
the selection tools and then add maotion blur to the background,
keeping your main subject sharp.

EDOM's Made Easy Series | Violume 21

Create Reflections

@ Add reflections to vour photos for eve catching results,

Simply add the reflection and then use the tools provided

to colour the reflection, fill the background and then make the
reflection lock more like alass or water,

Speed Effect

@ Add some great blurred speed lines for a little more zoom
in yvour photos. Use a selection tool and choose an area of
vour image to apply the effect to. Then you can add the speed
effect and then precisely refine the look of your finished effect.

Zoom Burst Effect

@ This mimics the effect of rapidly zooming vour camera lens
while you take the photo. You can crop your photo in arder
to put your primary subject in the centre of the shot and then
add the zcom burst effect, Refine the area of focus and add an
aotional vignette,



GUIDED MODE CATEGORIES
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Depth of Field Frame Creator

@ You can make vour subject stand out in the photo by making @ Use yvour own photos and graphics to create frame designs.
the distracting background blurred as if photographed with Use the tools to select the areas you want to be yvour frame

very shallow depth of field, ¥You can add simple blur or use maore and then save that frame desian ¢ vou can work on it further In
precise selections for maore targeted effects. Expert mode
)
After,
i b

Create Orton Effect

Xz el
Perfect Portrait

Baszed on an old slide film technique picnaered by Michael @ For great looking skin in yvour portrait photos use these

Crton, you can add a soft and dream-like quality to vour tools to heal blemishes in skin, remove red eye and whiten
photos. Apply the Ortan effect as many times as you wish and teeth. For a glamorous ook to your shots, you can also add &
then use the sliders to enhance the effect even further, alow effect and even shim vour subjects down if required.

Recompose Replace Background
@ This works much in the same way as Photoshop's content- @ With this set of tools, vou can select your primary subject
aware scale tool This tool lets you scale an image but using one of a number of selection tools and then remove
maintain the important content and detail in the pheto, You alsc their background. Select a new background or texture and
have the option to mask areas for greater control, then place it behind the original to match the colour tones for a

convincing rasult.
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STARTING WITH PHOTOSHOP ELEMENTS

Restore Old Photo Scratches and Blemishes

@ If vou have a number of old scanned photos that have many @ For any small blemishes and flaws in a photo, use this togl
plemishes on them, then this tool can make them look new

again. Using healing tocls, blur tools and clone stamp copies, you orushes. Larger areas will benafit frorn the application of the
can improve those old photos with ease, nealing brush,

o
)

o —
L

e
R YL

-

.

Text and Border Overlay Tilt-shift
Choose from a selection of border designs to frame your @ Turn your images into miniature effect photos using this
favourite photos. Choogse its size and colour and then add specialised blur tool. It works best on photos taken from
a text overlay using the type tool You can then specify the text's above your subject and from a distance. It mimics the effect of
position and edit the text style used. expensive Lilt-shift lenses. Modify the focus area and add blur,

contrast and saturation.

Watercolour Effect Photomerge Compose
@ A o simple and effective way to turn your favourite photos @ This allows you to select two photos you wish to work on
into watercolour paintings. Choose an effect. add a and extract from one photo and place it on another to
watercolour paper overlay and a canvas texture. Then you can comoing the two. You have selection tools to help yvou accurately
refine the effect and add captions in various text styles. extract yvour first subject. then you can place it, move and scale it

on the second photo.
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GUIDED MODE CATEGORIES

Photomerge Exposure Photomerge Faces

@ This is a form of high dynamic range photography. This tool @ Combine facial features from two different portrait photos
lets yvou combine bwo or more different exposures of the for humoraus results, Select two faces and open them. You
same shot to create a much more exposed version. Use automatic can then use the alignment tool to pick out three distinct areas
or manual modes for the final result on each face and then blend them together,

Photomerge Group Shot Photomerge Scene Cleaner
Use multiple group shot images to make sure everyone has @ If you have a series of photos of the same subject but there
their eyes open or is looking at the camera. Select two or are distractions in each, vou can combing two or more
sirmilar group shots taken together. Set one as the final image photos to clean up the scene. Use one base image and blend in
and use additicnal photos to merge preferred elements into the the best parts of additional photos to create a finished result.
final photo.
Before After
ﬁm‘hhﬂﬂlmm nutme
andmhfﬂmaﬁm What would vou like to do today?
avallable on the Home e.g. | would like to make a greeting card
screen. There is plenty.
1o pique your interest,

Create a watercolor effect

Photomerge Panorama

Turn any photo Into a beautiful, textured
watercolor — and even add text. Try now

@ reat for creating super-wide panoramic shots, Combine
a sequence of several photos that capltures a very wida
pancramic scene oy ""‘nE[’Qi“"lQ them. Select WOLT phﬂtDS choose
your panorama layout and type of settings and the program

does the rest for yvou. cre, ..
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Most modern digital cameras allow you to shoot in a
picture format known as Raw mode. Raw mode is a pure
digital readout of the data captured by the sensor. This
additional data offers amazing scope when it comes

to getting the very best out of your photos. Step inside
your very own digital darkroom and take control of the
final look of your photos. More than that, see how you
can integrate Adobe Camera Raw (ACR) and Photoshop
Elements for a professional looking workflow solution.
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Contents

34 The Camera Raw Interface 37 The Profile Browser
34 Inthe Raw 38 Camera Raw Processing
35 Control Tabs 43 Raw to Photo Editor

36 The Histogram
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USING ADOBE CAMERA RAW

The Camera
Raw Interface......

Let's take a look at the ACR interface, see what it has to offer and
also how it can integrate with the Elements Photo Editor.

& Adobe Photoshop Blements 2018 Editor  File  Edit imape  Layer
-] Caimsra R 3,

In the Raw

Adobe Photoshop Elements 2018
comes with Adobe Camera Raw
supplied. It is more usually referred

to as ACR and lets you process Raw
files from digital cameras as the first
step of your digital photo processing
workflow; but you don't have to stop
there. You can process your Raw file
and then continue to work with it in
the Photo Editor in either the Quick
or Expert editing modes. It is easy to
get started. Let's take a look at the
ACR interface, see what it has to offer,
and also how it can integrate with the
Elements Photo Editor to help you get
more out of your favourite photos.

o Zoom Tool

A standard zoom in and zoom out

tool that lets you view your image

at increasing or decreasing levels of
magnification. Each time vou click the
zoom tool, the image will be enlargec
to the next level of magnification.
Wherever you click on your image,

it will magnify and centre it in the
workspace using that clicked point. If
you press Alt on your keyboard, vou
can decrease the level of magnification
and zoom out. Right-click the image to
call up the context menu to display all
the preset zoom levels available.

o Hand Tool

The Hand Tool allows you 1o move your
magnified image around the screen by ore Bt I s
clicking and draggindg.

BE =% MRK2070.NEF

34 EDM's Made Easy Series | Violume 21



1 - Pakan DEsk

9 White Balance Tool

To help you remove colour cast from
vou photo, you can use the White
Balance Tool to bring the image back
tao a more nautral colour cast. Click on
the tool and then place the eyvedropper
cursor over an area of your picture that
1s either meant to be white, middle grey
or solid black. It will use that reference
point to neutralise any colour cast
Right-click the screen to call up the
content menu to aisplay all the white
bhalance presets available to use,

o Crop Tool

If vou need to crop yvourimage 1o
different proportions, you can use the

Crop Tool to drag a crop box over your
image and using the control points on
the box, scale anad rotate it to get the
perfect crop for your photo. Right-ciick
on the cropped image to call up the
context menu to view mare DFDDﬂrtiﬂﬁtﬂ
cropping options and to Clear the RO if
you need to start again,

e Straighten Tool

This is particularly useful if you have
strong vertical or hornizontal elements in
vour photo that need to be levelled so
they are perfectly vertical or horizontal.
Click the Straightan Tool and then click
and draw a hine along the part of your

photo that needs to be straightened out.

= 300

Y i
b 213 L e
B 27 H03 E-F0eEES m
L B E
Badwe =

TIETI s B Coioe Biack B Wb

=
Byaith-  Adoos Stamarg a3

‘Wi Balance. | Tumom

Temoeranin . 200

AillE BSTHL
Eapidaia 1]
Corrt i wF
Hhegtv it -H3
-_
S s +AR
Whikay +30
=40 ]
Gy #30
el e s 2H
aturghon + T8
A
|
o
[ —h
Dona Cancel |, Opsr frrags |

200
171 1/200s
g i 2
S MH
Basic =
Treatment: © Color Black & White
Profile:  Adobe Standard o
1 White Balance: Custom
Temperature 6200
. e
.' .l
Tint -1
e -]
Aute  Default
+0.80
+7

tions.com

3

THE CAMERA RAW INTERFACE

o Red Eye Removal Tool

If vou happen to have & photo of a
family member or friend whose eyes are
coloured red because a camera flash
illuminated the blood vessels at the back
of thair eyes causing the red-eyve effect,
you can remove the redness using this
tool. Clhick and drag a marguee selection
over each eye and the program will do
the rest,

o Open Preferences

Opening this dialog box allows you to
set some Camera Raw Freferances such
5 where yvour image settings are saved
a-’wd whether you aqtﬁmaulcally sharpen
all images. You can also set other auto
functions such as tone adjustments and
also specify how DNG files are handled.

o Rotate Image

Lets you rotate yvour photo clockwise or
anti-clockwise in 20° increments

Control Tabs

-B3



USING ADOBE CAMERA RAW

The Camera
Raw Interface ...

Our journey around the Adobe Camera Raw interface continues
with more of the tools to bring the most out of your photos.

o FuII Screen Mnde ] .d:lbuF'hnluu-!ll:lu Elements 2018 Editor Fle Ef Image Laye

Clicking this button lets yvou toggle the
Full screen mode, When you do, no file
menus will be visible until you toggle
full screen off again.

@ Shadow Clipping

Shadow Chpping 1s there to warn you If
amy of the darkest tones in your photo
becorne solid black. A blue highlhight
will appear to warn you which parts of
the photo are clipped.

[
o The Histogram l e
|

Carnara Rira 10

This 1s a graphical reprasentation of the
distribution of colour and tonal values
throughout the image. The amount |
of tones in any given part of the tonal

range are shown as peaks along the
length of the histogram

@ Highlight Clipping

This works in the same way as the
Shadow Clipping warning. If any of

the brightest highlights in the image
are solid white, or get pushed to soliad
white as a result of editing, they will be
displayed as red highlights.

@ Information Panel

The |left side of the panesl shows the
RGE values of the image at the cursor
position. The right side of the panel
displays the exposure information for
the image such as aperiure, shutter
speed and 150,

v B Biis/Channel

16 Bits/Channel

200%
300% Depth: 8 Bits/Channel
400%
800%

1600%

MR REF

Fit in View

Sawve image. . Dapin: | & Pag/Channae
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Profile menu allows you to choose from

@ Control Tabs

The ACR interface breaks down the
workflow process into discreet sections,
First is the Basic panel where the
majority of your processing will be
done, You can control all the basic
exposure and colour adjustments

here. The Detaill tab reveals sliders

for controlling Sharpening and Noise
Keduction. The Camera Calibration tab
lets yvou specify the calibration process
YO are using.

a number of preset colour profiles and
a series of artistic, modern and vintage
effects too.

@ Zoom Levels

Instead of using the Zoom Tool, you can
use the Zoom Level options.

QView and Settings

The buttons let yvou cycle through the
avallable before and after view options,
awap the before and after settings, copy

@ Treatment and Profile

Gives you the choice of processing your
photos in the main colour workspace or
in the Black and White workspace. The

the current settings to the before image
and toggle between the current settings
and the default settings.
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THE CAMERA RAW INTERFACE

@ Help and Save

Help accesses the Adobe help files for
ACR processing, whilst the Save button
allows you Lo save your current egits o
DMNG file format.

@ Depth

Choose from 2 Bits/Channel and 16 Bits/
Channel colour depth

@ Done, Cancel, Open Image

Cone Commits all edits and exits without
opening the file. Cancel guits without
accaplting any changes and Open Image
will apply changes and open the image
in the Photo Editor,

The Profile Browser

view all the standard and artistic calour presets
you can use on your photo to alter its colour. There

are a number of camera matching well

as artistic, modem, black and white and \'hlng_g.'

Adobe Haw

¢ Camera Matching

P Legacy

Artistic

Artistic 07 Artistic 08
> BEW
P Modern

¢ Vintage




USING ADOBE CAMERA RAW

Camera Raw
Processing

ACR lets you process Raw files from digital cameras as the first step

of your digital photo processing workflow; but you don’t have to stop
there. You can process your Raw file and then continue to work with it in
the Photo Editor, in either the Quick or Expert editing modes.

% T

BEFORE AFTER

&
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Create glass pane effects Add a spe
Photo o \Video
!
eal

RECENT FILES

T _MRKZ070.NEF ) hong-kong-1990268.,

3 switzerland-B62B 70D jpg ‘a polynesia-30£ 1072 jpg

E dog-3277416.1pg ﬁ monument—yvalley-53

o To begin, you'll neea to open Photoshop Elements 2019

and from the home page click on the Photo Editor icon, this
will activate the Photo Editor program. The default = to open in
Expert mode, You can access Adobe Camera Raw (ACR) from
either the Quick, Guided or Expert mode workspaces.

>
B

! O raw

Shared Folder

e The Raw filg, in this case a seascape shot in Cornwall, will
open in the ACE workspace, as ACH runs in a separate
window to the Elements Photo Editor, You can use the zoom
tools to fill the active image area of the workspace; you can
clearly see the effect your edits will have on the photo.

bdm lications.com

L

CAMERA RAW PROCESSING

File Edit
HNew |
Open... 30
Open in Camera Raw... . Y“HO
Open Recently Edited Fi® (2

ents 2018 Editor

Image Enhance Layer Select Filter °

Process Multiple Files...
Import

Contact Sheat I1...
Picture Package...

o Go o Fle > Open in Camera Baw (At + Tmd + ) to open
vour file browser andg navigate to the folder that contains
the Raw file vou wish to process. Once you have located it,
double-click the file or highlight it and press Open at the bottom
right of the browser window.

B Adobe Photoshop Elements 2019 Edito

9 G

. =ik "o
Straighten Tool [A)

o A good place to start with a landscape shot like this is

to ensure a nice level horizon. If yours is sloping, use the
Straighten Tool (A). Click on one side of your honzon ine, then
drag across to the other side and release the button to bring it
back o level,

BDM's Made Easy Sevies | Volume 21
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USING ADOBE CAMERA RAW

R: ---
71 1f3
A 7
35 IS0 31 15
Basic Basic
Treatment: £ Color
Temperature S700
Tint 1

Contrast

e e e ]
Highlights 0
Shadows i

o Click on the Basic tab to make sure it 1s the active tab and
yvou will see the range of adjustments available; you can use
these to get the most out of your image. The photo 1s slightly
underexposed, s0 a good place to start is to increase the value of
the Exposure by moving the slider to the right.

[ ] e r P bty | e ST R

b (O

g #71 1200 s
T 150 31 15-30@15 mm

Basic =
Treatment: £ Color Black & White
Profile: =~ Adobe Color v B

o If vou turn on your Highlight clipping warming (O3 and vour
Shadow clipping warning (U, yvou will be shown any areas
aof your image that are turning solid black or solid white. These
areas will suffer a loss of detail so having the warnings turned on
s useful to avoid degrading the image.

I e w00 —

o Mow, as you maove the slider and increase the exposure,

ary areas that are becoming too overexposed will now

be ighlighted in red. You can often get away with just a slight
overexposure in your images but beware of pushing it too far and
destroyving the Image

BDOM's Made Easy Series | Violume 21

o An alternative to viewing the highlight clipping warning is
to press and nold the Alt key while moving the Exposure,
Highhghts and Whites sliders to see just the affected highlight
areas without the image itself being seen. It does give you the
chance to fine tune the expasure without taking it oo far,



CAMERA RAW PROCESSING

B iy reem g I e o0l T

& e Bt A

- B TR

e M R |

o IT vou are adjusting the Shadows and Blacks sligers, too
rmuch underexposure will be highlighted in blue by the
Shadows clipping warning. Solid black areas are much like
nighlighted areas: vou can have a small amount of solid black
areas but beware of heavy underexposure,

Temperature 5700
——— e i
Tint ]

Default

Exposure +0.95
Contrast 0
Highlights 0
Shadows 0 |
e e i e ._
Whites | 0

—_— .
Blacks 0

If vou want ACE to do some of the heavy lifting for you,

o there is always the option to click the Auto button. When

vau do this, the program will attempt a set of best adjustments

that it thinks will suit the image for optimal exposure. T is
certainly a good baseline for you to continue editing,

wonw bdmpublications.com

@ Holding down the Al key while making Shadows and
Blacks adjustrments, just the darkest areas turning solid
black will be seen to warn you there 15 a potential Shadows
clipping problem

Temperature 5700
T
Tint -1

Auto Default

Exposure +0.78

T — i
Contrast a
Highlights -75
Shadows +55
I EE .
Whites -10
-
Blacks 0

@ Adustments are 2 personal thing of course but we opted
to Increase the Exposure, reduce the Highlights to -75, to
recapture detail in the lightest parts of the image, and pushed
Shadows to +55 to make sure detall was kept in the darkest areas
of the shot. Whites were also reduced slightly to help keep detail
in the brightest parts of the scene,
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USING ADOBE CAMERA RAW

Vibrance

Saturation 0

@ Mext are the three sliders that affect midtone contrast
and how vivid the colours ara. Clarity is a refined version
of global contrast, affecting the middle tones for more detall,
Vibrance affects muted colours first and Saturation is a more
general adjustment for much more vibrant colours.

= -:E Detad 25
Rz we= ;
= ik O P [ B m o
B S0 3 1530875 mm :
L ﬂ'] Noise Reduction
Datadl Dhotail = Luminanoe o
Sharpening
Amgunt A
-
Rotius 1.0
o Colar 25
Deptail 5
' Color Daral 50
Masung o
Calnl Smobthness B0
Molse Raduction
Lewminancn o

The Detail and Masking sliders control artefacts caused
by over-sharpening. The Noise Reduction settings let you
control image noise present in high 1S0O photos. Beware of very

g o 71 1200 s
R 5031 15-30@15 mm
Detail Detail =
Sharpening
Amount 40
A | Al

Click on the Detall tab to control Sharpening and Noise
Reduction in your photo, Sharpening is essentially an
increase of contrast between the brightest and darkest edges of

VOUF Image.

5 WET I ZOUS =
B e ISO 31 15-30@15 mm
Calibration =

Version 3 (2012)
Version 2 (2010
Version 1 (2003)

@ The Calibration tab is bast left at its most current version.
For ACR in this form, Version 4 is the most up to date
Process that offers the most recently improved tools and
functions within ACR. Changing it to older versions will result in
certain improvements not being possible.

high noise reduction settings that can make your photo look
Calibration

muddy and lacking in detail.
Image Settings @

| Camera Raw Defaults l
Previous Conversion
+ Custom Settings

Save New Camera Raw Defaults
Reset Camera Raw Defaults

0 To the far right of the adjustment panals, 15 a small icon
comprised of four lines. When vou click on this, you can call
up your image's settings, Save New ACR defaults and reset to
the standard default settings.
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o
QO & B ‘e =0C
v Normal

1101
2103
3to4
4105
Gto7
91016

ﬁ_-'-'

L

¥ Constrain to Image
« Show Overlay

Cnce you have adjusted the imadge to your taste, one final

option s o crop your image. Jse the Crop Tool {(C) to draw
a crop box over your image to remove any unwanted area of the
photo and create a more pleasing compaosition.



L.App ly changes and dismiss dialog without

CAMERA RAW PROCESSING

Apply changes and open image. Option-click to

opening image.

- = = i

Done Cancel |

(e

open image without updating image metadata.

{ﬂpeg | rﬂage)

Done Cancel

@ If wou are happy with vour photo and the edits yvou've made
v can simply click the Done button and your adjustments
will be saved in what is known as a Sidecar file with an XMP file
extension, This file remembers the edits you've made and applies
them non-destructively to vour Raw file when openad.

- N .
P

@ You alse have the option to click Copen Image and continue
to work on the photo in either of the Quick, Guided or
Expert modes on offer In the Elements Photo Editor. You can
then save the result as a PSD file or jpeg, We've decided the sky
needs to be worked on so we're going to open it

Hue/Saturation...
Gradient Map...
Photo Filter...

Imvert
T wonon by s [

The image file will now open in the Elements Photo Editor,

VWe're going to worlk on it in Expert mode because we will
nead a few extra adjustrments and layers to achieve our geal of
making the sky more dramatic.

Levels 1

@ The 'Levels T layer will appear above your base image
which will be on a default locked layer called ‘Background',
You will see that it is split inte a laver thumbnail and a layer mask
thumbnail. The layer thumbnail controls the levels properties and
the layer mask controls masking properties.

@ The first thing you need to do is create a new adjustment
layer, Click on the Create New Fill or Adjustment Layer
icon to expand the dropdown menu and you will see a number
of adjustment laver choices, Click on Levels to add a 'Levels 1
adjustment layer to the layer stack in the right hand panel,

Lavels

Output Levels:

@ When you create an adjustment layer, its properties are
displayed ina paneal that will appear when it is added to
the layver stack, In the case of a levels adjustment, there are
three sliders that control brightness of the shadows, middle
toneas and highlights.
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@ Mowve the migdle tone shider from the middle to the right;
a5 you <o 50, the whole image will get darker. You can also
drag the furthest right highlight slider to the left slightly to make
the clouds a bit whiter. Concentrate on how the sky is looking
and don't worry about the rest of the image for the moment.

x sk

COLOR

%

S

=

@ To do this you must first make sure your Foreground
Colour is set to Black. You can click the Switch
Foreground icon or press X on your keyboard to swap the
default foreground and background colours arcund so black Is
now the foreground colour.

BDOM's Made Easy Series | Violume 21

@ Once you have the sky looking darker and a bit more

dramatic, yvou will see that the rest of the image is too
dark. What you can do now 15 use the layer mask to only let
the levels adjustment affect the sky and level the rest of the
image unchanged.

Dpacity: s——— ) 100%

sz abaa
N R e e

@ Mext vou need to click on the Gradient Tool (&), When
you do, the Tool Opticns Pane! will display all Gradient
Too! options. Chick on the Eait button and rmake sure you have
Foreground to Background set as the gradient. Then make sure
the Linear Gradient outton is clicked.



@ Make sure the 'Lavels 1 laver mask s clicked to make it
active and then click and drag a line with your gradient tool
that starts just below the horizon and ends just above the level of
the lighthousea,

If yvou look at vour image now, the sky is darker at the top
and transitions to normal at the horizon and the rest of the
image is untouched. The mask you added only lets the
adjustment yvou made affect the sky at the top and fades to
zero effect where the layer mask is black,

iments 2019 Editor | Flle Edit Enhance
MNew 2
Open... aE O
Open in Cameara Raw... R 8]

Image Layer Select Filter

Open Recently Edited File >
Duplicate...

@ 32% (Levels 1, Layer

Save
Save for Wel,

File Info...

Place...

@ If vou are happy with the image, you can go to File > Save
As (Shift + Cmd + 8) and save your composition as a

Photoshop PSD file with the lavers and adjustments intact, which

allows you to return and adjust it still further if you wish.

lications.c

CAMERA RAW PROCESSING

RS

| —
i ﬂm
U[

Opacity: |100

Levels 1

When vou let go of the mouse, a gradient will be drawn

on the layer mask that fades from bilack to whita along the
points you clicked with your mouse, Wherever masks are useg
remember that black conceals and white reveals.

@ It doesn't have to end there. You can add another Levels
Adjustment layer and tweak the overall brightness of the
image. You can then go back to the 'Levels 1 adjustment and

make the sky even darker by sliding the middle tone tab even
further to the right.

@ Your ACE to Elements workflow example is complete. You
have processed the original Raw file non-destructively,
opened the resulting processed file in the Elements Photo Editor
and made further targeted edits using adjustment layers,

BDM's Made Easy Series | Violume 21

45









48

GETTING ORGANISED

The Organiser

orkspace

Before you dive in and start using the Organiser and its tools, it's
worth taking a look at the workspace and how its tools are arranged.

Find it

Use Elements Organiser to organise and
share your photos and media files. You
can view thumbnails of all your favourite
images and media you've imported. You
can view a large thumbnail of a single
media file or smaller thumbnails of
many media files. You can fix the most
common problems in the media files by
using the tools in the Instant Fix tab of
the Task panel.

@ The File Menu

The Flle menu options appear in the

top left of the menu bar. These are the
basic methods for interacting with the
program, managing your catalogues and
fimding, tagging and viewing all of your
media files

@ The Import Button

From the drop-down menu, you can
choose to import photos from varnous
files and folders on your computer, from
your camera and card reader, Another
option lets vou search your hard drive.

@ Albums and Folders

Click the Albums button to view any
Photo Albums you may have created.
Click on Folders to display a folder view
of your files.

@ Folders View

Click a Folder name to display just the
photos within that chosen folder. Click
the All Media button at the top of the
media browser window (o display all
imaaqes from all folders.

@ All Media and Sort By

If wou are viewing the content of one
folder, yvou can click the All Media button
to leave the selected folder and see all
photos, Next to the All Media button is

a Sort By drop-cdown list where vou can

BDOM's Made Easy Series | Violume 21
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sort according to Newest, Olcest, Name

and Batches of photos.

() Tool Options panel

.|"‘-|:"|

The tools arranged on the left at the
bottom of the screen represent the

main tools for tagaing and organising
your photos. You can hide the Folders
panel, Undo steps, Botate your images,
Add location data, Add an Event, use

the Instant Fix feature, open the Photo
Editor, create a slideshow or return to the
Home screen,

“*‘1& Status Bar

This small bar displays Inforrmation such
as the number of

temns in the madia

wonw bdmpublications.com

orowser, the date range of all media and
the View MNMotifications button,

ﬁ« Category Tabs

At the top of the Organiser window are
five clickable tabs. Media -:_“‘-_:-C'Lj'_-,*' either
a foldar or the entire catalogue. Click
this tab to view photos '-.-*-.fi"lf_-I'F;‘ you have
identified faces, Click the Places tab to
tag an image with a place on the map.
Finally, you can click the .—"'E“"‘I‘"-' tab to
|<_~:|IL_~ choto tagged as Events.

g Media Browser Window

The contents of your catalogue or a
sinale folder will be displayead in the main
DrowWsar win Ij oy
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THE ORGANISER WORKSPACGE

(72 Search
e’

Click this button to open the Search pane.
You can enter a search parameter or click

on any of the search types listed down the
left hand side of the search panel

y Create and Share

These two buttons reveal drop-down lists
where you can create slide shows, photo
Looks, video collages and more, Mate
that certain creations require smu&u
Pramiere Elements to be installed for
video-based tasks, The Share button lets
vou emall ang share vour media on social
media and image sharing

£+3 Ratings and Auto Curate

:l{_

-4 &
SILE5.

filter your search by
ges nave
automatically

Hatings lets you
any star ratin _15 YOUr Ima
been given. Auto Curate

chooses ’rI » best ohotos for vh:u “f‘n:ﬂ
can specify how many are shortlisted, up
1o 500 h.m, the fcsulw are displayed in

the t'.lr-:'}-:-ff-'.E’ W MO

() Panel Bin

o

When vou click the Keyword/Info
button at the lower right of the
workspace, a panel opens providing
x,am. with a number r“f -'iuff&rn,-:-'r Ways

o add kevywords and tag photos. An
rfarmabion pane s provided where
nfarmation ab ':u’r a selected photo can
e displayved

You can adpust this slider to see yvour
image thumbnails larger or smaller in the
Crowser winodow

() Keyword/Info

Panel Bin

A0S OF

Click this button to open the
and choose options from the
nformation panel

Tagging and Keywords

A media organiser is only as -
good as the tagging and g" .
keywords associated with &' & # #= & # - AM‘%
your images. Spend F,;“-*'*
some time tagging -
your images 1o &,;E W Tags o Inform:
reap the benefits y
when it comes ,;5 v Keywords
to searching B Nature
and retrieving Ll H
them again. L] @ Color
y I_I H Photography
Ty | | Other
3 :H"".:. 'Ii
i W
’?}lﬁﬂﬁ- 1.":;
*’%L:;jgu es 4
J;.--L-_._ _j-';r
met
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GETTING ORGANISED

Setting up
Elements Organiser

Elements Organiser 2019 gives you complete control over how you
import, search, tag, organise and share your photos and videos.
Organiser scans your files and analyses your photos and can even find

faces ready for you to identify.

8o

T Create multi-photo text Elements Organizer keeps track of your media through a | New..
Catalog. e
| Convert...
Most people keep all their media in one Catalog, which can e
have thousands of photos and videos. You might want a
separate Catalog for a special purpose, such as business
photos and videos, Each user of the program can have their
own Catalog.
i . Photo : Vid —Catalogs i
Ela - Organizer . Editor Edif Renarme |
S & () Catalogs Accessibie by the Current User
{(® Custom Location Move |
e RECENT FILES q Remove
) T reptile-2042906 adit. .. T rabhit- 1882694 jpg | | = it ss i |

o When you open Elemeants, yvou are presented with the
Home Screen. Down in the lower right are the programs
avalabletouse orto trv a free trial. Click on Crganiser to activate
it and follow any on-screen prompls.

ments Organizer keeps track of your media through a [ e
talog. EE—
g Convert...
ost people keep all their media in one Catalog, which can
iave thousands of photos and videos. You might want a
eparate Catalog for a special . Such as business
photos and| @ M a i :
o catalod kL SPEE X 0IME IO B RO CHIN0G
{My Catalog 1 k-
Latalogs— m
|| Import free music into this catalog Rename
|} Catalogy
Cancel oK
B Custom & B |
Macintash HO/U...s /My Caralog 1 ‘Browse... Remove |
| | Cplimize |

0 Ihere is usualiy a default catzlogue created but vou have
the gpticn to use the Catalogue Manager to create a
custom location for your catalogues. Click the Custom Location
and then Browse to the location where you would like to create
your custom catalogue,

VIDB0S B0 yoU Can casily Tired T laier Dased on
wha you were with, where you were and what
YOU Were choimg,

Crganize your medss wAR e Elamen

start Imperting

o If wou are creating a naw folder, vou can give it a bespoke
name and then hit the Create button to make the folder
into which your catalogue will be placed. Once you have done
that, vou can then give a name to your catalogue. We have called
ours 'My Catalog 1'. Click OK to create it
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The Crganiser workspace will open and vou will see the

main Madia workspace displayved. If you are using it for the
first time, it will prompt vou to start importing images ready to
be organised,



Finding photos of your
loved ones has neaver béan
easier
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SETTING UP ELEMENTS ORGANISER

&0 et Mk

izt e Fodaem iieg Poddig 2 pelsfusdyi s giibed [rare T lgldde i
Chow oin 1ha Talder 1o ped a8 el e egv

e Aakdl Fridber,. T 2o

There are also screens giving voud a brief overview of what

gach section ol the Organiser program can do. The People
section can identify faces for tagaing. The Places section can
oeotag or let vou manually add location data to vour images and
Events groups your images by date and time.

| e R T e

mi< » [ El=umw &- i Public h
. il
1 a
Fayeeibes Shared Folder
e Racents

= Dropbon [Persanal}
%= Dropbex (Team BOM)

el Macintoah HE Lo B GORG

2 rubkc

"'?" marktrost

T Shared _3

ﬁ Applications R .
= Desktop

r&l Dot uments

% Woloud Deive ..

I"'| domain-Airlrop

u Downloass Goresisn Bl Burgern Shit S
s Add Folder.. q = FIA-0..2 (2hosd  PMB-OLLPRpog B
S e Foddes

o Start the process by clicking the Start Importing button
and Organiser will ask you to add folders from which to
import media and photos from, You can add and subtract as
many folders as you wish, Click Add Folder to choose more, and
even customise how much content from each is imported.

66 of 170 itemis) imported Stop

Julsers!markfrostfPu. _erial (dawlish 2_pg
—r | 36K

No media available. Click Tmport’' to add media

0 wWhen vou click Add Folder, browse to where yvour folder
of images are kept and double-chck it to add it to the
import list. There is a small icon shaped like binoculars that when
highlighted, infarms you when new files are added to that folder,
When you are ready, you can hit the Impaort button,

o All the selected media yvou chose will be imported. I you
have chosen a lot of images, you will see a progress bar
listing the itams as they are imported. When complete, Organiser
will display a grid view of your images ready for yvou to start
working on,

9 Click on the People section and it will start the process of
scanning your photos looking for faces so yvou can organisa
images by pecple. The Places section will display images ready
for you to add location data; unless they already have GPS data
attached, whereby they will be pinned to the map.

wonw bdmpublications.com

@ Oct 2018 - Nov 2017 / Add Event

1“‘ The Events section displays all vour photos in chronolegical
¥ order based on date and time. You can create naw events

and stack all images of that event within it. Now that you are

organised, let's find a little more about the workspaces on offer,
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GETTING ORGANISED

Tagging and
Keywords

If your photo library is large and scattered across many folders, it
would help if they were tagged and had keywords added to make your
searches more streamlined and efficient. Rather than trawling through
folder after folder, why not tag them with keywords?

! Albums i Folders
import -
My Folders "=
B Albums il Folders Sort By: | Newest -] =5 aedlil
a5 animals
My Folders aa EVENIS
o aerial as examples
i animals as hdr
e Events s people
ez examples n
laal s - places
_-I h i T
’_"' s " /Users /markfrost/Public/BDM/Adobe
IL_' .phﬂtﬂs- T
| places
o From the Home screen, click on the Elements Organiser o We made a folder called 'Placas’ that contained a number
con to open the Organiser workspace, We warked in of images but anly a few of them were relevant to our
Folder view with the Media tab clickad and all media currentiy particular reguirerment of mooriand photos, The first thing we
on display. We had some example images of Dartmoor in Devon did was to press the Cmd key and left-click each of the required
that wa wanted to tag for future reference. moorland photos. There were five shots in total.

B~

5 items salectad
(Haytor |

Haytor Hotel, Meaafoot Rd, Torguay, England TQL1 ZX0, United K,

Haytor, Dartmoor Mationa
Haytar Dirive, Exeter, Exeter, EX4 2EP, United Kingdom

Hayror Road, Torbay, Torguay, TQ1 4LP, Unived Kingdom
Haytor Grove, Mewton Abbot, Newton Abbot, TQ12 405, United K...

9 Mow that the images are selected, yvou can begin to tag o Fress enter and the dialog pane! will show you possible
therm. The first and foremost requirerment is to add a place lacations basad on the name you entered. We knew ours
tag. In the taskbar, click on the Add Location button. This calls was in the Dartmoor National Park, so clicked on that option
up the Add 2 Location diglogue panel. Cur shots were taken at 3 and then the Apply button to add that location data to the five
place called Haytor, so we entered 'Havtor' in the dialogue panel images we haa selected
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= — - * People Tags +v
[ | &g Colleagues
[] & Family
[[| &g Friends

* Places Tags G ol
i_,ﬁ] United Kingdom

» [Bl ® England
» [B % Newton Abbot

X 9 B3

¥ Events Tags -+

Mow if you ook over at the Places Tags section in the Tags

pane! bin, yvou will see that location data has been addea
as a tag, which may consist of several sub categories. If vou click
the top category, in this case United Kingdom, only the taggeag
images will now be seen in the browser window

0 Information

+ 1
N

@ Tags

Import Keyword Tags from File...
Save Keyword Tags to File...

Collapse All Keyword Tags
Expand All Keyword Tags

v Show Large Icon

0 It is added to the Other category but you can click and
drag to any of the other categories, or chck the green plus
symbol in the top right corner and click on the New Category
option in the drop down menu that appears. When you do, the
MNew Category window opens,

[1] B WNatre
[] B Color
[ ] @ Photography

D E Sunrise
N

¥ People Tags
| | & Colleagues
[ | #& Family

o The newly named category 15 added to the Keywords hist.
You can drag and drop the its Image Tag into this new
folder. If you turn off the Places Tags visibility icon and then click
on the new category's visibility icon, yvour images will still be
clisplaved in the browser window.

wnw . bdmpublications.com

TAGGING AND KEYWORDS

Sunrise

: Sunrise T Add

If wou highhght all of the images again, vou can add more

tags to help you identify the photos at a later date. Under
the Image Tags panel, vou can add custom keywords; In this
case, the keyword 'Sunrise’ was used, Click Add to include the
new kewword,

=) Create Category

Sl
g)l Choose Color...

Category Name
Sunlight

Category lcon

Q In the New Category window, you can choose a colour
for yvour category icon as well as choosing the name you
want the new category to be called, in this case 'Sunlght’. If you
wish, you can even select an icon from the choices listed in the
category lcon window. Then yvou can click OK to proceed

— —
- (@ Sunlight

¥ People Tags [~
[ ] #& Colleagues

[ ] & Family

[ ] #&g Friends

¥ Places Tags ; =d

@ A% you can see, we haa tagged the photos with a specific
Places Tag and also with the new Sunlight category and
Sunrise image tags. These various sets of tags mean that if we
ever need to find a sunrise photo taken on Haytor, we can just
search for those particular criteria and they will be displayved.
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GETTING ORGANISED

Putting Names
to Faces

Now that you've tagged a few photos, let's move over to the People
workspace. Your library was scanned for all faces present in the photos
and then displayed here. Now you can tag these people and literally put
names to faces to aid you in your search for friends and family.

i Folders

= @ All People || Hide Small Stack
- &

| Hike Smiall Stacks

Al Hame (3 Adld Hame (4) Add Mame [(4) Add Name (£

§

Aidd Mame (2] Adld Naame (2] Add Masne (2 Add Mameé {Z)|

Click on the People tab 1o open the workspace for tagging

faces. Just like the main Media view, you can view the
contents of selected folders or click the All Pecple button for a
view of every face that has been found in your entire catalogue
of images; this includes those in the UnNamed category.

e The view you are presented with is a thumbnail portrait
of each individual face that has been identified. Below
the thumbnail are the words Add Name followed by a number,
The number represents how many pictures of that person have
oeen found.

Name (4)

Add Name (4)

[a2] Photos

L
o Faces

Ursual Romanovich x Add Name (3)

This action will move ‘Ursual Ror

o If wou hover your cursor over any given thumbnail, it
displays two options. One shows all the complete photos
of that person and the other just shows a small thumbnail of
thair face without any background context to distract from the
process of identifyving them.
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o To name a known person, Ursula Romanovich in this case,
you can click on Add Name and type in thair name. Next to
the name is a small tick and cross icon. Click the cross to cancel
inputing the name or chck the tick to assign that name to the
parson. Doing this will move them to the Named category.



Ursula Romanovich |+ | X

me (1)

I. Ursula Romanovich

PUTTING NAMES TO FACES

Is Ursula Romanovich

S maat

Don't Show Again
Assign as Profile Picture

e If some photos of that person have been missed and are
still available in the UnMNamed category, you can click those
thumbnails and click Add Name. If the facial match is close
enough, the name will be displayed and you can simply click it
and click the tick button to add those images to the list,

0 Someatimes a photo of a person that is very similar to
another may be added by mistake. If Lthat is the case, you
can right-click the offending thumbnail and choose 'Not Ursula
Rormanavich’ to remove them from the list

£ &l Pacple
- ..'| y A !
) '.
Groups B
o | AddGroup .
ﬁ eadgues Saame
T Family Delete
G Friends

7‘
On other gccasicns, if you name a person and then view

o their photos in the Named category, you may be shown
a series of additional pictures and asked if they are alzo of that
person, You can also multi-select those that are not the person
vou want and click the Not This Person in the taskbar

o As an example of grouping, here are five members of a rock
band: it would be handy to group the members for easier
searching later on. To do this, go to the small the green plus
symbol in the All People panel to open the Add Group dialog box
for yvou to create a new group for the members of the band.

8.0 Add |
Name: |Rock Band
Croup: | None b
Cancel oK *j

B Family
ﬁ Friends

fﬁ Rock Band

Ungrouped

o Under Mame, yvou can tvpe the name of the croup; we just

called it 'Rock band', The Group it appears in is None since

we want to create this as a brand new Group category [0 appear
in the All People pane! bin, When yvou're ready, vou can click OK

to create the new group.

wiarw bdmpublications. com

@ The new group called 'Hock Band' will appear in the All
People panel bin. Now yvou can highlight all five members of
the band and drag their thumbnails into the 'Rock Band' group. If
you click an their group feolder, only their faces will be displayed
since the tag is relevant anly to them.
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GETTING ORGANISED

Tagging Photos
with Location Data

Tagging places is similar to the way you worked with People. There will
be Unpinned modes and Pinned modes for those photos that have had
their locations identified. We've already touched on adding Location tags
briefly, but now we can explore the Places workspace in more detail.

Group By Time Ih People m Events |

* Pinned * UnPinned

nt Number of Groups: Min —@— Max
e ~Mar2018 / Addlod e |

76 >
* UnPinned | Search ¢
|
| Strocts -
|
| el ]
{
. " . -
| " : .jh'
Click on the Places tab to view the Places workspace, For @ IT wou are using this view, then you can alter the Number Of
the moment, yvou will need to be in the UnPinned category Groups value displayed in the left hand panel. Mowving the
and view all the photos that have vet to have any location data slider left and right, increases the numbers of groups on view for
added to them. If vou click Group By Time, then they will be maore detailed scrutiny or reduces the numlber for a broader view
displaved in chronological order. of all the photos you are viewing.
B Abums Bl Folders |F'l:ﬂph m Events
My Folders = & All Media L Group By Tiewe * Firred * UnPinned
o amridl
st animais
__._..." EWENTS Hownd Tge
s BHAMplE e — — T = =
_'._: ol Hound Tor Cwse, Churston rallway s1aisen, Faignion, TO# 75, Unired Kingoom
MDIE Taronuo, Omtario, Canada
A m Torredn, Coabufla, Mexdo
s plACEs Tarrunce, California, United Stated
;.: W
- Bl b gt
an  SpiO
Buckfastlai
— Jamal —*|
@ We have opted to tag a specific group of shots taken at a 2 the riaht of your Places workspace 15 the map where
ocation called Hound Tar. These shots dre kepl in a folder yOU can view any pinned photos. If you know where vou
called ‘photos’, 50 we have used the folder view to find them are looking on the map, you can zoom directly to that place,
We haven't worried about viewing in chronological order in this ctherwise you can search for a location by putting a name in the
instance. There are four images to tag. search pane at the top of the mag.
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TAGGING PHOTOS WITH LOCATION DATA

Satellite ~ .

! Place 4 Media Here? " §) |

=

I the media view panel on the left, press the Cmd key and Sometimes, vou may find that the lacation of the imades on

mulbi-select the images tor location tagging. Thean enter the map s not that precise but it does give you the aption
your search destination in the Search panel above the map. Press to drag the pin to the correct place. If vou are having trouble
enter and a list of matches will be displayed. Click the correct

identifying the correct area, you can alter the map from Streets
one and the selected media will be placed in that location. to Satellite for a better view of the land.

MNow you can see the land better, you simply drag the pin 0 You can also navigate directly to a place you know on the

the right spot and click the Place 4 Media Here? green map and then highlight the pictures you wish to place
tick to confirm placement. You can double-click the pin to view there, Once highligntad, the picturas can then ba dragged and
the images contained at that location. It will also appear in the dropped directly onto the map at the location you navigated to.
Pinred category view now as well. These will also appear in the Pinned category.

BT

Place 3 Media Here? « 8

Edit location information for selected mediau
J

Ehatcher Rock

Q If vou import any pictures that contain GRS data, they 1“ If the placement area is too broad, vou can adit the location
will be automatically replaced on the map in the Places

B nformation by chcking on the pinnad thumbnail and
workspace when the data they contain is analysed. Our

inputting more precise location options or dragging the pin to a
example of some aerial photos taken on the Devon coast were new location,
accurately placed,

wnw bdmpublications.com
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GETTING ORGANISED

Adding Events
Tags to Photos

Having talked about who was in a photo and where was it taken, it seems
only right to mention how you can search for images when you want to
know when something was taken. Now you can tag and group them by
the type of event it was and when that event happened.

- b . Folders
My Folders < All Events
_ﬂ' aeirial
- i
% @& October 1, 2018 # Add Event Phcei
o Exampias . e
o
= T il
"+ peaie =1 Named =7 Suggested
R, phoigs |
& places
-_: s Number of Groups: Min * O Max
a3 pon & May 2017 - Apr 2017 /' Add Event '
o We have an example folder full of various types of events 9 Much like the People and Places workspaces, the Events
such as weddings, parties and sporting events. When workspace has a Suggested category for untagged events
viewed in the Events workspace, they are listed by date order to vet to be igentified and a Named category whare any that are
help yvou find what you are looking for. They are listed with most tagged as an event will finally be displayed.
recent dates and times first,
Ao e ) Cal Cles
5 v alendar it ﬂ' May 13, 2017 7 Add Evemt ‘

Jul
oet Now
o Clhick the Number OfF Groups slider and push it to the far The avent we are looking for happenad in April - May 2017
right Max setting. The media browser will display more MNow you can use the Calendar panel on the far nght to
time and date options for you to focus in on, We are locking for cpen the 2017 calendar and click on either April or May. Clicking
a particular sporting event, Autocress, which was photographed on May 2017, reveals the photos from that motorsport event,

back in 2017
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o May 13, 2017  # Add Crem

I|'||hr.l:|
]

i 10E= & May 13,2007 & A B

P ——
TS Py E
I . = »

& May I3, 2017 F ASd el

ﬂ May 3. 201 & A5 Dwiivi

o

[ W FPFE e F =0

e The photos are spread cut across the duration of the entire
day but are all there ready to be tagged. You can use the
NMumber Of Groups slider again to break down the view into
fewer groups or more groups of photos split across that day's
worth of shooting.

bs = & & & & #« | |Auto Curate

Add New Event
Start Date: | 11/19/2018 | B&
End Date: | 11/19/2018 | [
Croup: | Nore -
Ll |

Add Event

ADDING EVENTS TAGS TO PHOTOS

@ May 13, 2017 / Add Event

o Mow that yvou have all the photas in once place, you can
fighlight them by pressing Cmd + A to selaect all, or by
dragging a section around all the photos with your mouse, They
will be highlighted in blue with a small tick box in their bottom
right corner,

| §

Marme:

san owe; [SBEOIT]E

Group:
Description!

| Autocross Evemnt

11372007 |EH

Mope =

Motospart event photagraphed on Behalf of the
Autocross Club.|

=

owr in the taskbar in the bottom centra of your screen

is the Add Event button. If you click this it will call up the
Add Event dialog box whera you can begin to add details about
the event itself such as Event Name, Start and End Date and a
Description if recuired.

o Start by giving it a name, We used 'Autocross Event’ and
kept the Start and End dates the same since it all occurred
on May 13th 2017. Since no other Group names have been
created, Group iz kept as None, A short description is also added.
MNow you can click OK to proceed.

f13/2017
hutocross Event

'-De scription

Motosport e
photographe
of the Autoci

o You will see that all our photos now have a small calendar
icon in their top right corner to indicate they have an
event tag called "Autocross Event’ added to them, If you look
in the Named category now, you will see that event listed. Click
on the small information icon to see the description you typed.

LI = =
PR T Rar B | e . D = Diea
kit S . . . [] & ehi
= Places Tags
] @ Uninet Kingdam
=[] % England

v [ ] 9 Newton Abbot
=[] % Peignton
[] @ Eastern Esplanade

[] 9 Daddyhole Road

* Events Tags

F] 8 Awocross Bvem

@ If vou return to the main Media view, vou will ses that
the Events Tags panel now contains the Autocross Event
tag. If you are viewing all media and click the Autocross Event
tag to make it visible, only the shots tagged will appear in the
browser window.

BDM's Made Easy Series | Volume 21



We hope that by now you feel like you've had a good
introduction to what Adobe Photoshop Elements is

all about. There's a lot more to come on the following
pages but before we dive in further, we thought it
would be great to show you a series of quick tutorials
exploring the vast range of techniques and tools
available. There's everything, from making a panorama
from multiple images, to putting pictures inside text.
Take a look and enjoy the Elements experience.
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THE ELEMENTS EXPERIENCE

Contents

62

Meme Maker

70

Open Closed Eyes
64 Partial Sketch

72  Multi-photo Text
74 B&W Colour Pop

66 Replace Background

76  Zoom Burst Effect

Photomerge Panorama

68

61
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g Lo where your primary
3 either double-click the image
oress the Open button,

R BT el e R (A PR LTI

Cosmputier ar tha Elemams Organi

Chidein Fiism

3 Just in case, there is a small selection
e that you can try straight away, with two
male and two male sets of sample eyes, on
your photo.

Computer -  Organi:

Click to Apply:

When you have found a likely candidate,

double-click it to load it as an eve source
and then click on its thumbnail to apply it to
your main photeo. Click OK when done.

wpnw.bdmpublications. com

g Edit image Enhance Layer Seiect Fitter ‘View ‘Window Help
BN Smart Flx LM
Auto Smart Tone.. THT
At Levels yif 48
funn Comiras L
St Haze Remosal CEHA
fume Color Comection 4HE
Ao Shake Reduction
ALt Sharpen
Auto Red Eye Fld

Adpust Calor

st Lighting

Ardpuest Srmart Fhe.. 30 M
Corvert 1o Black and White.,, “CHB
Haze Rarmoval.,. RZ

Aadfust Sharpness. .

- Open Closed Eyes.. .
Aetfuest Facial FeaiLires.
Shake Reducton...

Unsharp Mask..

Go to Enhance > Open Closed Eves and

vou will see the Open Closed Eves dialog
box. Here you can choose your Eye Source to
open your subjects eyes with,

Eye Source

Dpen an Eve Source photo from your
Computer or the Elements Organizer

Choose fram

= .-

Computer  Organizer

ul-186705
Lipg Try sample eyes:
| ! > -ﬁ\ |

1 J L

i

ingd sonia — =
-'9.:ﬂ';] U ;

For best results, find a photo that roughly

matches the lighting and colours of your
original photo, You can select Choose from =
Computer and |locate a suitable image.,

Eyp Soruma

Cpen o Bpa Sawroe charin |
Covriniber of e Elgarearts O

S Thrav

The new eyes you found will be mapped

over your existing image and blended as
seamlessly as possible. If you like the result, you
can save it under a new name.
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The Elements Experience 2

Partial Sketch

Guided edits are a simple, quick and

fun way to add edits to your photos.
Have you ever fancied yourself as a
great sketch artist? Well, with the Partial
Sketch guided edit, you can instantly
turn any of your favourite photos into an
artistic rendering with just a few clicks.
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PARTIAL SKETCH

',

— O

PARTIAL SKETCH

Turn part of & faverite phato Into an artistic
skistch,

Open the Elements Photo Editor, go to You have four pencil sketch effects to

File > Open and choose a favourite photo, choose from. Click one to activate the
then go to the Guided workspace. The Partial sketch brush, Select Add and use the slider to
Sketch effect is under Fun Edits. control its size.

2. (Optional) Click the Detail Brush button
to precisely paint the effect on or off.

o Paint across your image to reveal areas If you want to, you can use the Detail
you want to be converted to a sketch Brush to more precisely paint the sketch
effect. You can always use the Subtract brush, effect on or off your photo, controlling the

to remove any sketch areas you don't want. brush size and opacity.

e An optional effect is to soften any hard With the image still active, you can

edges or flip the effect. If you're happy, actually go to the Expert workspace and

you can select Next and Save your image. continue to work on your photo adding more
contrast to the sketch layer.
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REPLACE BACKGROUND

Sog

RS WA ARG WA O RS S

1. Use one of the Selection Tools to choose
the primary subject of your photo.

Refine

Mran aresce Hhoa maain cobdact fa moakea

In the Guided workspace, you will find *’2 Choose from the available tools to select
~ . the Replace Background edit under the = your subject. The Quick Selection tool
o . :_S;.&Ecia[ Edits category, Put the photo you want should work well on our subject. Drag inside

» on t tework on in the Photo Bin, the edge of subject to select them,

2. Choose a new background

= $ , Use the tool options to subtract areas 4 . Now you can import a photo that will be
- = that stray outside what is required. Then the new background. It will be placed
voU can use the Refine tool to improve the behind your main subject. Both subject and

. s : guality of the selection. background can be moved if required.

&

5. (Optional) Use Auto Match Color Tone to

b lmam ol s e ilmimamd cadibla s sl sl

f 5 Now you can make further refinements Click Auto Match Colour Tone to make
= to the outline of your subject if you want. = the colours of your subject match the
A soft brush can be used to feather the join background more closely. Now you can save

between the foreground and background too. the image as a PSD or jpeg.
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-E':A.l:;nﬂ Fle =
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. Inthe Guided workspace, you will

fi ._ Phﬂtnmerge Panorama under the
merge category, Place tha_i_aquence of
ra .“i-':: photos vou want in the Photo Bin,

Settings

Biend Images Together
& Vignette Removal
|| Geometric Distortion Correction
& Content Aware Fill Transparent Areas

9 Make sure the Blend Images Together
and Vignette Removal boxes are ticked.
i . = If you want-to fill transparent areas then

TR NN ‘cdmﬁse Csﬁntent,.ﬁ:,g{are Fill I:E;nsparen

- - - = =
'_ _— '-‘:ng. _ﬂ'

—_—————

i
—= i
-

e

74%

What would you like to do next?

Save:
% Save Save As
=
Continue Editing:
=
In Quick
Share:

Once Expert mode has stitched the
images and filled any transparent areas,
it returns you to the Guided page to save it or
continue working on it in Expert mode.

Photomerge Panorama

Auto Panorama
L =
e ﬁ A |
Perspective

10y i Cylindrical

Make sure all your photos are selected
and choose the type of setting you want.
In nearly all cases, the Auto Panorama settings
Is fine for standard photos.

Adobe Photoshop Elements

Mow you can click the Create Panorama

button and the stitching process will
begin. Mote that Expert mode is used to stitch
YOUur images,

In Expert mode you can flatten the image,
< make adjustments to the image and crop
it if required. Then you can save the result as a
PSD or other image format,
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Turn photos and text into fun memes for
social media.

In the Guided workspace, the Meme

Maker is under the Fun Edits category,
Make sure you have a suitably worthy image

open and ready to go.

iImpact Reguiar ~ | Color:
Regular ' Size: 36.4 pt |j
Leading: | (Auto} | ~ | Tracking: 0 | ,.|

] o —

- "..-“P

» Bin Tool Options - Undo Redo Rotate Organiz

You can type new text using the Type

Tool and choose any font from the Tool
Options panel in the lower left of the screen.

J* Effects
IH.-.-_H-\. &
| - 1
.
F
* A 4 ~ i

‘You can also add more effects to the
resulting image. You can choose from
a pop art, black and white and several other

options. Click on the effect you want to add.

After (Roll over to see Before.)

1. Click the Create Meme Template button
to get started.

- J

2. Click the Type Tool button to modify
your top and bottom text.

Use the tool options below to adjust the
style of your text.

We have a funny picture of a monkey

sticking his tongue out. The first thing to
do is to click the Create Meme Template button
to add the basic frame and text.

LU L

Zoom: k)

e | Diq | -

| Fit photo to canvas

LR BN NN

4. (Optional) Choose a new border.

—

’ Y
{ \
e

; Then you can zoom your photo if required

= and flip it horizontally or vertically. Then
you can choose to add a new border from the
options available.

A IS S
In Quick In Expert
Share:
Fickr
R
Y Twitter

Finally, when your meme is ready, you can

save it, continue to work on it in Quick or
Expert mode and Share it with the woarld on
Flickr and Twitter,
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Create visual text with a different photo inside
each letter.

The Multi-photo Text guide is in the

Fun Edits section. With your chosen
background photo open, you're ready to then
click on the Multi-photo Text icon.

= 85
o Chick here B3 H!:'L_['ﬂ‘ﬂln ud CHok e i Bdd ohato
e

When you click the Create Frames

button, each letter is converted to a
frame ready for you to click and then select a
photo to appear in it.

Clear Color

White Black

6. (Optional) Choose the intensity of your
text's bevel, drop shadow, and stroke.

" You can add a new background if you

wi want by clicking the options available; or
yvou can add outlines and drop shadows to the
text to make it stand out more,

{/ Kohinoor Bangla Beld Sample
{} Kohinoor Devanagarl Light Sample
{} Kohinoor Devanagari Regular Sample
() Kohinoor Devanagari Madium sample
{} Kohinoor Devanagari Semibold Sample
{) Kohinoor Devanagari Bold Sample
{} Kohinoor Telugu Light Sample
{) Kohinoor Telugu Regular Sample
{) Kohinoor Telugu Medium sample
p——
Impact Reguiar | ! Color: ™
Regular - Sae 100t | v
Leading: | (Auta) - Tracking: O -
e h;_..\_ = . = - .||Il:--
1 & D ) 5

- -

Bin ‘Tool Options  Undo Rado Rotata Organizer Home S

Use the Type Tool first to add your text,

alter its style and size using the Tool
Option panel, You can also specify how it fits
yvour photo.

Choose from your computer or your

Photo Bin and place one image inside
each letter. Double-click each frame to adjust
the image size and position.

{7 Save it there and then or open it in Expert
mode to work on it further. We made the
rabbit larger and more visible and then saved it.

BDM's Made Easy Serles | Viodume 21
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DR POP
Highlight a single color in your photo 1o make
it pop.

The B&W Color Pop edit is found in the

' Black & White section. Open a photo that
oL want to add the effect to and then click on
the B&W Color Pop icon to proceed,

/¥ Sselect Custom Color

Use the slider to include more tones of
selected color,

Fu2ziness .

2. {Optional) Use the Refine Effect button
to add or remove where in your image the
effect is applied.

Then, if you increase the Fuzziness

value, more colours similar to the one
ﬁhpﬁen will become visible again while the rest
remains in black and white.

. The Size and Opacity sliders dictate size

of the brush and how opague the effect of

adding colour or subtracting it appears. We're
bringing colour back at full strength.

wunw bdmpublications.com

B&W COLOUR POP

o You can click on one of four presets or of
vou prefer, click on the Select Custom Color
button and pick the most dominant colour yvou
want to remain untouched in your photo.

effect is applied.

-Lf_,gf Refine Effect

wi’Add \

Size :

L._{‘f Subtract

Opacity :

You can then use the Refine Effect
buttons to bring back more areas to
colour using the Add tool, or remove them
using the Subtract tool.

3. (Optional) Click on 'Increase Saturation'
to boost the color.

. Paint over areas that you want to be
coloured again, using a smaller brush for
finer detailed areas. Finally, you can then click
Increase Saturation for a more vivid image.

BDM's Made Easy Series | Volume 21
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The Elements Experience 8

Zoom Burst Effect

Sometimes you want to add motion to an
image that is otherwise quite static-lmlﬁng.
Elements has a few Guided edits that can
add a motion effect to your photos to give
them a little extra punch. The Zoom Burst
Effect is a digital version of anages old
photographic trick where the photographer
very quickly zooms their lens as they take
the shot to create streaks within the photo
to emulate the feel of speed and action.
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Z0OM BURST EFFECT

After (Roll over to see Before.)

1. Use the Crop Tool to crop your image so
that the primary subject is in the center.

-:-T . The Zoom Burst Effect edit is found in the “'ﬁ: \ The first step is to crop your image so the
= Fun Edits section. Open a photo that you " main subject is in the centre of the shot.
want to add the effect to and then click on the The zoom effect will start from the centre so it
Zoom Burst image to proceed. makes sense to position the image centrally toc.

Add some motion and action to your photo
with this classic effect.

2. Click the Add Zoom Burst button to
apply the effect to your image. Press
multiple times to increase the effect,

= '~ aAdd Zoom Burst
;.

3. Click the Add Focus Area button and
then click and drag on your image to
specify the area of focus. Repeat as
needed to increase the area of focus.

% Lise the crop tool to drag a crop box 4 ) You can then click the Add Zoom Burst

== around your main subject. Our example S5 button and the effect will be added to the
is of a motorcycle to which we want to add shot, It mimics a photographic effect where the
some motion to create a bit more drama. lens is quickly zoomed as the photo is taken.

!

x:s ) At the moment, the entire image has the 1:&, We used the Add Focus Area tool to

© effect added to it, however, you can use = bring the rider back into focus to give
the Add Focus Area tool to remove some of the  the shot a point of interest. We also clicked the
effect in a chosen area. Apply Vignette button to darken the corners.

wiww.bdmpublications.com BDME Made Easxy Sefles | Voume 21



The great thing about Adobe Photoshop Elements

Is that it can cater for all skill levels when it comes to
image editing, digital manipulation and creating new
works of art. Whether you are a complete novice who

Is starting out and wanting to learn the ropes or an
experienced digital artist who needs more advanced
tools to complete their project, Photoshop Elements
has all the power and sophistication you need to get the
most out of your photos.
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YOUR GUIDE TO IMAGE EDITING

A Guide to

Using Layers

Layers are one of the fundamental aspects you can employ when it
comes to non-destructive image editing.

very core of image editing since its

introduction in the early '"90s. As
you might imagine, layers are exactly
what they sound like. You can have a
number of separate elements, each
on its own layer, that are stacked one
on top of the other. When all viewed
together, they create the final image.

The advantage of using layers 1s clear.

It means yvou can change an element
on one layer only and not have an
impact on the rest of the image. It also
means that you can take an image
and duplicate it an another layer and
perform any edits you want on that one
in the knowledoe that the base imags

The use of layers has become the

will remain untouched in case it doesn't
turn out guite as you had hoped. Within
Elemeants, there are four main types of
layer, There is the basic pixel layer which
contains the main photo elements of the
project. There are text layers where you
can type text and change the size and
colour. Then there are fill/adjustmeant
layers that are designed to affect the
layver pelow it such as changing the
saturabtion or brightness of the layer
below, or jJust adding a colour to that
layer. Finally there are vector layers that
contain scalable graphical elements such
as shapes and work paths. BEach laver
tyvpe can also have a mask adoed to it so
only part of that layer can be seen.

o Create New Layer

You can click the Create New Layer
button at the top of the layer panel, use
the key broad shortcut or go 1o the file
menu and choose Layer » New > Layer
to add a new layer to the stack. You will
be prompted to name the new |layer. You
can rename it at any time.

o Create New Group

sornetimes It may be necessary to take
a number of layers and group them

to make Lhings more manageable, as
the number of lavers increases in your
document. You can highlight each layer

Opan =

- b e B R e 3L - e B e D EPEORL T
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voll want and than press the Create

Mew Group button to group them:.
Alternatively, vou can go to the file menu
and select Layer > New > Group

o Fill or Adjustment Layer

Fills and Adjustments allows you to aad
colours, gradients and patterns to a layer.
They also allow you to add adjustments
such as Brightness and Contrast, Hue and
Saturation and Levels, Adjustment layers
affect the layers directly beneath themin
the stack or they can be clipped to the
one layer directly below them only.

o Add Layer Mask

Each layer vou use in a document can
have a layer mask added to it. The mask
15 designed to lat yvou hide or revea

6 6 0 06 ¢

o O @,

specific parts of that layer only. Areas
of the mask in white let the layer remain
visible, while any areas of the mask in
black hide that part of the layer. The
rule of thumb is: white reveals pixels and
black conceals them.

9 Lock all Pixels

Clicking this button locks the layer
completely and no further edits can be
made to it. You will also be unabkle to
reposition the image on a locked layer,

o Lock Transparent Pixels

If wou click this button, any area of a
layer that has no image pixels in it is
considerad transparent, An area that is
transparent is then locked and no adits
can be made so it remains transparent,

O a Ej

W J e da s

- |

i@ T

USING LAYERS

Shape 2 @

Layer 1

13

Layer 0 12

A GUIDE TO USING LAYERS

o Delete Layer

The trashcan shaped button lets you
delete any selected layers if vou wish to
rernove them from the layer stack.

o Panel Options

Thare are a number of menu options
avallable here such as Rename Layer,
Duplicate Layer, Delete Layer, Link
Layers, Merge Visible and Merge Down,

o Blend Modes

Blend Modes determine how the image
colours on the laver interact with the
laver below it. It can be changed for
every layer individually or as part of a
group for certain visual effects,

@ Visibility

The small eye icon on the left of each
layer lets yvou turn that laver off so it is
not visible. Any effects associated with
that layer are also rendered invisible until
the eye icon is clicked once more.

0 Link/Unlink Layers

This lets yvou ink & numbear of layers
s0 that any transformations and move
commands you make are all applied to
the linked layers at the same time,

@ Background

The Backaground layer is the default
Bottom laver Whether it 1s an image
vou have cpened or a new document,
the Backaround layer s always partially
locked until vou choose to unlock it

@ Standard Layer

A typical layer with pixel information
displayed on it

@ Adjustment Layer

Arn adjustment layer is designed to affect
the layer below L. In this example, we
have a Levels adjustment that alters the
brightness and contrast of all the layers
stacked below it

@ Vector Layer

A vector layer contains scalable data
such as shapes in the case of our
example. A small icon in the lower right
caorner of the thumbnail indicates it 1s a
scalable graphic.

@ Text Layer

The thumbnail of a Text laver displays a
T to indicate the layver contains scalable
text. The layer name also reflects
whatever text is on that layer.

BDM's Made Easy Series | Volume 21

81



82

YOUR GUIDE TO IMAGE EDITING

Methods for

Adjusting an Image

When it comes to methods for adjusting your images in Elements, you
are spoilt for choice. There are a number of methods to get an image
looking great. We'll show you how each one works, with some examples,
to help you choose which method suits you best.

Quick Mode

|
{

Balkel
RGO

Spot Healing Brush Tool (J)

o We start in the Quick mode workspace with a sunrise
mage of a pier that is in naed of some work to makea it
look its best, The first thing to do is remove that large black spot
in the top right corner: probably a bit of mud stuck to the lens,
currently spoiling the shot.

o To remove such a blemish, you can go to the toolbar and
choose the Spot Healing Brush Too! (1), When you choose
this tool, the Tool Option panel displays Spot Healing Brush
aptions. You can choose Spot Healing Brush or Healing Brush to
remove the spot,

—— Brush Settings... | Mode: Na
Healing Brush Toal (J) | :
. | Aligned : <

B 55 ¢ H E %

| Photo Bin - Tool Options - Undo Redo

b

Rotate Uzganiznr Home Screen

¢c D Em &

Redo Rotate Organizer Home Screen

a5 9

Photo Bin ‘Tool Options  Undo

o The main difference between the two Drushes is that the
Spot Healing Brush lets vou paint directly aver the blemish
and then works out what to fill it with by analysing the area
around it. Proximity Match and Content Aware are the best
options here far this kind of blemish

BDOM's Made Easy Series | Violume 21

o The Healing Brush Tool asks yvou o select an area to be
the clone source by clicking on a clean part of the image
next 1o the blemish, This chosen area will then be cloned over
the blemish when you paint over it. The cloned source will be
olendsd in to be as seamless as possinle.



METHODS FOR ADJUSTING AN IMAGE

=

Adjustments Effe

9 You can alter the brush size by using the Size slider in o Mow that the blemish is gone, we can ook at making
the Tool Options paneal or by pressing the laft and right the image more vibrant and appealing. Layers are nol
bracket keys, Pressing [ will reduce the size of the brush and available in Quick mode, so it comes down o choosing the
pressing | will increase the brush size, This lets you clone with right methad for the best overall effect. The easiest way to see
greater accuracy and detail if vou nead it the effect yvou can have on the image is to choose Agjustments

from the taskbar,

m T R T LT

A e

— p— -1

EETE
ETETE"
BT

o This calls up the Adjustments panel, You can choose o MNext, you can go to the Exposure adjustment and

Smart Fix and select from a number of options that make choose to make the image brighter or darker. Again you
subtle changes to the image and recover detail in the highlights can hover over a number of options and see a preview of the
and shadows. Hover over each one to see a preview of the effect or use the slider to make more subtle adjustments to the
effect applied to yvour photo. Click the one you want to apply birightness of the image.

o The Lighting panel is the key to really controlling the @ The vividness of vour image can be controlled in the
brightness of your Highlights, Midtones and Shadows, Colour panel. Increase the Saturation globally or use
each of which has its own tab for you to access. Choose from Vibrance to increase the most subdued colours first, Hue lets
the options provided or use the sliders for more subtle control vou shift the entire colour palette for a surreal colour effect if
of each of the tanal options. Yiou reguire it

werw hdmpublications. com BDOM's Made Easy Series |Volume 21 83



84

YOUR GUIDE TO IMAGE EDITING

0 Balance lets vou shift the colour temperature from caold
to warm and Tint allows you to add either an increasingly
green colour cast or a magenta cast to help offset any colour
inconsistency in your original image.

Quick Mode Auto Modes

Filter View  Window Help
NHEM
XRT
{raf L

jit Image Enhance Layer Select
AUt Smart Fix

Auto Smart Tone...

AUTO Levels

LA
%8B

Auto Contrast

Auto Haze Removal
Auto Color Correction
Auto Shake Reduction
Aute Sharpen

Auto Red Eve Fix

Adjust Color

Adjust Lighting

Adjust Smart Fix...

Convert to Black and White...
Haze Removal...

{38 M
LB
.."-. ‘ﬂf -ﬁ

@ Linder the Enhance menu are a number of Auto features to
iImprove your image. Thase are quite broad in their effect
and do lack a certain finesse, so you have no real control over the
outcome. If you want some more input in the effect there are a
couple with a bit more control worth looking at.

@ If vou go to Enhance > Adjust Colour > Adjust Colour
Curvas, you can adjust the Highlights, Midtones and
Shadows of your image. There are a number of preset styles you
can choose from to enhance the colour in your image as well as
the aption to manually adjust the tone sliders,

BDOM's Made Easy Series | Violume 21

@ Finally, you can go to the Sharpen panel and apply levels of
sharpness to your image; but beware of overdoming it and
creating artefacts and halos as the contrast increases and bright
unwanted highlights appear around areas of high contrast in vour
photo. If yvou are happy, you can save the result.

@ If vou go to Enhance = Auto Smart Tone (Shift + Crd + T2
an interactive panel appeaars, whare you can drag a cursor
around a grid. Each corner of the arid shows a possible outcome
that can be achieved by moving the cursor further in that
direction. Move it arcund until you get the result vou want.

@ Another option, but one that needs a light touch, 1s the
Haze Removal tool Go to Enhance > Haze Removal {(Shift +
Cmd + Z). This can be quite a strong effect but there are sliders
to adjust the strength of the Haze reduction applied and also the
sensitivity of the haze datection



METHODS FOR ADJUSTING AN IMAGE

Guided Mode

B ¥ O

Photo Bin  Tool Options Undo

Redo  Rotate Organize

Adjust the brightness, contrast, and tonal
range of your photo.

Guided Mode s an alternative if yvou are happy to have less

advanced adjustment options available but with more step-
byw-step guidance to help yvou on your way to creating the final
image. Make sure you have an image open in the Photo Bin ready
to work on

Levels o B

1. Click Create Lievels Adjusiment to open
the Levels dialog bax

2. To ensure that vour image uses the full
range of {onal values, drsg the black slides
to the right S0 thal & 5 Just below the ieft
most point of the graph. Then drag the
wihite slider o the kfl 4o thal & is just

el the Fight mast point of the graph.

o You will be asked to create a Levels adjustment and a
dialog panel will appear. Click QK. Since the image has a
lot of underexposed darl areas in the foreground, sliding the
Midtone slider to the left will brighten the photo in those darker
areas, You can then click Next and then Done for this part.

o The great thing with Guided edits is that you don't have to
apply just one edit, We are going to apply several to get
the end result we are after, Start with Levels to get the overall
brightness of the image dialled in first. Levels can be found in the
Basic category,

Show Open Files

ENHANCE COLOR

Fine-tune and enhance the colors in
phaoto.

Photo Ei-in ::Tnnl ngﬂms:: Un

o Now, if you laok in the Photo Bin, back at the main Guided
Home screen, the phota will have a small icon inits top
right corner that indicates it has edits applied. Then, you can go
to the Colour category and choose Enhance Colours to add more
vividness to the photo,

Use the sliders below 1o fine une the
adjustment.

Hug : @ —
Saturation : —Ef:—
Lightness :  ee— —

Create = Shuy = Create - =« ~
| Enhance Colors a e Lighten and Darken o8
Click Auto to balance the codors and Click Auto o apply a general fix to the
contrast in the photo, PhoLO'S Exposune.
Auto Fix Auto Fix

9 You can use the three sliders of Hue, Saturation and
Lightness tao make the image much more saturated and
bring out the colours in the sea, sky and foreground, A boost of
Saturation to 45 and Lightness to -2 is enough to bring more life
into the phota. You can lick Next and Done once more.

Drag these shders (o manually balancs the
shadows and bright spats,

o Finally, back in the Basics category, click Lighten and Darken
and use the three Shadows, Highlights and Midtones sliders
to make final tweaks to the image. The Highlights have been
reduced to bring more detail back into the brightest areas. At this
paint vou can click Mext and then save yvour image.
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YOUR GUIDE TO IMAGE EDITING

Using the Photo
Editor Expert Mode

Don't be put off by the title of Expert. In this case, you get more tools to
play with and you can actually be more involved in the editing process.
You can switch out to another mode, but to truly unlock the power of the
program, you will want to try out some image editing in this mode.

- N o=
S

-

o We have opened anathar image that needs some fixing. It

Is @ sunrise on the moors that s a little underexposed and

neads same work to bring out the foraground, while keeping the
sky relatively untouched, since that is gquite well exposed. This 1=

where the use of layers and masks will help us out,

ct Filter View Window Help

Filter Gallery...

Correct Camera Distortion...

Adjustments

_Strnkes
Distort Blur More

Moise Gaussian Blur...
Divalate | ane Rlir

9 Fress Cmd + J to copy the Background layer, Mame the
new laver remove cast’. Then go to Filter = Blur > Average
This will blur the duplicate of the scene and average out the
colours it contains into one colour, In this case, It turns a muddy
brown colour.

86 EDM's Made Easy Series | Violume 21

o First, the colour balance needs to be adjusted. The image
is a little too magenta and warm, particularly if you look
at the colour of the grass. This can be altered by using a really
simiple trick that can be really effective and requires the use of
layers to ag it

_ Narmal -

opeciy: [100%] <]

| Opacity: |100%
§ ———— —

Set the blending mode for the layer

remove cast

o Malke sure this layer |s active then go to Filter =
Adjustments = Invert (Cmid + 13 o invert the muddy brown
colour to a pale green hue instead. This colour, derived from

the colour average of the original scene can be used to create a
colour correction filter.




USING THE PHOTO EDITOR EXPERT MODE

Color Dodge
Linear Dodge (Add)
Lighter Color

Soft Light ¥
Hard Light

Vivid Light

o Zo to the Blend Maode button and from the dropdown
menu that appears, choosae Overlay as the blend mode for
the 'remove cast' layer. This will blend the colour of that layer into
the photo of the moors below it You should see that the snow
now looks a lot cleaner and whiter than it did,

: o -
QW0 885 j

Dpacity: .‘l

Mow to make the image punchier, click the Create New

Fill or Adjustment Layer button and choose Levels, Make
sure ‘Levels 1" is at the top of the layer stack, Adjust the Midtane
slider so the sky is-a bit darker. This will obviously make the entire
image too dark but you can fix that next.

o Altering colour can be auite subjective and if vou fesal
that the correction is too much, you can always go to
the Opacity slider and ad|ust to sbout 80% to lessen its effect
slightly if you wish, New vou can continue editing the image.,

MODIFY

=gy
x et

' rrErr—

|Set foreground color

o Choose the Brush Tool (B) from the toolbar, then set the
foreground colour to black. You can press [ to default
the colours so black is the foreground colour and white the
background colour, Pressing X will swap those foreground and
background colours aver if vou reguire.

{Layar mask thumbnall

remove cast

Rotate  Layout Organizer Home Scre

When vou choose the Brush Tool, the Too! Options panel

will display parameters for the brushes, We need a large
soft brush which can be chosen from the Brush Presets menu.
Chck on the Soft Round 200 pixels brush to make it active. Make
sure the Levels | laver mask is active by clicking it

@ You can now use that soft black brush to paint on any areas
of the mask where you do not want the adjustment to be
visible, In this case, we only wanted the sky to be adjusted so we
painted over the rocks and foreground,
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YOUR GUIDE TO IMAGE EDITING

Whan yvou paint over those areas, vou are hiding the
adjustrmeant so they become their original brightness again.
In fact, it would be nice to make the foreground rocks and snow

prighter, so let’'s get another Leavels Adjustment and add it to the
laver stack. This will be 'Levels 2,

@ Just as vou did with the ‘Levels 1 layer mask, paint with
vour saft black brush on the 'Lavels 2' layer mask over the
sky area and horizon. You are now concealing areas of the 'Lavels
2" adjustment so the sky goes back to being darker again

Mormal 4

Opacity: | 100%

Levels 2

@ There 15 no reason you can't add the same amount of blur
to the 'Levels T layver mask as well. The softening of the two
masks means thare are no cbvious joins betraying the fact that
various adjustments have been made. Thanks to the use of layers,
this has all beaen non-destructive editing.
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@ FPush the Highlights and Midtoneas sliders of the levels 2°
adjustrment Lo the left: as you do this, vou will see the entire
image become lighter, Concentrate on the foreground rocks and
snow and adjust the shiders until they look nice and bright. The
sky might be too bright but not to worry,

F_—_ ——
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@ If wou want, to blend the masks better, you can keep
the 'Levels 2' layer mask active and go to Filter = Blur =
Guassian Blur and choose a blur of about 125 pixels to help blend

the two adjustments you've made seem more seamless.
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@ Mow that yvou have both the Levels Adjustments in place,
you can revisit them at any time and tweak the settings to
vour heart's content, You can even go back into the layer masks
for each and use your brush tools to refine thase masks you
apphied in the first place.



@ The image has now been colour balanced and two sets of
adjustments have brought some sparkle to the snow in the
foreground and kept the sky dramatic in the background while
the rocks now have some nice detail showing in them as well.

s St b athad =]

How much Saturation you add i1s a matter of personal taste

but to capture the glorious colours of that sunrise, it's been
pushed to +36. You will notice however that the grass could do
with a little push to make it more vibrant.

USING THE PHOTO EDITOR EXPERT MODE

Hus/Sniuration..
Gradient Map...

= Pholo Fiber.. a1

frmoart

Trwashald...
Posferize, .

@ £ rarmgve casl

‘ E

@ Mowy lat's turn up the vividness of the image. Click an the
Create New Fill or Adjustment Laver button and choose
Hue/Saturation from the list that appears. A 'Hue/Saturation 1’
laver will be added to vour existing layer stack, Make sure it Is the
topmost layer

Hue/Satyi  Master LT i
| Reds X3t
_ o Vellows -
Greans x5
Mug  Cyans UG = 423
Saturation  UeS L7 e 30
| Magentas 8
Lightness: E]
[ ] Colorize
VA
18 faE* 75%. \o5*

@ Click the Channel button and you will see how you can
affect the saturation of the component colours. Select
Yellows and dial up the saturation and push the Hue slider to
about +23 to really bring out the vibrant green of the grass.

n -
_—— -
I

Hue/Saturation 1

@ At this point, you may want to perform more edits to the
image. [t s always good housekeeping to create a snapshot
of the work done thus far, To do this, press Shift + Alt + Cmd + E.
This creates a new layer which is a merged version of all visibia
layers, Mame this laver 'merged’

wiarw bdmpablications. com

@ You can now perform edits directly to the pixel data of the
'‘merged’ layer, safe in the knowledge that if anything goes
wrong, you still have all the original work on the layers below
which you can use to create ancther merged version. You can
alsa save vour document as a P5D file when complete,

BDM's Made Easy Seres | Volume 21 89



YOUR GUIDE TO IMAGE EDITING

election
Tools

Some aspects of image editing will require you to select certain areas of
a photo so you can either place it on another layer or edit it in isolation
from the rest of the image. With Elements, you have a number of options
for being able to achieve this and we cover them next.

Rectangular Marquee

T

o [his tool lets you make selections of square or rectangular
areas of yvour image. In addition to making the selectian,
Vou can add tot, subtract from it and intersect with it You can
make selections of a fixed size, fixed ratio or normal aspects. You
can alsa feather and refine the edge

The Lasso tool can be used o make area selections fram
vour image or active layer. The shapes yvou select with the
Lasso tool can be completely irregular and hand drawn. When
vou join the lasso back up to the point where you started, the
selection is closed.

3,
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Elliptical Marquee

9 The Elliptical Marquee tool behaves in the same way as the
Rectangular Marguee tool and has the same tool options
available. You can make circular and eliiptical selections of any
size or proportion. If you hold the Alt key, vou can centre your
ellipse over the cursor position,

Magnetic

o This tool uses edge detection to adhere to the edge of the
supect yvou are attempting to select in the image. You can
alter its parameters for more accurate detection in order to make
It snap to the edge of your subject. Areas of high contrast work
best with this tocl




Polygonal Lasso

9 The Polygonal Lasso allows yvou to draw point-to-point
straight lines around vour subject. This is good for
geometric and straight-edged zubjects where a perfectly straight
line s required. Like the Lasso Tool, when you join back up with
vaur start point, the selection 1s closed.

o Ihe Selection Brush s more of a freeform brush that lets
voul choose a brush type of certain size and hardness

and paint a selection around your chosen subject. You can also
choose to make it a mask instead, You can add or subtract from
vour selections in the usual fashion.

Refine Selection Brush

o The Hefine Selection Brush lets yvou make targeted

adjustrments to an existing active selection. In additional Lo
adding or subtracting frcm the selection you can actually push the
selection edge and smocth it by applying the refinement brush,

wnw bdmpublications.com

SELECTION TOOLS

Quick Selection

o The Guick Selection tool lets yvou paint a selection as if it
were a brush. It uses edge delection to attempt to match
vour selection to the nearest edge in the image. You can alter
brush size and settings and it worlks best on high contrast
subjects that are in sharp focus,

Magic Wand

o This tool is useful for the selection of image areas that

are the same colour and brightness. You can adjust its
sansitivity, refine its edge and also choose whether it will globally
select all areas of a chosen colour or just its nearest neighbours.

Auto Selection

@ This works in a similar way to Quick Selection except that

vou use Rectangular and Elliptical Marguees and the Lasso
and Polygonal shapes to enclose an area for edge detection to
work within, It works best with well-defined shapes that have
good contrast.
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YOUR GUIDE TO IMAGE EDITING

Cloning, Healing
and Enhancing

Even with modern digital cameras, a lot of photos may have
imperfections in them; for instance with dust contamination. This will
be displayed as a black smudge on the final photo. Removing these
blemishes is quite easy. The technology can also do much more.

Eye Tool

FRed-aye is causad by light from the flash of a camera 9 Click the BEve Tool () and simply click your cursor over the

reflecting off the blood vessels at the back of the eve when offending redness in the eyes of your subject. The tool will
the pupil is wide open. If you happen to find a favourite photo remove the rednass and vou can alter Pupil Radius and Darken
where vour subject has red-eye, then It 15 a simple process to values to make sure the red has been completely removed, It can
remove it. alsa be sef for Pet BEye as well,

Closed Eye Correction

kd €

PN

o Another great function available in the cptions pane! 1s the o Evas that closely resembile vour subject will work best or if
function to open closed eyes,. Click the Open Closed Eves you fave another image where the eyves are open, you can
button to activate the diglog. The image will scan for closed eyes load that and the proaram will automatically apply those open

and circle possible candidates, Choose the one you want. You eyes to your current image.
can then choose a set of apen eyes to merge into the shot,
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CLONING, HEALING AND ENHANCING

Spot Healing Brush Tool

] T T L Lty
LRI TR R LN L]t
- " [

o The Spot Healing Brush s great at removing dust spots
from photos and 15 also great for removing spots from
humans too. If you have a portrait and the subject has some
unwanted blemishes, yvou can use the Spot Healing Brush to click
on the spolt and it will use nearby pixels to fill the area.

L

100% | Doc:1LAMMIAM
Healing Brush
o [ : . Size: {_Je 30 px Source: Sampled
. ' ' i
| 20 Brush Settings... Mode: Narmal
] Clone Overla

[+ Aligned

o The Healing Brush is an clder version of the Spot Healing
Brush, It requires you to specify a sample point of a similar
clean texture which iz then cloned over yvour chosen area much
like a Clone stamp when you click on the target blemish or
wrinkle you wish to remove.

9 You can choose between Proximity match, Create Texture
and Content Aware, For most of vour subjects, vou may
find that you are switching between Proximity Match and
Content Aware. You can adjust the brush size for smaller spots.
With care, most blemishes and wrinkies can be removed easily.

When it comes to Healing Brush technigues, you will find

that subtlety is the key, Spot Healing i1s not perfect and may
require several attempts to get it right. Avsiding too many repeat
patterns is important to avoid creating a texture that doesn't look
like it has been cloned,

i 0
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o The Smart Brush uses edge-detection to allow yvou to brush
areas of your photo and apply different effects to those
areas, When vou select the Smart Brush Tool (F} the options
panel has an effects picker to let you choose which effect you
want to apply to your photo.

o Choose an effect such as a pencil sketch effect and begin
to drag your brush over the image, where yvou want the
effect to be seen. You can change brush size and settings such as
hardness and roundness and subtract from the current selection,
Choose the Detaill Smart Brush for mare refined selaections,
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YOUR GUIDE TO IMAGE EDITING

Clone Stamp Tool
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o After the Healing Brush Tool, the Clone Stamo Tool (S)
will seem guite familiar, It copies pixels from one area onto
ancther to remove things from vour photos. Despite recent
advances with the Content Aware and Spot Healing Tools, it
remains one of the best ways to remaove things from a photo

o Here is a wildlife photo from which we want to remowve the
distracting blades of grass that are sticking up to the right
of the rabbit. This is a good example of how cloning can quickly
remove elements from your photos with minimal effort.

Work vou way down the grass stem, vou can change the
size of the brush at any point by pressing the left and right
bracket keys on your keyboard. Take your time and don't o
afraid to keep selecting new clone source points so the colours
match the background when you clone out moare of the grass,

EDM's Made Easy Series | Volume 21

Select the Clone Stamp Tool (5). In the options panel, you

will have a number of paramaters to choose from such as
Size, Dpacity ang Blend Maode. The Aligned button, when tickead,
links o and moves your source point as you move your cursor,
Unticked, it uses the same source point each time

o Press the Alt key and select an area right next to the Lo
of tha grass as the source of your ¢ *ﬁed pixels. Now you
can clone that area over the blades of grass. If the colours don't
match, vou can reselect an area that more C|C='5E.‘|‘_-..f matches and
doesn't stand out as cloned.

o ne thing that really gives cloning away is a repeating
pattern. |t vou see a pattern bulding up, you can press
undo (Cmd + Z) to step backward though your last performed

ctions and change your clone source again to avoid the
repetition of that pattern.




CLONING, HEALING AND ENHANCING

o In the options panel, you also have the Fattern Stamp o You can change the Pattern Stamp's Size and Opacity as
available. As the name suggests, yvou can use this tool to well as the Blend Mode, Choosing Soft Light, for instance,
apply a preset pattern to your image. Click on the pattern picker allows a softer blend of the pattern into the image. Click

and choose the pattern you want to apply to vour photo, Impressionist to turn the patterns inte paint dabs for a more
artistic effect.

Blur, Sharpen and Smudge

e : ] - :
[ | A& | Mode: Norman i 5w e—C— 500 px
| Brush: * - - :
Lo ; D.Eﬁ_m-'“l-w
. Mode: | Normal - | Size:
] 1 §
5 : Strength:
. Brush: i .
g ' [_| Sampl
' ' ¥ Proted
- - T o
w r [ . - I' § -
D C 3 | Tl
Undo Redo Rotate Layout Organizer Home Scre
o The Blur Tool (R) is a fairly self-explanatory too! for adding e The Sharpen Tool (R) uses a brush tool to apply sharpening
Blur to specific areas of a pnota, You can choose a brush to your image, Like the Blur Tool, it is a more targeted
tvpe and alter its Size and Strength values for a subtle or intense method of adding sharpness to a photo. Choose your brush type
blurring of your subject. and alter the Size and Strength values to get the desired effect,

Strengtih: -l—:l—l BORE
|| sample All Layers

O PR ey I e e

o Approach sharpening with caution since It is very easy to o The Smudge Tool (H) can be usec to smear the pixels of
overdo it and ruin an image with over sharpening. Make your photo across the screen for a creative effect. Just
sure the Protect Detail button is ticked and begin to apply the like Sharpen and Blur, you can alter the brush type and set the
sharpening effect. Size and Strength of the effect, The Finger Painting button adds

colour to the smudged pixels.
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Doc: 15.1MM5.1M

o ) i.._ © Mode: Desaturate -
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ool Options'_ Undo __ Redo_ Rotate _ Layout _Organizer Home Screen | [Rotate Layout Organizer Home Screen
o The Sponge Tool (O} has two Mode settings of Saturate o It's & simple 1“.';- for adding targeted saturation or
and Desaturate. You can control the Size settl g5 as well EI"' desaturation 1o the photo. It is recommended to set the
the Flow of the effect you are adding to your image. You can also —low of these brushes to about 10%. Then gradually build up the
set LI.& tvpe of brush you wanl to use Lo apply the effect. -:1pm!|t_';1-_;::n aof colour saturation, the rer Tuwl of L:JIUI_.f entirely or
|ust lessen the vibrance of areas in the photo

e Click and drag the Spange Toal over the areas you o lhe Dodge and Burn Tocls are named after the
selectively wish to Saturate or Desaturate. Continue to technigues that were originally used in tragitional film
brush the areas to =*1r"rF"L—1':.f:, the amount of the effect vou are processing darkrooms. Dodging refers to selectively making
applyina. In this example, brushing using the Desaturate option areas lighter in an image and Burning is the ocpposite effect of
eventually turns the affected areas to arey. making Imageas darker,
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b Range: | Highlights v [i Size: e——— — 75
5 | Exposure: {» = 104

o
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ool !:Ia:rti-uns: Undao Redo Hotate  Layout Organizer Home Scraen

e e Dodge Tool can be used to lighten irTh'_H_.]-':"‘:i. Usa the
Range button to determine if you are affecting just the
Righlights, Midtones or Shadows in your photo for greater

control of the final result. Again, using very low Exposure settings
around 10% 15 recommendead.

TM15.1M

Midtones -

Size: :—{:}— 200 px
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Redo Rotate Layout Organizer Home Screen

o he Burn Too! will selectively make r‘.—n’r». of your photc
darker. You can darken the |-|-r|| lights, Midtones and
Shadows by clicking the Range button agam and adpsting

the Size and Exposure settings of the brush ,Jt ‘It;u- 5 key to
making it waork, so Exposure settings of 10% are a good start

wyrw bdmpublications.com
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o You can

want to make lighter. Thase tools work better for images

that

start with lo

contrast images will have less need for these kinds of adjustments.

Tam = ]
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Dase
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salectively brighten areas of the image that yvou

Wwer amcun:a of contrast to begin with, High

I

Jow youl can brush over areas that you want to be darker

and create more contrast. Since this particular method is
a destructive one, in that vou are altering pixels, duplicating the

layer andc

Figingt,

WOFKING on a copy Is a good way 1o avold 0sing
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YOUR GUIDE TO IMAGE EDITING

Draw, Fill,

Shapes and Text

The Draw section of the toolbar contains various elements to let you
paint, draw, erase and sample colours in your images. There are also a
number of text options available for adding text effects to your photos
and making masks in the shape of any text that you type.

Brush Tool

Mode: |

(2]

B
>4 ri:.n:uh Mode
" opacity: O 100%

52 9 C" - E E D

nutﬂﬂ-'mns Undao edo Rotate Layout Organizer HnmaS::muﬂ

e S T ] -

o The Brush Tocl (B) is one of the most often used tools

i the photo aeditor's arsenal, Whather you are painting
directly over a photo, or adding brush strokes to a layer, the
Brush Tocl is designed to behave like its real world counterpart
but with more powerful features built in.

9 When you click on the Brush Tool, the options available are
guite varied. You can control brushes with vour mouse or if
vou use a tablet, you can contral it as if it were an airbrush with
pressure sensitive effects for more artistic flair,

9 You can choose ary number of brush types from the brush
picker ana alter the Size and Opacity values. Youd can also
load new brushes that can be purchased and downloaded from a
large number of vendors specialising in photo editing tools.
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o You can choose the colours vou brush with and also use
the Brush Sethings shiders to change how much the colaurs
fade and alter with each brush stroke, You can also tell the brush
how much Scatter or Spacing to use with each brush stroke you
apply. Tablet sattings are also availabla
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When vou paint with this brush, the image beneath the

o Mext to the standard brush is the Impressionist Brush Tool
cursar is turned into a series of loose curls, swirls and

(B} Using its various Brush Settings you can turn your

photo into a painting much in the style of the old impressionist daubs. The |larger the brush size you use, the more abstract the
painters whose works were rendered as a series of dots, strokes image becomes, Using a brush that is too large will render the
and swirls. photo unrecognisabla,
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: i Limits:
amr Replacement Tool (B) Lo Z I3 Brush Settings
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o The next brush is the Colour Replacement Tool (B). Select 5 Cur example picture is of an owl set against a green
foreground colour in the toolbar to use as the replacement background. The celour of the background can be replaced
colour. Once again, you have a number of tool options available fFairty easily since the owl itself contains no strong green colours
including Size, Tolerance and Limits. that match the background oo closely
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o The Colour Replacement Tool works by continuously @ In the case of the owl image, dragaing the Colour
samphng the colour directly under the cursor position. The Replacement Tool over the green areas next to the owl
colour beneath the cursor will then be replaced with whatever replaces that colour; but the owl remains untouched since it is not

vou have chosen as the foreground colour, You can select the the same colour as the colour beneath the crosshair of the tool,
Blend Maode used to effect how the replacement colour is applied.
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YOUR GUIDE TO IMAGE EDITING

Eraser Tool

& Type: () Penci
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o Much like its real world counterpart, the Eraser Tool (E) o If the photo is on a layer, then erasing pixels will revea
removes pixels from your image. Whatever colour you have transparent areas instead. Again, if you alter the Size and
chosen as the background will be used to erase pixel data from Dpacity of the Eraser Tool, those transparent areas can either
the photo as if it were a solid coloured brush. You can also sat be fully transparent or partially transparent, depending on brush
the Size and Cpacity of the eraser. opacity settings,

A

o The Background Eraser Tool (E) is a useful one for targeted o You can alter the Size and Tolerance of the brush, as well as
removal of certain parts of an image. It behaves a little like the softness and spacing of the brush you use. Tolerance

the Colour Replacement Tool but in this case, any pixel colour 15 key to setting the sensitivity of the brush to changes in colour,
beneath the cursor is erased, leaving the area transparent when High Tolerance will mean more varied colours are removed under
It's on a layer. the cursor position.

o In our example, the blue can be remaoved sky from the o The Magic Eraser (E) is a more global erasing tool. Set vour
photo by placing the cursor over the blue areas to be Tolerance higher for more colours to be Included or lower
removed. As you click and drag the mouse, any blue that falls to pick out less shades of the target colour at the cursor position
under the cursor position will be removed, but the white clouds When you click on the blue sky, large swathes of that colour will
rermain untouched since they are not blue. be removed with each click of the mouse,
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DRAW, FILL, SHAPES AND TEXT

Paint Bucket Tool

‘
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o The Paint Bucket Tool (K) allows you to fill areas with solid
colours. You can set Opacity, Tolerance and Blend Mode,
High or low Tolerance settings mean it will use edge detection to
decide which areas can be filled or ignored,

= i
:
|
E m =

o You will notice there is an option for Contiguous fll. IF it is
ticked, only the nearest neighbouring colours will be filled. If
the Contiguous button is unchecked, then all matching colours in
the image will be filled, noc matter where they are in the photo

¥ il

9 You can fill and antire layer, or it can be used to fill specific
areas based on what edges it encounters. Our example
has a cartoon character on a white background, His outline is
guite well-defined so clicking with the paint bucket means the
background can easily be filled with a colour.

o In addition to the Paint Bucket, you also have the Pattern
Fill option. Once again yvou have Tolerance settings and
Dpacity values to alter. Choose a pattern and use that to fill an
entire layer or in the case of our cartoon, the blank background
can be filled with texture.

Gradient Tool
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o The Gradient Tool (G) lets vou fill areas of yvour image or
antire layers with colours that fade frorm one to another or
can fade from one colour to transparent. The Gradient Tool does
not use edge detection. |f you need a filled shape, it needs to be
defined by a selaection.

o You can pick the kKind of gradient you want to use by
clicking an the Gradient Picker and choosing a presat from
the list, Thay range from Foreground to Transparent to multiple
colour gradients all at the click of a button.
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YOUR GUIDE TO IMAGE EDITING

Gradfant Editar |

VAL

o If vou want to make vour own gradient, you can click on
the Gradient Editor and add what are known as Colour
Stops Lo a basic gradient, change their colour and define if thay
are solid or transparent. Any custom made gradients can be
caved as a preset.

o When you let go of your mouse, the current gradient will
Da appl ed and fills the active selection around the camera.
The default Gradient Type is linear, meaning that the gradient
travels in a straight path from start colour to end colour.

Qur example of a camera on a white background could
use somea colour. The background has an active selection

around it to enclose the gradient when it 1s added. You can click
and drag your cursor to draw out a start point and an end point
for the gradient to follow,
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o If required, yvou can change the type of gradient you are
wsing from its default. You can also use Radial gradients,
Angle, Reflected and Diamond gradients, They can all have their
Blend Mode altered as well as Opacity. They can be reversed and
Transparency and Dither turned off

Colour Picker

o The Colour Picker () does as the name suggests. When vou
chioose this tool, it gives you a small evedropper cursor that
when clicked on a photo, picks the colour beneath the cursor
position and makes it the active foreground colour.
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o You can choose whether it samples asingle pixel ora 3 x
Javerage or a 5 x 5 pixel area to create an average. The
colour it samples can be across all lavers or a sinale layer,
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DRAW, FILL, SHAPES AND TEXT

o Choase from a number of praedefined shapes and add them
as vector shapes on a new layver. Choosa their colour and
Layer Style from the Style picker, You can also choose whether
they are of fixed size or unconstrained and if you add to a shape
or subtract from it

o Cince voud have chaosen your settings, vou can draw out
the shape an your photo. You can click and drag from the
corner oubtwards or choose From Centre to draw the shape out
frorm the cursor position. The snape will fill with vour chosen
colour when you |let the maouse button go.

Horizontal Type Tool
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o The Harizontal Type Tool (T) gives yvou a multitude of text
options. Choose your font, its colour and size. You can then
tvpe on your docurmeant and a naw text laver will be added above
vour photo, The text can be manipulated and bent into a curva or
other shapes for creative effects,

o You also have vertical text options, text for masking and
the ability to fit typed text to a shape or path. Our example
shows a E'Jttérf!';.-'"j autline with sample text I:-:3||G‘-*~'ir"lg the autline
of that shape

Pencil Tool

Mode:  Norma v |
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o The Pencil Too! (M) is designed to act like a real world pencil
and 15 a hard-edged tool that has a number of preset pencil
tip shapes to draw with, You can choose the Size, Opacity and
Blend Maode for your pencil strokes along with its colour,

bdm lications.com
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o You are then free to use your mouse or tablet, to sketch and

draw with your pencil as yvou see hit. You can draw directly
over your existing imade or create a new layer and draw on that
o as to preserve your original image,
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YOUR GUIDE TO IMAGE EDITING

Modlity, Crop, Move
and Recompose

The Modify section of the toolbar contains a set of tools that give you the
ability to crop in a number of ways and to scale your images but protect
certain parts from being affected during the scale. You can also move the
subject of your photo from one part of the scene to another.

Crop Tool

. Crop Suggestions : E ) Bt |
: B ! . 16xSin
- = =~ 5 s @ ?, 25x2in
: , o 3x5in .
: ' b : , 5x5in i
S _ E? ‘ 4 sx7in E "'ﬂ
n - [ — i g 8x101in ¥ ; )
.a - n 8 Bin “Tool Options* U mmmane Organizer Home|
o The Crop Tool () is the most common method of cutting 9 You can use set proportions to crop or yvou can go it alone
areas of vaur photo off in order to change the composition with ro restrictions and make your own crop. Simply click
and proportions. When you click the tool, the ocotions panel wil and drag your mouse across the area of the scene that vou want
display some suggestions for yvou as to how it thinks the image to be cropped and a gridded box will show yvou the current crop.
can be cropped. You can use those or make your own crop. You can click the green commit arrow to proceed.

N S S
el . " H ] Draw shape from center
s oy o Geptmepgennd A
A - - L - e "-. - Ll
B Gak @ = [ = . hol Options®  Undo Redo  Rotate  Layout Organizer Home Screen
Within the crop tocl options you also have the Cookie o With your shape chosen, you can drag it over your image
Culter Tool (C), which lats you cut out images using a ancd scale it to cover the area of the photo you want to
number of preset shapes, You can choose from all the available crop. If you tick the From Centre button in the cptional panel, the
shapes such as butterflies, snowflakes, graphic symbols and shape will be drawn ocutward from your cursor position, You have
Much more, the option to feather the crop if vou want.
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MODIFY, CROP AND RECOMPOSE

If you hold the Shift key as you drag, you can keep the
shape's proportions lockad. When vou let o of the mouse,
the image will be cropped in your chosan shape. You than have
options available that let vou Rotate, Scale and Skew the shape
until you have it how you want it,

o The Perspective Crop Tool (C) lets you draw a crop box
around a spacific part of yvour photo that is distorted and
gives you a chance to crop and remove the distortion at the
same fime. You start by drawing a crop box around the area you
want to crop.

o When vou click on the green commit button shaped like a
Licl, the Perspective Crop Tool will crop and streteh out the
image, removing the distortion. It may take a couple of attempts
but it can help vou rescue some tricky, distorted images

o You can then begin to manipulate the crop box to match
the perspective of the object you are cropping. \Use the

control points around the crop box to drag the box out to match
the subject. In our exampie, the road sign gives us some helpful
straight lines to match the perspective.

Recompose Tool

| O
-5419 | Size: === 500px || NoRestriction
LA | et R B
- ;

Rotate  Layout Organizer Home Screen S R T

L w
i

2

C;.
Unda Reda

e

o The Recomposs Tool (W) uses content aware scaling
technology to let vou scale images to a different
proportion, but only scale areas with no detail. You can alsc
select areas to remain untouched by the scaling process for a
much better final result.

9 Here is an example of a rally car with a lot of empty space
to the right. It could be cropped but this image provides
a good excuse to try the Recompose Tool. The opticns panel
dispiays a number of tools to help yvou with the scaling process
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o You can use the Mark For Protection brush to highlight
areas that yvou want kept intact and untouched during
the scaling process. Similarly, you can also make areas that you
want removed, You can adjust brush Size and Threshold and
any scaling restrictions you wish to apply.

e You can begin to drag the control paint inwards and as
You do, all the areas thatl are unprotected will concertina
together and the program will attempt to blend that pixel data
together The areas that are selected to be protected will not be
crushad togethear,

Once you have marked out your image and have either
selected areas to protect and areas to remove, yvou can
click and drag on the contral points around the perimeater of the
image, In this case, we are going to drag the right middle control
noint inwards.

T
ol o & - e

e e e

o The control point can be dragged all the way across the
image. All the dirt and dust on the right of the image has
peen merged into the space that remains now the image is half
the width it was onginally, out the car is unchanged.

Content Aware Move Tool

o the Content Aware Move Too! (Q) uses similar technology
o the Recampose Tool but in this case it lets you move
an object in your photo and place it elsewhere in the shot and
blends it kack in and fills the onginal gap left by the subject,
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o The options panel givas you some simple tool parameters,
You will need to draw a selection around the object in

the photo you wish to move. You can add or subtract from the
selection you've made by using the Mew, Add, Subtract and
Intersect coticns provided,



MODIFY, CROP AND RECOMPOSE

e With the tool active, you can draw around the subject
that is going to be moved. Be awars that areas with
complex content can be a challenge and the area you move
vour subject to needs to be of a similar texture and colour for it
to work properly.

o The Content Aware Move Tool will bBlend the image
together. It can be a hit and miss process and may require
the settings to be tweaked. You can also try selecting more of
the area around your subject for more blend data to be used.

o Enclose your subject in a selection and then drag it to its
new location. The Healing slider controls how aggressively
it tries to blend the image into the new location and also fill the
qap |t leaves behind. The Mode can be altered from Move to
Extend to stretch your selection if reguired,

o We tried the sailboat image and also a simple abject on
grass. The grass image yielded better results after a few
atternpts but it still needed some cleaning up with the Clone
Stamp Tool to remove some obvious artefacts and blend in some
untouched grass,

Straighten Tool

| [File soges st suighienng e mage
Fil‘i’f S ¢ DE E 9
Bin

‘Tool Options . Undo Redo Rotate  Layout Organizer Home Screen

o The Straignten Tool (F) will easily take care of wonlky
landscape photos and get them level again. You have a
number of options as to how the image is handled once
straightenad. The canvas can grow as reqguired when rotated,
stay the same size or be cropped to remove the background,

e Simply click and draw along a slanted horizon line that
neads to be level. Whean you let go of the button the
horizon will be levelled. There is an option to Autofill Edges,
When the Image is rotated, any blank areas will be filled with
rearoy similar textures,
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Now that you've experienced what Elements has to
offer and how the major tools work, it's time to try out
some more involved projects to help you hone your
skills. The Quick and Guided workspaces are all well
and good but if you really want to understand more
about digital manipulation, then it's time to fire up the
Expert workspace and dive in. There's an old saying:

'the best way to learn, is to do'. With that in mind, let's
do it!
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TAKE YOUR SKILLS FURTHER

BEFORE

lue skies are wonderful. They mean we are having a lovely sunny day. This is particularly

meaningful if you live in the UK, which is often the butt of jokes about its horrible weather.
No better time then to get out and take some photographs. The only problem you may find if
you're anything like us, is that landscapes shot on days like this can look a little dull. The light is
great, but the sky is lacking in any drama and it’s just a big, blue, empty canvas. Sometimes the
sky is lovely but it’s in the wrong part of the image in relation to the landscape you were trying
to shoot. Well, there is an answer to your woes with sky swapping. It requires your primary photo
and a photo of a cloudy sky.
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File Edit Image Enhance

{3

ais

— - ler
Open in {;ar['rrera Raw.. \

Open Recently Edited File

o 1
R

SKY REPLACEMENT

T T

o To bedin vou will need vour primary photograph. Go to File
> Dpen (Cma + 2 and use the file browser Lo navigate to
the location your photo is stored. You can double-click the image
to open it or highlight it and then click on the Open button in the
loweer right of the browser window,

o The first thing that will need your attention though is the
horizen. In the case of this shot, the camera was tilted
slightly and it means the horizon is not on the level. Luckily, there
i5 & tool that can help us sort this out with just a few clicks

o Cur example is a shoreline image taken on a beautiful blue
sky day. Unfortunately, that blue sky just looks a bit empty
and is in need of a little attention to make it more appealing.

All the trees and rock details below make the image ook a bit
bottom-heavy. Some clouds should help.

) T

Grow or Shrink ¥ Autofill edges

o o to the toolbar and in the Modify section and then click
on the Straighten Too! (P) to make it active. When vou do
this, the options panel at the bottom of the screen will display
all of the available parameters and options available for that
particular chosen tool,

/386M

Rotate All Layers

—

. 3 )* Ha il
-
e - :

When the image s straightened, vou can choose how the

crop is dealt with once the photo is rotated. You don't want
to lose too much of the photo so choose the Grow or Shrink
Canvas to Fit option, This way, it won't matter how much the
image rotates, it will not be cropped.

wonw bdmpublications.com

o Since rotating the mage will create blank areas at the
adges of the photo. you can also select the Autofill Edges
option, This uses the Content Aware Fill tEChﬁﬂMg}" to analyse
the nearest textures at the edges and fill in the blanks using
cloned texture,
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TAKE YOUR SKILLS FURTHER

o Mow vou can actually straighten that horizon out. Take the
Straighten Tool ana click and drag a line across a tilted
area that yvou know has to be level. In the back of this photo is a
shoreline which can be used as a guide, Drag along it from left
to right,

- N wm N e
S0 owe = o

o When vou let go of the mouse, tha Straighten Tool rotates
the image enough to level out the shoreline. The antire
image rotated about 6%, which has created blank areas as the
canvas expanded to make sure the photo was not cropped,

Create -~ Share

Opacity:

o When you choose to Autofill the edges, the blank areas are
now analysed and then filled with similar textures. Because
of the random fractal nature of the trees, rocks and sea, the filled
areas match very well, with no obwvious cloning errors to be seen.

LI B2 « B tutorials

—

Shared Folder

~ N

0 Dur example clouds were chosen because they are litina
similar way to the primary photo at roughly the same time
of day. This is an important consideration since vou want the
clouds to look as if they belong in the shot, otherwise the effect
15 gaing to ook very odd,
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@ If you click on the layer thumbnail for the photo, you can
rename it. We called ours 'shore’. Now the image is ready
far its blue sky makeover, Go to File > Open (Cmd + O) once
again and navigate to the folder where your cloud replacement
photo s kept.,

@ Double-click the 'clouds' image to open it. Since you only
need the clouds, you can selectively choose just that area
to add to the primary photo. Go to the tocibar and choose the
Rectangular Marquee Tool (M), You can use this tool to drag a

selection box from the top left corner to the right horizon.



Editor File Edit Image Enhance Filter View W

Undo Rectangular Marquee 3.7

Layer Select

Paste Into Selectio

Deletg

Stroke (Qutline) Selection...

Define Brush from Selection...
Define Pattern from Salection...

When vou let go of the mouse the selection you drew

will become active with black and white dashes known
as 'marching ants’, With the selection active, go to Edit = Copy
(Cmd + C) to copy the selectad sky area to the clipboard ready
to use In your photo.

!
* shore.jpg @& Sd.fi

Move Tool (V)
" ENHANCE

e P

SKY REPLACEMENT

@ Click on the document tab of vour primary photo to make
it active and go to Edit > Paste (Cmd + V) to paste the
copied clouds onto the current photo. It will automatically appear
centred on its own layer so as not to destroy the shoreline photo
below it. By default the new layer s callea 'Layer 1,

et
@ 5o to the toolbar and choosa the Move Tool (V). You can

use this to physically click and drag the clouds into the top
left corner of the photo and set about making it the right size to
makch the dimensions of the primary photo.

@ You will see that an active layer element will have control
points around its perimeter. You can click and drag these
control points in order to scale the clouds to fit the new photo.
In this example, clicking and dragging the far right centre control
point to the edge of the photo,

OO O8 5

 Normal -

® 8 clouds

@ You can rename 'Laver 1" as 'clouds'. Mow click on the little
aye icon to the left of the 'clouds' layer thumbnail. This will
make it invisible for the moment. You need to work on the 'shore’
layer, so click its thumbnail to make it active.

-9’ . .’5‘* e Mem— 50 $1
; e ; 50 ! Brush Eettings gL
_}% P

@ =0 to the toolbar and choose the Quick Selection Tool

(A). You need to use it to make a selection of the sky area.
With the Quick Selection Tool active, yvou will see ","El"IDLS options
available in the tool options panel at the bottom of the screen
Choose a brush size of about 50 pixels.
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TAKE YOUR SKILLS FURTHER

@ Use the Quick Selection Taaol to start selecting just the blue
sky, Drag the cursor over all blue areas, avoiding all others,
and it will automatically select as yvou go. Because the tree line

15 of a different colour and hard-edged, the selection tool has no
real difficulty in choosing just the sky.

9 Simply start to brush over the areas where the sky meets
the harizon line and trees. The Refine Edge tool will make

more accurate, targeted refinements, particularly around the tree

areas, If yvou are happy that the selection is as good as it can be,
you can click OK to proceed,

Refine Edge.

Sample All Lay

e e (! o 8

@ With all of the sky selaected, vou can now use the Refine
Edge tool to make the selection even more accurate. Click
the refine Edge button in the tool options panel to open the
Refine Edge dialog panel. In this case, the default Edge Detection
and Adjust Edge settings will be fine.

@ The selection edge will be refined, ready for the next step
Click the 'clouds' laver visibility icon to make it visible
again and you will see the salection, denoted by 'marching ants’,
overlaid on the clouds. Keep the selection active and make sure
the 'clouds’ layer is also active.

@ Click on the Add Layer Mask button in the layer options
panel and a laver mask will automatically be added to the

‘clouds’ layer in the shape of the active selection. Anything inside

the selection is white, anything cutside the selection is black,
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@ When yvou Alt + left-click on the layer mask thumbnail, vau
can view the mask on its own in black and white. You can
zee how the Refine Edge Tool has quite accurately masked the
trees and horizon, You can Alt + left-click the layer mask again fo
returny to the normal view.
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Layer mask thumbnall

Solid Color...

Create -
JPlo e
al

—  Gradient...

]

Gradient Map...
Photo Filter...

Invert
Threcshold...
Posterize...

With masks. the rule of thumb to keep in mind is that white

reveals part of a masked image, whereas black will conceal
areas of your photo, In this case, the clouds are allowed to be
visible but anything below the trees s hidden by the black areas
of the mask.

Opacity: |100% | ~ |

Rename Layer...
Edit Adjustment

Duplicate Layer...
Dalete Layer
Group from Layers...

Disable Layer Mask

@ It would be good if the sky was just a little darker to match

the exposura of the primary photo. Keep the ‘clouds’ layer
active and click the Create New Fill or Adjustment Laver, Select
Levels from the meanu that appears. A 'Levels 1" adjustment layer
will be added above the 'clouds' layer

Right-click the ‘Levels 1" adjustment layer and choose

Create Clipping Mask from the context menu that appears.
This will clip the adjustment layer to the 'clouds’ layer which is
directly below it in the stack. Any adjustments made will only
affect the 'clouds’ layer and nothing else.

The shiders in the Lavels panel allow vou to darken ang

lighten the Shadows, Midtones and Highlight areas of the
phicto. Dragging the Midtones slider to the right slightly will
darken the sky. You can experiment with all the sliders until you
Fave something yvou like,

bdm lications.com
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A small box with an arrow will appear to the left of the

adjustment layer thumbnail to indicate it has been clipped
tor the layer below, A Levels dialog panel will open automatically,
ready for you to make adjustments to the clouds,

@ With that, your sky replacement is complete; vou can go to
File > Save As and save yvour layvered document as a P5D
file. This will keep all your edits intact should you ever want to
revisit this image and make more amends to it,
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hanks to digital technology you can be a makeup artist and control exactly how you want

your subject to look. Naturally, there are numerous ways you can go about retouching
skin. Some techniques are very simple but do not give natural results. Some people take it to
extremes and end up with their models looking like mannequins. All we are looking to do is
make our model’s skin look as healthy and glowing as possible. We are going to use a technique
called frequency separation. Simply put, you break the base image down into two components.
One layer carries just colour and tonal information, the other layer holds detail and texture. This
means you can work on one, without affecting the other. It’s a simple and effective method.




FREQUENCY SEPARATION

Create + Share ~
U Je 0 a & o =

Normal %) Opacity: |100% | ~

o Our example is from a portrait shoot of a young qirl called o Click the 'Backgrounad’ layer to make sure it s active; it will
Courtney. Opan the photo in Elements as a new document righlight in blue to let yvou know it is selected. Then press
Courtney has scme makeup applied but she had some spots that cmd + J to create a duplicate layer. Name this layer 'colour’,
the makeup couldn't cbscure so we are going to Improve har Highlight the 'colour’ layer then press Cmmd + J once more to
complexion by removing the blemishes from her forehead. create vel anather layver which vou can name 'texture’,

Create ~ Share ~
Y U@ 0a 5 o =

Normal - Opacity: ‘i_'IGEH'E -

Create ~ Share ~

Opacity: i[mcﬁ:,

&

o Make sure the texture’ laver is now highlightaed and press

Cmid + J one maore time to create a layer that will be called b clicking on their visibility icons to hide them. Make the

‘texture copy’. These are all the layers yvou need to begin creating '‘colour’ layer active, What you are going to do is turn this layer

your two main layers of texture and colour to edit. into colour data only, To do that yvou need to blur this layer to
remove any obvicus detail.

o Make texture copy' and texture’ invisible for the moment

-
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Layer Select Filter View Window Heip

Filter Gallery...
Correct Camera Distortion...

Acustments
Artistic
Biur

Brush Strokes

Average
Blur
Blur More

Lens Blur...
rMotion Biur...
Radial Bilur...

rF Y Yy Ty rYyrywm TrvwT™
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9 o to Filter > Blur > Gaussian Blur to call up the blur dialog
panel. Sat the blur Radius to about 10 pixels. You have to
apply just enough blur to remove any hard details but leave the
general shape and colour intact. Do not over blur the image ana
merge colours together too much.

Select Fiter View Window Help

Gaussian Blur H¥F
Filter Gallery...

Correct Camera Distortion...

Adjustments

Artistic

Equalize
Gradient Map...
Blur Invert . 3£l
Brush Strokes Posterized..
Distort Threshold...

Fhoto Filter...

W ——m o

o The texture copy” layer is blurred to the same degres as
the ‘colour’ layer. You can use this layer and the un-blurred
Texture' layer below it to create the second component needed
for the skin retouch. To de this, go to Filter > Adjustments >
Irvert (Cmd + 1D to invert the texture copy’ layer colours.
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Create ~ Share -~
il =
Opacity: |100% | +

J e da s

Normal =

Filter View

Window Help
Gaussian Blur ®F

Filter Gallery...

Correct Camera Distortion...

Adjustments
Artistic

Blur

Brush Strokes
Distort

o Make all the other layers visiole again and make the "texture
copy' laver at the top of the layer stack active. You need to
apply the same blur amount to this layer, Go to Filter and the top
mend item will be the last effect yvou applied. You can also press

_rmd + F to apply the last filter you used,

o All the colours of the 'texture copy' layer will be inverted
like a colour negative. With the texture copy' layer still
active, move the Cpacity slider down to 50%. What vou see now
Is @ combination of the 'texture' layer below and the current layer
at 50% opacity. These two lavers need to be merged.



FREQUENCY SEPARATION

o
Opacity: 1 (0 ".'._
Rename Layer...

Edtil Adjustrrent

Yoo Oa st W -=
:Hunn:'lln - | Opacity:

100% |~

|_", it

Enable Layer Mask

Create Clipping Mask

Link Layers

La ':I" ————
Set the blending mode for the layer

texture

Merge Visible
Flatten Image

= a

o Hold the Shift key and click on the texture’ anad texture @ Mext, keeping the new texture’ layer active, go to the Blend
copy’ lavers to select them both, than right-click them to Mode button and choose Linear Light from the dropdown
call up the context menu. Choose Merge Layers to merge them list that appears. This will blend the texture’ layer into the ‘colour’
into one layer. You can rename this layer 'texture' now that it is layer below and the result of the two should look identical to the
ready Lo use. ariginal image.
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o You now have vour two components. The top texture layer @ Click on the texture’ laver to make it active. Texture will be
Is detall only with no colour data and the 'colour’ layer is your first stop for cleaning up the skin. Go to the toolbar

anly colour information with no real detail. This is the process and choose the Clone Stamp Tool (5), When vou click on it,
of frequency separation In action, Editing is much simpler now you will see various options become available down in the tool
colour and detail are separated from each other, aptions panel.
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@ 5o to the brush picker and choose a hard round brush, You @ Mow the process of cleaning the skin can start. Place yvour
can alter its size later. Hard brushes generally work beller cursor aver an area of skin that is clean and unblemished

for the kind of cloning of skin we are about to do. You can use close to the first area you wish to start retcuching, Press the Alt
the Size slider to set a brush of about 25 pixels, To begin with, key and a small target cursor will appear, Left-click the cursor
keep the Aligned box unchecked and Moae kept as Normal, aver the clean skin to set that as your clone source.
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@ Mow you can move your curscor over the nearest area of Mow you can carefully begin to clone clean skin over the
olemished skin you want to retouch. You should see a plemishes on her face. You can always press Alt and choose
realtime representation of the clone source at the cursor position. a new area of clean skin as vour clone source if the texture
When you click over a blemish, the clean source area will be changes too much and needs to be updated, Remember that all
'stamped’ over the blemish, these edits are only happeaning on the 'texture' layer,

0 Take you time with this part of the process. Keep changing @ Dnce you are happy that her faorehead 1s done, you can
yvour clona source to avoid the build up of repeating make amends o any other areas of her face and neck that
patterns that give the game away as to the use of cloning. You might cleaning up. You can remove wrinkles in exactly the same
can use the Size slider to make the brush larger or smaller if way by clening clean skin over them. Stray hairs can also be
needed as well, cleaned up as well,

120 BDM's Made Easy Series | Violume 21



FREQUENCY SEPARATION

', Softens edges of the selectio
e T yeerr—

@ Mow that the 'texture’ laver is completed and her skin is
looking flawless, you can turn your attention to the 'colour’
layver and even out any mottling that may be present. This is

an optional step, but it does give the portrait that extra level of
professionalism andg is very flattering.

@ There 15 a amall amount of mottling visible on her forehead
which we want to remove, as well as softening the shadows
around her left cheak, nose and chin. Draw around the areas you
want to soften with the Lasso Tool. Join up to your start point
and the selection will ba closed and softened by 35 pixels,

@ 50 to the menu and choose Filter > Blur > Guassian Blur to
call up the blur dialog panel. Set the Blur ratio to about 30
pixels or however much you feel is needed to blur those areas a
sufficient amount, to remove any mettling from her face. Click
Ok o bBlur the selected parts of the iImaage.

bdm lications.com
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@ Make the texture’ layer invisible and make the ‘calour’ laver
active. Go to the toolbar and choose the Lasso Tool (L), The
Lasso optional panel will show vou various options avallable for
this tool. Go to the Feather slider and set it to about 35 pixels to
soften the selection vou are about to make.

L I T |

D

Undo

@ Press the Shift key or click the Add button in the opticns
panel to add more selections, An area around her left cheak
has also bean included and again, softerad by 35 pixals to avoid
any hard edges to the colour. Keep this selection active for the

hext part.
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@ It wou want, vou can also do the same to the highlighted
areas of her right cheek to give more of a matt finish to her
skin. It behaves a bit like adding more digital makeup foundation
ta her skin, When you are happy, vou can go to File > Save As
(Shift + Crnd + S) to save yvour finished result
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Cnmpnsiting is the combining of visual elements from separate sources into single images,
often to create the illusion that all those elements are part of the same scene. In this tutorial
we will be looking at a fairly typical approach for the two main elements of the image which is
the grey/neutral background compositing technique. Shooting your main subject against a grey
screen gives them a well defined edge that makes the process of blending them into another
environment all the easier. Grey screen compositing is the choice of many graphics professionals

and is easier to do than you might think. We have a scenario in which we have a photo of a cellist
and want to put them into a much grander environment than just a grey background.
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o =0 to File > Open and navigate to where the components
for the scene are stored. In this example, we have our cellist
image and a rendered scene to put her into. Highlight your

images and click Open to create two new documents in Elements.

— Jrr— -
e —— T g
i — el Ty
- Ll
Omm s
B Livwl Dbl s e |

o The other image we will be working with is a 3D render of
a baroque ballroom. There is a perfect spot upan which the
cellist can be placed. Now, you have the two images that will be
combined, You wil see that it is not done in the conventional way
that vou might imagine but is very effective nonstheless,
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COMPOSITE IMAGES

o Ve have ‘cellojpg’ ana room.jpg’. You will see that the
cellist is an a grey background. All the lighting gear
and extraneous items present in the shot have been ¢lonec
aut leaving just her and a plain grey background. The grey
Brackaround is a key part of this process.

nents 2019 Editor File Edit Image
Undo Select Canvas ®7

Enhance Layer Select Filter View

Revert

[cello, RGBfE*) * =
- L

Copy Mergad
Paste

L S o
.

Paste Into Selaction
Delate

Fill Salection..

Stroke (Outhing) Selection..

Define Brush from Selection...
Define Pattern from Selection...

Clear [

iCotor Setungs.. TEE
Prezat Manager...

Start Dictation..

o For the moment. return to the ‘cello’ document and click on
the layer lock icon next to the layer thurmbnail to unlock the
layer. Go to the 'room’' image and do the same, Press Cmd + A to
select all pixals on that layer and then press Crd + C to copy the
room’ image, or go to Egit > Copy.
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TAKE YOUR SKILLS FURTHER

»p Elements 2019 Editor File Edit Image Enhance Layer S
Undo Name Change ®Z

Revert {+r3k A

44.45% (cello, RGB/E") * |

& =
Opacity: |100% | ~

9 =0 to the cello’ document and go to BEdit > Paste or press
Cmd + WV to paste the copied room image into the 'cello’

document. It will appear on its own layver above the 'cello’ layer.
You can name this new layer 'room'. For the moment, click tha
visioility won of the 'room’ laver to make it invisible,

d .
: New i
: : Refine Edge...

o Cliclk the 'cello’ layer to make it active. You need to make

a selection of her outline to start the compositing process.
Go to the toolbar and select the Magic Wand Tool {A). Although
the Magic Wand s a fairly simplistic selection method, it actually
wiorks really well in these situations.

Add to selection

|

Refine Edge...

.
L R e T

E o

\J
r

o Set the Magic Wand Tolerance to about 35 and make sure
the Contiguous button is checked. Position the cursor over
the grey background surrounding the cellist and left-click. The
Magic Wand will select as much grey as the Tolerance setting
dictates. Now we need to add the parts it missed.
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o Click the Add To Selection button and a small plus symico
will appear on your cursor Lo indicate anything selected will
be added to the currently active selection. Now you can click and
add more grey areas until all the grey is selected.



COMPOSITE IMAGES
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o Make the room’ layer visible and active again. You will see @ Go to the layer options panel ana click on the Add Layer
the selection you just made overlaid an the Image as & Mask button. When you do, a mask in the shape of the
series of black and white dashes known as ‘'marching ants’. This selection will be added to the 'room' layer. Anything within the
selection can be used to create a mask in the next step. bounds of the selection will be white and anything outside the
Baunds will be black. White reveals and black conceals.

wl A0 e a8 by I

+ Mommad
Diissalve

Drarken
Wty
Codaor Baurn
Linesr Burn
Darker Colne

LAgFEn

ST

Cefor Dodge

Larss Digdige A}
Lightar Codgr

Saft Light L |

- Hard Light
A } Wil Ligha
a A FEEY
! La 3 }
N I
-

o You might notice that the cellist looks a little too much @ Any area of the neutral grey 'cello’ background that is
like a cul out figure, You can remedy that by changing Blended with the 'roam’ layver makes no visual difference
the Blend Mode of the 'room’' layer to Overlay. This blends the but any parts of the grey background darker than about 50%
pixels of the 'room’ layer into the ‘cello’ layer. Only the cellist is grey show up, This s great since the cellist's shadow now
unaffected by the blend bBecause of the mask on the laver above, appears on the ground.
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TAKE YOUR SKILLS FURTHER

Create ~ Share ‘
J @ 0 6 5 ]
Opacity: |100%
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; Brush: ~ - Mg
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@ Mow we can beacin to make the whole image more
caheasive. With the room’ layer active go to the layvers
palette and click on the Create New Layer button. Call this new
layer 'mist’. We are going to add a subtle atmosphere behind the
figure which is a popular thing to do in images like this:

I e s e I e R el B T

@ Keep the ‘'mist’ layer aclive and go to the toolbar ana
choose the Brush Toal {B). In the tool options panel at the
bottom of the screen, choose a large soft brush of about 700
pixels. Keep its opacity at 100%. Make sure the foreground colour

15 white,

< J@ 08 5 o -

| Opacity: [100%

. Normal -

Rename Lavyer...

o t
Duplicate Layer...
= Delete Layer
Group from Layers...
@ 0 cel

@ Take the brush and paint white on the 'mist’ layer around
the upper parlk of the cellist’s outling. You will be painting
over your foreground filgure of course but we can actually use
the mask on the ‘room’ layer below to help us remedy the issue,
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@ Right-click the 'mist' layver and choose the Create Clipping
Mask option from the dropdown meanu that appears. When
vou clip the 'mist’ layer to the 'room' layer, it inherits the mask

as well, Suddenly, the mist 15 appearing behind the cellist even
thouah it i1s an the layer above.



0 The 'mist’ layer will now have small arrow icon next to its @ Mext yvou can add some subtle lighting effects o the
thumbnail to incdicate it 1s clipped to the layer below, AL the candles and windows for a moody feel. Create a new layer
maoment the white brush strokes ook way over the top, Reduce and name it ‘'candles’. Make sure it is at the top of layer stack and
the Opacity to about 40% ang add Gaussian Blur to the mist to active. Go to the toolbar and choose the Brush Tool (B} again if
soften it if yvou want as well rol still selected.

F @ 52.3% (candhles, RGB/MAT * | = re0mjpg & 44 4% (room, REGEE *

| et this as 2 default

D 100% Tablet Settings...

—_— .
= 4

1 Organizer Home Screen

@ n the tool options paneal, chose a soft brush, click on the @ Start to dab yvour white oval brush over sach candle flame
Brush Settings button and change the Houncadness setting I the scene, You can use the Size slider to alter the size
to 50% and the Angle to -90°, This will make the brush owval to match the candle sizes that are dotted around the scene
rather than circular. Set the Size to about 400 pixels and ensure Although the brush strokes are currently white, you can use
that the foreground colour is still white. Stend Modes to get a nice glow on those candles
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TAKE YOUR SKILLS FURTHER

Darken
Multiply
Color Burn
Linear Burn
Darker Color

mist

Lighten '
aScreen &
Color Dodge

Linear Dodge (Add)
Lighter Colar

-

cello

Owverlay

soft Light
Hard Light
Vivid Light

1 R T Tl
inearLight -

S, T (WP

@ With the 'candles’ layver still active go to the blend Made
button and choose Lingar Light from the dropdown list that
appears. There will be no apparent change at the moment but
the next step will create a cosy glow for the candle flames,

Hiugy/Saturation
Learn moré about; Hue/Saturation (6]
Cancal
Master - 3!
Heal
Hue: s E
o)
Saturation: 49
Lightness: =20
.—:‘:—-
& Colorize
[# Preview

@ Go to Enhance > Adjust Colour > Adjust Hue/Saturation
(Cma + LD to call up the Hue/Saturation dialog panel. First,
make sure the Colorize button is checked, Then set Huea to 15,
Saturation to 49 and Lightness to -20. This colours the white
orush strokes orange and blends them into the layers below
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@ You can do a similar technique with the windows. Create a
new layer called 'windows' and use vour oval white brush
to paint large dabs of white on the three main windows. You can
use the Size slider again to adjust brush size to match the size of
gach window,

@ Mow set the Blend Mode of the 'windows' layer to Overlay,
then go to Enhance > Adjust Colour > Adjust Hue/
Saturation (Cmd + U again and click the Colorize button so it is
checked. Make Hue 40, Saturation 70 and Lightness -20 to add a
warm glow to the windows.
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Solid Color, .. -
Gradient... Opacity; | 100% .;
Pattern...
Lewals...

Brightness/Contrast...
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Gradient Map...
Photo Filter.,.

Invert
Threshold...
Posterize...

Narmal - Opacit
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o
Chamnel:  Master - & I“En
Hipa: = —--4:)——— 0
[ §
S-B'tu:'iﬂt!'l: —i:— _ﬂu @ o windows
ummEESI_ .—:hll- i
("] Colorize @ candles

@ Mow, you can add colour effects to tie the foreground and
Dackground elements together. Go to the layer options
panel and click the Create New Fill Or Adjustment Layer button.
Choose Hue/Saturation from the dropdown list that appears.,
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@ A "Hue/Saturation 1" adjustment layer will be added to the
top of the layver stack. All the layers below it will be affected
oy what agjustments are maadge. A dialog panel will open and g
to Saturation and choose a value of about -30 to desaturate the
whale image slightly



COMPOSITE IMAGES

Create ~ Share ~

O GPla a

| Solid Color...
Gradient...
Pattern...

—
Opacity: |[100%

Hue/Saturation
Levels... 2
Brightness/Contrast...

HuefSaturation...
Gradient Map...
Photo Fiiter..

Invert
Threshold... =
Posterize...
—'-—r— :-_--T LTI
@ Mext, go to the laver options panel again and choose
Create New Fill or Adjustment Layer again and Lhis time

select Photo Filter from the list. 'Photo Filter 1" will be added to
the top of the stack. You are going to add a colour cast to tie the
various elements together a bit more,

Phatd Filtar

@ I ] mist

S R

@ The Photo Filter dialogue panel will cpen whean yvou add
tha adjustment layer. Set Filter to Warming Filter (B5),
Density to 100% and make sure the Preserve Luminosity button
Is not checked. The whole image will look dark orange now but
not to worry.

< Bormal
Dizsola

Darkan
BAudtiply
Color Burn
Linear Bum [’
Darker Color

Lighten ]

Scresn windows

Color Dodge
Limear Dodge [Add)
Lighter Color

- candles

E:‘;PP_ .
Soft Light* ;

Hard Light rriist

Vivid Light E
Linear Light
Pin Light

Photo Filter 1

Do Filter

Filter: | Deap Emeraid

Prioto Fifter

n Hue/Saturatij

%FTHEWE Lumingsity

Enable to maintain Image brightness

§

Set the blend Mode for the ‘Photo Filter 1' layer to Overlay

This makes the image very contrasty but if vou set the
layer's Opacity to about 20%, the effect is much more subtle.
You can deepen the colour effect even more, Press Cmd + J to
duplicate the 'Photo Filter 1' layer. Rename it 'Photo Filter 2°.

Lovais | =
- Auto o NC
e
@ 13 5 Photo Filta
Vd | —
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Y |
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095 @ = I Hue/Satur
Output Levels: = |
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You can adjust the brightness by adding ancther

adjustrment. Use a Levels adustment layer and adjust the
Midtone and Highlight sliders to brighten the middle tones and
highlights a little. You can also alter the Shadow Qutput Levels to
about 12 to change the darkest colours to slightly lighter anes.

wonw bdmpublications.com

@ Change its parameters by choosing Deep Emerald as the
Filter type. Density is 100% and now check the Preserve
Luminosity box to maintain image brightness, Set this new layer
to 20% Opacity as well to create a moody image where all the
colours look more harmonious.
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@ Your composite is complete. You can now go to File > Save
As (Shift + Crmid + 5) and save it as a named PSD file. This
saves the layvered document so vou can return to it at any time
and make amendments to the image
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@ TAKE YOUR SKILLS FURTHER

BEFORE AFTER

odging and burning have their roots in the days of analogue photography, long before

digital cameras and computers were in use. Dodging refers to the technique of lightening an
image at the darkroom stage by reducing the exposure of a photographic print in specific areas.
Burning is the opposite, where parts of the image are exposed for longer onto the print, making
those areas darker. With the advent of digital technology the process is done on a computer but
the basic principle and its terminology remain the same. In our example we had a basic image
that was lacking in contrast; using the dodge and burn techniques, brightness and contrast was
selectively added to produce a much stronger image.
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clouds.jpg dodge and

-

o Eagin by opening a relevant image to work on. Go to File =
Cpen (Cmad + O) and navigate to the location of the image

vou wish to work on, Our example is a portrait named 'dodge

and burm.jpg’. Double-click it to open or select it and press Open

at the bottom of the browser window.

DODGING AND BURNING

I._'_ |
nl'_p i -
[ e ———

- . Trrw

= BN

T

o The image were are Using as our example is a moody
portrait but it is guite low in cantrast. You could use levels
adjustments or brightness and contrast, but they are quite globkal
amendgs. Using Dodge and Burn Tools you can be much more
selective in vour approach,

JJe noa @ =
| Normal > |

Qpacity: |10 |;|

o It's good procedure to work on a duplicate of yvour image
rather than your original. You never know when vou might
nead to call upan it. It's better to have it and not need i, than
nead |t and Nnot have ik

Je. Oa 5 W =

L
Create a new layer

Opacity: | 100%

Opacity: |100% |~

o You can use a great little non-destructive method, as we
did, for applyving Dodge and Burn effects to yvour image
without altering its pixel data. Make sure the 'base’ layer is active
and then go to the layer options panel and click the Create A
MNew Layer button. Name this new laver 'dodge’.
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o Right-click yvour 'Background' base layer and choose
Duplicate Layver from the menu that appears. The Duplicate
Laver dialog panel opens ang you can choose a name for your
new layer and then click OK at the top right of the panel. A new
duplicate layer called 'base’ is created for you.

le  Edit
Lindo Name Change #® L

¥ A I
L

image Enhance Layer

Fill Layer
& Learn more about: Fill Layer

Revert

isa ¥ Foreground Color I

Background Color
Blandin  Color...
Moda
Pattern
Fill Layer... . Cpacity
Black

Stroke (Outfhe) Selection..

| | Prese

ey e Ll

White

Letfine Brusn..

Define Pattern...

o zo to Edit = Fill Layer to open the Fill Laver panel. Rather
than selecting the dual options of Foreground Colour or
Background Colour, choose 50% Grey as the fill option. The
reason for this will become apparent in the following steps. The
'dodge’ laver is filled grey, obscuring the portrait for the moment.
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JUenda o=

« MNormal
Dissolve

Darken
Multiply
Color Burn
Linear Burn
Darker Color

Lighten

o Keep the 'dodae’ layver active and go to the Blend Mode
button and choose Owverlay as the blend. Because the gray
is 50% neutral it will not be visible using Overlay as the blending
mode, Anything lighter or darker will have an effect on the layer
balow,. This is key (o the non-destructive method.

thance  Layer
New Layer.. - aRN

Duplicate Layer... Layer rrnrh'-'ﬁm:ki;ruund..-
Delete Layer Eroup...

Group from Layers...

Window Help

Rename Layer...
=i pE Syl i
Layer Style Layer Via Copy

Mew Fill Layer

Menw Layar
MName: |burn I | oK
[ | Uise Previous Layer ta Create CEpping Mask Caaial
Coler:  Mone -

Mode: | Overlay o Unlﬁtri:lﬂﬂjﬂﬁ
%Fm with Owverlay-neutral cotor (50% gray)

o Go to Layer = New > Layer (Shift + Cmd + N). The New
Layer panel will open. Under MName, call the layer 'burn’
Keep Colour as None and under the Mode button, choose
Owverlay as the Blend Mode. Then make sure the Fill with Overlay-
Meutral colour button is checked.

Overlay -

0 Begin by making the 'dodge’ layer active. [t will highlight in
blue to confirm it is active. Go to the toolbar and choosa
the Dodge Tool (D). The tool options panel will show vou the
available parameters you can apply to the Dodge Tool,
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o We neaded a second laver just like the 'dodae’ laver and
could have just pressed Cmd + J to duplicate it but we
wanted to show yvou another method of creating the 50% grey
layer with the blend mode applied and ready to go.

@ A new layer called 'burn’ will be created for you that is
already filleg with 0% grey and set to the Cverlay Blend
Mode. You now have the two layers needed to start Dodaing,
to make the picture lighter and Burning, to make areas of the
nicture darker.
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@ Under Range, choose the Midtones Fainting Mode and
unaer the Brush picker, choose a soft brush of about 200
pixels, You can use the Size slider at any time to alter the brush
size if required and also use the bracket keys [ and | to scale the
orush. Set the brush Exposure to 10% or |ess,



DODGING AND BURNING

@ You can now begin to lighten specific parts of the portrait. @ With each individual stroke of the brush, those light areas
It will be a subjective thing depending on your preferences will be made lighter and lighter. Using an Exposure of 10%
but areas that are currently the lightest can be made lighter to or less means that you can be a bit more subtle and build up the
begin to increase contrast. Start brushing over areas |ike the lightening effect gradually rather than applying it all at once.

forehead, cheelss and nose,

@ Continue to build up the brightness with your brush strokes @ I you press Alt and click the ‘'dodge’ layer thumbnail, you
on the 'cdogge’ layer. Work around the beard, hair and can see exactly what s happening on that laver. Any part of

evebrows to increase the brightness. If vou feel you've applied the image that is lighter than 50% grey has its brightness added
too many brush strokes in one area, you can always press Cmd + to the layer below because of the blending method used. Alt +
Z to undo a number of steps and try again, click again to return to the normal view.

@ Cince an area of the layer is dodged to pure white, it cannot @ If wvou compare the dodged version of the portrait to the
get any brighter. However, if you feel the effect still isn't original you can see how the brightness has been focussed
strong encudah, you can always duplicate the layer for a more on, making the face more three dimensional with the addition
intense effect and adjust the layer opacity if required. of those brightened skin areas. If you are happy with the dodge

effects so far, yvou can turn your attention to the ourn' layer.
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TAKE YOUR SKILLS FURTHER

Overlay v Opacity: |100% j

Layer thumbnail

ws @ Range: | Highiights v sum =
Love: IR -
{Burn Tool (0) | ;

|Painting Mode

mm R

@ Click the "ourn' layer to make it active and swap from
the Dodge Tool te the Burn Tool by eilther pressing O
until the Burn Tool is highlighted or click on its [con in the too
options panel,

@ Start to add brush strokes on the '‘burn’ layer to the darker
areas of the photo, We started around the eves and
darkened the sides of his forehead, under the nose and the sides
of the cheeks. Again, apply the brush strokes singly and build up
the darker areas until you have it as you want it.

@ Because you are working on separate layears, vou can
raturn to the 'dodge’ layer if yvou want, swap the Burn Tool
for the Dodge Tool again and continue to brighten areas of the
image to your taste. In the case of this image, we went back and
brightened the ayves themselves,
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@ Just as with the Dodge Tool, choose Midtones as the
Painting Mode by clicking on the Range button. Keep the
brush as a large soft one and Exposure at 10% or |ower,

@ If vou Alt and click the "burn’ layer, you can view that layer
in isclation. Mow, any dodged area that is darker than 50%
grey is added to the lavers below, darkening the portrait. Alt +
click again to return to the normal view:

@ It it looks like the ‘ourn’ layer effect is too strong, you can
aiwavs click on the layer Opacity slidar and reduce that
laver's opacity to about 70%. we also duplicated the 'dodge’ layer
and set the second layer to 25% opacity for little extra contrast
to the brightest areas.



@ The next few steps are optional and down to parsanal taste,
Go o the layer options panel and click on the Create New
Fill or Adjustrnent Laver button, Select Hue/Saturation from the
menuy that appears to set it as an adjustment layer sbove the
lavers already created.

RGB

& &

0 &_U.EE 215

Output Levels:

@ One additional tweak was to add a Levels adjustment and
push the Highlights and Midtones sliders to the |left; this
helped boost contrast a little more and highlighted all the work
already done with the Dodge and Burn Tools.

DODGING AND BURNING

Normal -
Hue/Saturation =
Channel: Master - e
@ ——
Huﬂ.: . —_—c_ n

Lightness: se— 0

@
=2

@

@ Ae wanted to reduce the saturation of the image a little
When you add an adjustment layver to the layer stack the
properties panel for that laver will be displaved automatically, We
used the Saturation slider to reduce saturation to about -35

@ A side by side comparison now shows how much the image
has been transformed with the use of targeted brightening
of midtones and also selective darkening of certain areas to
increase the overall contrast of the image that wasn't present in
the original.

Harmal ol

® 5 == =
L=} — 1
2 4 =5
e . [ndicates layer visinimy
- E Backgroind &
@ burr
o dadge cogy

dodge and burn adit.psd

With that vour Dodge and Burn project 1s completed. You

have applied some very focussed brightness and contrast
adjue.tme:"lts to brning cut more detaill ang create a more dramatic
looking image.
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@ You can choose to flatten the image, by going to File =
Save As (Shift + Cmid + 5) to create a new file under a new
name, or save the document in its layered form as a Photoshop
compatible PSD file,
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ain is great, as long as you're not caught out in it without your umbrella. It is certainly a

favourite of cinema to add a more brooding feel to a shot. If you’ve ever seen films like Seven
and the Ridley Scott sci-fi classic Blade Runner, you can see that rain is treated almost like a
character in its own right. In this tutorial we are going to show you how you can make your own
rain and take your images to a different level. We have an example shot of a dog looking very
unimpressed by being out in wet conditions. The photo was taken during a lull in the rain, but
perhaps the rain can be started up again, to make the dog even more grumpy.




HOW TO ADD RAIN TO A PHOTO

b

and sonia
160, pg

199369.psd  tree-832079.)pg Untitled_Panc
al.psd

o The process starts, as ever, by going to File > Open and e You will be creating bwo layers of rain. One will contain
navigating to where yvour image is kept, Highlight your srhaller drops which will appear to be further from the
image and press Open or doulle-click it to open it In Elements, viewer, The second layer will be much claser to the viewer and

Our example dog image opens Up ready for a good gownpour, be blurred. To begin, go to the layer options panel and click on
Create A New Laver,

- | v Undo Name Change
— - - = Revert
U J O 0 a 5 0 =
- | Opacity: |100%

 Normal

Fill Laye!
|

& Learn more about: Fill Layet
Use: | Black

S

Fill Layer... Blending
Stroke (Outlibe) Selection... Modéz| Norimal
Define Brush... mmtr_ 100 o
Define Pattern...

[ ] Preserve Transparency

Clear

Color Setungs...
Preset Manager...

Start Dictation...

9 A naw laver will be added above the main image on the

o o to Edit = Fill Laver to open the fill option panel. In the
'Background' layer. Name this new layer 'sharp’. You can Use section, choose Black as the fill colour. Make sure

use this layer 1o add the first of the rain effects by creating small, Blending Mode is Normal, Opacity is 100% and that the Preserve
sharp, drops. Make sure the 'sharp’ laver is active, Transparency box (s unticked. The 'sharp' layer will be filled solid
biack, chscuring the dog for a moment.

L
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TAKE YOUR SKILLS FURTHER

Distribution

9 Mow yvou need to create some raindrops. Go to Filter >
Moise > Add Noise to open the Add Noise panel. You have
a couple of options to adjust to give yvou the correct kind of rain
alements. First, you need to make the Amount 400%, which is
the maximurm Amount you can add.

Filter View Window Help

Blur More ot F
Filter Gallery...

Correct Camera Distortion...

Adjustments
Artistic

Blur

Brush Strokes
Distort
Noise
Pixelate
Render
SKetch
Stylize
Texture
Other

Average

Blur

Blur More
Gaussian BIUr...
Lens Blur...
Motion Blur...
Radial Blur...
Smart Blur...
Surface Blur...

vy vV VvV YyYYyYVYyYVYVYYTYYY

Digimarc

o In order to create the rain particles, the noise on the 'sharp
layer needs to be Blurred slightly. Go to Filter > Blur > Blur
Maore, This adds a small, predefined amount of biur to the noise
to soften it slighthy.
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B8l Amount: [400.00 |%
—)

Distribution
) Uniform

® Gaussian

pnochromatic

o By default, the Distribution value is set at Uniform. You need
samething a bit mare random, so click the Gaussian button
instead, You might notice that the noise has a lot of colour in it
We need to remove that by checking the Monochromatic button
at the bottom of the panel. Click OK to proceed.

Create ~ Share ~

J & La W =
. Solid Color...

Gradient...
Pattern...

Opacity: 100%

Brightness)M ontrast...

Hue/Saturation...
Gradient Map...

o Tha noise doesn't look very much like rain at the moment
but i you go to the layver aptions panel and click on the
Create New Fill Or Adjustment Layer and select Levels, you
can adjust the contrast to make something that locoks more |ike
individual grops.




Opacity: [100% | =

Rename Layer...
Edit Adjustment

Duplicate Layer...
Delete Layer
Group from Layers...

BAC  Disable Layer Mask

Merge Down
Merge Visible
Flatten image

Mo Color
Red
Orange
Yellow

Gresn
Blue

o A 'Lavels 1" adjustment layer will be added. To make sure
the adjustment only affects the 'sharp’ layver, right click
levels 1' and choose Create Clipping Mask from the menu. This
means the adjustment will only affect the layer below to which i
s now clipped.

-1

JJUe da b

+ Normal
Dissolve

Opacity: |100% | ~ |

Darken
Multiply
Color Burn
Linear Burn
Darker Color

M -

Levels 1

Lighten

Whizn yvou have the adjustment as vou like It click on the
'sharp' layer to make it active and then go to the Blend
Mode options button and choose Screen as the blend. When you
do this, only areas that are brighter than 50% grey will be seenin
the imacge,

bdm lications.com
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HOW TO ADD RAIN TO A PHOTO

RGB

ad
L3
1.00
Output Levels:

@ The Levels dialog panel will open whean the layver is created.
If you push the Shadows and Highlights sliders closer to
each other, you will see the effect vou're having on the noise in
the 'sharp’ layer. You need to adjust the sliders so the blurred
noise separates out into small particles.

U Je 08 5%

| Normal

@ You can continue to make further adjustments to the levels

and when you are ready. press the shift key and click both

the 'Levels 1' layer and the "sharg’ layer in order to select them
kroth at once. Both layers should be highlighted in blue,
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TAKE YOUR SKILLS FURTHER

Edit Image Enhance Layer Select Filter View Window

Hotate >

Transform »  Free Transform . ¥T
Crop Skew
Recompose Distort

Divide Scanned Photos Perspective

Resire

Rename Layer..

Duplicate Layers
Delate Layars

Orowp from Layers...

Mode
Convert Color Profile

Create Clipping Mask

Link Layers

mm: JEE : D D D —_—
Marge Visbla 1 @ Bl @ : w:[200ke | +:[2004
Flatten Image ] : O O @ mm
Rotate Scale Skew - ™
ki Color G - D
Red - s
Crange s
Yellow -
Green -  f P .y — = = A
Biue I? : = r"_ ‘..,_-" é-. _l_
| i oBin ‘Tool Options’ Undo  Redo  Rotate Layout Organizer Home S{
@ Hignt-click on these selected layers and choose Marge @ AL the moment, the rain particles look a little small, You
Lavers from the menu to merge them into one layer, When need to make them quite prominent so you can scale the
combined, the layer will default back to a Normal Blend Mode so contents of the 'sharp’ layver. Go to Image = Transform = Free
yvou will need to go back in ang change that back to the Screen Transform (Cmd + T). This tool gives you various options for the
Blend Made again. scaling of the layer contaents.

: | A
- W: [ 200k H:[200.00% | :
P o

F _
E

Commit current operation |

@ In the tool options pane!, you will see the transform options. @ This will scale the contents of the 'sharp’ layer by 2005,
You just want to be able to scale it from its centre. Make making the raindrops much more visible: At the momeant
sure the centre point of the Reference Point Location is clicked thouagh, they look like they are frozen in place. You need to be
and in the width and height boxes enter a value of 200%. Press able to add a little movement to suggest actual rainfall,

the green tick to commit the changes.
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ayer Salect

Filter View

Blur More
Fliter Gallery.

Correct Camera Distartion..

Adjustments
Artistic

Biur

Distort
A
Pixelate
Rendear
Sketch

WwWinag fagtl]

Brush Strokes

Help

EF

Average

Bilur

Biur More
Gaussian Biur...
Lens Blur..
Motion Blur... R
Radial Biur... ™

yY Y Yy Y vy TYyYTYTT YT

Stylize Smart Blur..

0 (o to Filter = Blur > Motion Blur to call up the dialog panel.
Rather than the rain falling vertically. make the Angle about
-56° and the Distance about 40 pixels. Smaller numbers mean
the rain looks quite light and larger numbers give the imprassion
af heavy rain falling quickly, Click OK when reacly.

Window  Help
Matian Blur =F
Fiber Eallany...

ince  Layer Select | Fllter | View

Ad|USTTETE
Artistic

Blur

Brush Strokes
Distart

Holss

Plselata
Rl
Skakch

TY Y TYETYTTFTYTIYFYTYY

L

A

@ A mottled cloud-like pattern will be added to the layer
mask. It 1s randomly comprised of black and white clouds.
This random mask makes the rain appear a little more random
too, since various areas are being concealed or revealed In
cliffering intensities.

wonw bdmpublications.com

U JeRla =

o ’

Add layer mask

Layer mask thumbnail |
Background Ejﬁ.

@ Keep the sharp' layer active and o to the layer oolions
panal and choose Add Layer Mask to do just that, Click on
the layer mask thumbnail (it will highlight with a blue border) and
then go to Filter > Render > Clouds.

Edx o

E = 5

Layout Organizer Home Screen

2)

Rotate

2 C

Redo

@ Keep the layer mask active and go to the toolbar ang chose
the Brush Tool (B). Set the foreground colour to black and
the Size to about 800 pixels. Start to paint black on the laver
mask over the dog and the immediate foreground to give the
illusion that the rain is behind the dog.
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TAKE YOUR SKILLS FURTHER

Skew E;I ‘ A
=, o =N . EBE .ﬂ‘
il Y hﬁl n
Jndo Redo Rotate Layout Organizer Home Screen

Disable Layer Mask

Delete Layer Mask
Apply Layer Mask

Add Mask To Selection

Subtract Mask From Selection

LN LN ] N fb e ol i = | P | W

Mow, vou need the blurred rain for the foreground.

With the 'sharp’ layer active press Cmd + J to create a
duplicate of that layer. Rename it 'blurred’. Right-click the layer
mask and choose Delete Layer Mask as you won't need it for
this layer.

@ Make sure the 'blurred’ laver 1s now active and go to Filter
> Blur > Gaussian Blur to open the blur panel. You want to
make the foreground rain look blurred like it is very close to the

camera, Entering a Radius of about 7 pixels will blur just encugh

to create a sense of depth,
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@ Since this layer will need to appear even closer to the
viewer, it needs to be scaled. Use the method you used
with the first layer ands scale it another 200% from its centre and
press tha green tick to commit those changes when ready.

Y e O0a 5

sceen  ~

@ If the foreground rain looks a little too intrusive, vou can
always go to the Opacity slider and make its opacity about
75% to lessen its visual impact. Now the dog really looks like he
has something to be grumpy about, You could call that done but
there's one little axtra thing to do.




d clouds.jpg

dodge and burn
edit.psd

psd rnpples.jpg

We wanted to make the puddle directly under the dog look

a little more like there was rain falling in it and used another
image to help with that. After going to Flle = Open, we navigated
to where a puddle image with ripples was stored and opened it
in a document of its own.

HOW TO ADD RAIN TO A PHOTO

. —

P~ o S S

@ Press Cmd + A to select all pixels of the ripples image and
than press Cmd + C te copy it. Then go back to the rmain
document and press Cmd + WV to paste the copied pixels onto a
new layer of its own,

Cre cre
U Tge da ks

JJdelhla G

IMd layer mask

Dissolve

Darken
Multiply
Color Burn
Linear Burn
Darker Color

blurred

Linear Dodge (Add)

@ You can press Cmd + T to use the Free Transform Tool to
drag the puddies image control point around to make it fit
over the puddle beneath the dog. You can compress the image
vertically to help match the ripples to the perspective of the main
image. FPress the green tick to commit the changes.

@ You can rename this naw layer 'puddle’. Make sure the laver
mask is active. Choose a large soft black brush and start to
paint out areas where the rippled puddie should not be seen. The
end result of the masking should logk like the example shown.

tions.com

3

@ At the moment the ripples of the second puddle image
look very out of place. Go to the layer options panel anc
click Add Layer Mask to add a mask to the puddie image. Now
go to the Blend Mode buttan and choose Screen from the menu,
This blends the rippled puddile image into the lavers below.

s N 1
_-_.f;l.,‘ ‘-ﬁ‘ni-l— E
K 3

w -e':"'. -- _":"

- =1

.-

@ If this additional effect logks a little too much for the
Image, vou can always recuce the Opacity setlting to about
70%. Now the grumpy dog logks like he has been caught In the
middle of a downpour and probably wants to get home to a
nice warm fira.
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Glossary

For your reference, we have listed many of the terms you'll encounter

as you become

Active layer
The laver currantly selected in the
Layers pans|.

Adjustment layer

A laver that lets vou appky colour
and tonal adjustments to your
mage without permanantly
changing pixel values. Lise
adiustment layers to experiment
with colour ard colour tones. You
can think of an adjustment layer as
a vell through which the underlying
layers are sean

Adobe Bridge

Gridge 153 browser applicaticn
produced by Adobe Systams as
part of the Creative Suite and

5 ususlly Installed alonaside
Photoshop. [ts main function is as
the file management hub of the
Crestive Suite I can ba dsed to
open, manage, rate and rename
files a5 well a5 edil their metadata.

Adobe RGBE

Thie RGE colour space profile by
fdoba Systems, Incorporated. it
provides a large gamut of calours,

Aliasing

Thie ,eﬂuqe;: effect ssan at the
edges of diagonal lines, arcs and so
on -:,du.-e,d by pixels lining upin a
sawrnaoth pattern,

Alpha channels

TH‘ '"_'I”. a- 2] rT d I‘-\._-I 'h'ar I'\-\_rl II_ -llIUIJ
manipulate, isolate and protect
specific parts of your images

Anti-aliasing

The smoothing of jagoed edges
rodigital images by averaang the
colours.af :I"' pixels at a boundary.

Artefact

Sy unexpected and undesired
change load "-Jil:l Mage caused
by incorrect settings or Faulty
processing. Exarmples include
Elaoming, maire, sharpening and
noisg

Aspect ratio

he ratic of an I'T'aq;':: width Lo its
heiaht. It is used to determine how
an image fts on a page or monitor

Background layer

The bottormmost layver i an imags,
usually cantaining the Image data
Ihe B'n:l-: Qround layer 15 always
locked, If vou wanl to change its
Jta_a_nnu arder, plending mode or
apacity, yau must first convert it to
a regular laver

Backlight
Light coming from a source bahind
the phatogragphed subject

Batch processing

Parforming one oF mons 3 rr:-“fu"-?'i
tazks to a selected group of files at
the sames bime.
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Bit depth

The number of colours used to
represent a pizel in an imags, A
I-bit image is Black and white, an
g-bit image can have 256 colours
or shaces of grey and a 16-bit
mage Can have 65536 colours.

Bitmap image

Animaoe consisbing of rows and
columns of _"'n-c:! 5 in computar
memory; alsa called a raster image
Bitmap fle formals include BMP,
GlF JPEG, PS0D, PICT and TIFF

Bits per channel
Determines how many ones each
colour channe!l can contain

Black Point

nimage aditing, the blagk pont

5 @ tonal adjustment that zet= the

point at which the deepest shacaw
detall in the histegramy iz clipped

to black,

EBlending mode

A feature that controls how pixels
inanimage are attected oy a
parting or editing tool The blend
colour s applied 1o the base colour
te L.FL'IULI"L- a new-colour, the result
colour, When applied to Ir.i:."-.-f"c-. a
blending made determines how the
pixels ina layer blend with pixels in
avers berneath it

Brush preset

A prush with preset settings

for size, thickness and so on.
Fhotoshop includes several brush
presets for vou to chooase from and
WOl can Creale a large number of
your own presets as well

Burning
The selective darkening of part of
an image

Camera raw format

A format describing data exacthy as
t 15 captured by a camera sensor,
with no in-g nrrﬂ A DroCessing
applied

Canvas

The workspace ground an existing
imace, within the image window,

| ayer data n"ay e outside the
canvas but it will be clipped to the
canvas when the image is flattensd.
You can change the size and colour
af the canvas.

Channel

A term for describing the colour
data in an image. A black and white
grayscale image has one channel,
an RGE image has three and a

C YR imace has four Ordinarily,

a channel describes either red,
aresn or blue, which are blended (o
create all colours

Clarity
Foung In Adobe Camera Raw, It
behaves like an intelligent version

more experienced with photo editing.

af Contrast and only alters contrast
withim the middle tores of your
mage

Cliphoard

The temporary halding area for
data stored with the Cut or Copy
cormimancs

Clipping

The foss of athar highlight

or shadow details when tane
nformation is forced to pure white
or Dlack,

Clone

To paint with the Clone Stamp 1;-#!.
Yl |||,_|:. safa sampling Eoink o

the active layear hafare el r.n“lr-l' Wwith
the L’=Lanu atamp tool,

CMYK
e '| ‘.._lq-’erf cvellow and black
are the ir ks most printers use to

[ ]f -L1L|._ g colour images, Phatoshop
nciudas full support for ChYK
mode

Colour cast

A unwanted or unexpected calour
shift in-a photo. For examgle, a
photo taken indoors without a
camerd flash may have foo much
wellony

Colour channels

The component colours from which
all cofolrs in animaga are creatad
Usually refers to red, green and blue
(RGE

Colour depth

Measures how much colour
nformation is available to display or
prirt each pesel in an image Greater
calour depth means more available
colours and more acourate colour
representation in the digital image

Colour management

A zvstem yused to achisve consiztent
colour as an image travels from one
device to anather; for example. from
camera to comouter or compuier to
Erriribesr

Colour temperature

The degree of haat, in degreas
Kelvin, that an aobject would have to
absorb before it glowed in a certain
colour. Each colour is assaciateg
with & colour ternpersture, as are
various Kinds of light

Compression
A technigue that reduces the tile size
of bitrmap images

Cropping

Trimrming & portion of an il'nage o
mprove its r.-:n'vnu sitionor bo create
a frame around il

Dithering

The approximabion of an un available
colour through the use of two or
more available colours.

DMG (Digital Negativﬂ}

An open standard file format

develn u—:r.l by Adobe Systems that
provides a 4 alternative 'r' proprietary
Camera raw files

Dodging
The selective hlghteming of any part
of an imagea,

Dots per inch (dpi)

& rmegsure of printer resalution. High
dpi seltings produce prints with fine
clatail, Used for monitors oo

Duotone
& bwo colour greyscale fle that uses
Lo cuskorm inks

EPS

Ence -p~L|I'n_. Fostooript, A file
tormat used to save images that
will by L.'-r:!-f. -| pitlastration and page
lavoul programs

EXIF

Exchargeable Image File Format

y standard Tor simplifying the
exchange of data Detween Cameras
and software. The data may incluce
cameara modal, date arnd time the
photo was laken, camers settings,
shutter speed and 50 on

Exposure

Aomeasura aof tha amount af

hght in which a photo was taken
Underexposad digital photos are [oo
darl, overexposed ones, too light.

Feathering
e softening of anedoe aof 8
b!ﬂlli:dl.;

File Format
The structure of how information
I gncoded in a computer fle. File
farm: 1.q arg 'h—nugn—-f- 1o store
specific types -:-‘ nformation, such as
JPEG and TIF far image or l’:b[f:'f
ata, Al tor vector data and PDF tor
docurnent exchangs

Fill layer

& type af laver that contans a solid
colour, a |.':-::|_|.'I?r'|- or & gradie r'r A% an
interchangeable attribute

Filters

Lise filters o clean up ar retouch

vour photos and apply special
art effects that give your Imaoe &

different appearance

Flattening
Merging of all visible layers into the
Backgraund layver to reduce file size

Font
A et of etfars, numbers
Gamut

He range of colour that a device
Can reoroduce.

Gaussian blur
& softening effect appled through



a bell-shaped distnbution of tones
and colours,

Gradient

Amy of several methods for
achieving a smooth ransition
betwean two adjacent colours,
which alsa include bBlack arnd white

Greyscale

A sinale channel imaoge thal
Iincludes only lack, white and
snades of grey. Depending on the
bt depth, greyscale images can
reproduce a number of shades of
aray

Halftone

A monachrame images made o of
variably sized dots simulating the
shades of grey in a photograph, 1Lis
ysed for reproducing photographs
orn PostScript printers and printing
prasses

HDR (High Dynamic Range)

A process that combinas multiple
erposure varialions of an image o
achigve a dynamic rangs exceeding
that of a single exposure.

Highlight and shadow _
The lightest and darkest colours in
A mage,

Histogram

& bar chart showing the
distribution of the pixel values in a
digital image. The horizontal axis
represents levels from O (darkest)
to lightest (255 and the vertical
Aaxis represents the numbers of
pixels at each level,

Hue

The colaur reflected from or
transmitted through an cbject.

I common use, Hue s the
property that allows a colour o be
distinguished as red, blue, vellow
and so on,

Icc

International Colour Consortium.
ICC device profiles are the industry
standard far repraducing colours
accurately across devices such as
scanners, monitars and prinlars.,

Image cache

& section of hard disk space used
as virtual memory. The image cache
speeds the on-screen redraw of
high-resolution images.

Image mode
I'he colour mode of an image, such
as Grayacalg or RGE

Indexed colour

A colaur that is renderad oy using a
pixel value as an index to a2 panel of
256 or fewer colours

JPEG

Joirt Photographic Expearts
Group. A committes of experts
that develop algorithms far
comprassing computer image files.
Can be any graghic file to which a
JPEG algonthm is applied. JPEG 15
the format generally used to share
phatographs over the web,

JPEG compression
A lossy comprassion techrnigua that
reduces image data and file size.

Layer

& mechanism far overlaying and
comiining multiple images. Layers
are like transparent sheets of glass
that vou can stack and rearrangs.

In addition to ordinary image layers.
there are special kinds of [ayers,

Layer group
& collection of lavers saved with a

Photoshop image.

Layer mask

& profected area Inan adjustrment
laver. Areas below the mask cannot
e sdited,

Levels

Functionality for adjusting colour
and tone. With a Levels adjustment,
you can set shadow and highlight
wvalues to use a full tomal range,
adjust rmiddle tones only, correct
colour casts, and so-on.

Locked layer

A |layer in the Layers panel that has
the fock icon applied, No changes
can be made to a locked laver. A
Background layer is always locked.

Megapixel

& term used 1o describe digital
camera resolution, 1 megagixe!
aquals ans million pieis

Midtone

An area thal falls Betwesen the
brightest highlight and the darkest
shadonw.

Moire

A wawy striped pattern inan mage,
resermnbiing the pattern of watared
sills, Moire can be an arlefact caused
by a camera's inability to capturs the
detail In an image.

Moise

An artefact caused by ntarferancs
OF cameaera arror, Moisa s often saen
as stray pixels of unexpected colour
or a oenerally "grainy” apoearance
Certain comprassion techniques can
amplify naise.

Opacity

The amaount sometfing blocks
light. ¥ou can change the apacity
of layers, filters and effects so that
rnore for lessy of the underiying
image shows through

Owveraxposure

An overexpasad image results from
too much light being allowed to fall
onta the camera sensar,

Panorama

A broad view of a subject, usually

a landscape, made by overlapping
individual shots as they are taken
and than merging them o form ona
wida image.

Perspective

The angle or level fram which a
photograph s taken, the camera-sye
WEEW

Pixel

The hasic, rectangular unit of data
that a digital image cansists of.

The edges of pixels can produce a
sawtooth pattern unless anti-aliasing
5 used

Pixel dimensions

The number of pixels along the
width and height of an image. This is
a measure of the amount of image
data in the pholo, not its physical
size when printed or dizplayved-on-a
monitor,

Pixels per inch (ppi)

A rmessure of image resolution
stored ina camera or comiputer
file. High ppi settings produce
photographs with fine detail and
large file size.

Plug-in

A software application or module
that provides extended and specific
functionality from within a larger
host application

PostScript
A language by Adobe that describes
tho appearance of text. graphic

shapes and sampled images on
printed ar displayved pageas.

Preset

& preset 1s an action that can oe
applied 1o an image or group af
images. You save a group of editing
settings such as colour balance,
brightness, cantrast and saturation,
which can then be applied to your
selected photos

PSD

The pative uncomoressed file farmat
of Adobe Photoshop and Photoshop
Elemants, based onthe TIFF
standard,

Quick mask
& mask channel created in Quick
Mask mode in Photoshop

Raw Files

A Raw fila is the unprocessed data
captured by a digital camera sensor,
In most cases, camearas write Haw
files using a progprietary file format.
Raw files give the photographer

the advantage of managing image
processing during post-production
rather than laething the camera maka
the processing decisions, as happens
when shooting in JPEG format

Red eye

The reflection of the carmera flash
from the retina of a photographed
sulyect, resulting in a red dot 16 the
subject’s eve, You can eliminate

it automatically when you import
imagss or by using the Rad Eve
Remawval tool.

Resample

[o change the resclution of an mage
by chanaging its pixel dimensions,
Downsampling decreases bthe
numoer of pizels and upsampling
increazes the number of pixels

Resolution

A measure of the clarity and
sharpness of an image. In digital
images, it is measured in pixels per
inch.

RGB

A model for representing colours on
a computer display, Red, green, and
bBlue (KGE) are combined in different
proportions o represent any colour.

Rule of Thirds

If you divide an image into three
equal sections both vertically and
horizontally, where the lines intersect
is commonly regarded as good
placement for the subjects in your
photos,

Sample

To select a colour with the
evedropper in order to use it with a
cirawing or painting tool

Saturation
lhe purity, or strength, of a colour.
A fully saturated colour contains no

grey at all.

Selection

A part of an image selected for
rnanipulation of any kind, duplication
in a layer, colour correction, deletion,
rotation and so on,

Shadow Detail

Refers to the amount of detail that
can be seen in the darkest areas of a
photodraph

Sharpening

In phato-editing programs, any
functionality that enhances the
details at the edges of phatographed
chiects and people,

Skewing
Deviation of the content of an image

GLOSSARY

from a vertical ar hanzontal axis.
akewing can be a carmeara effect or
an intenticnally applied effect.

Smoothing

A techmigue for averaqing the values
of neighbouring ixets to reduce
contrast and create a soft, blurry
affect,

Split Toning

This option lets you alter the colaur
aof the shadow and hignlight areas of
your images, For example. you can
add a blue colour cast to the darkest
areas of your photo but make the
prightest areas of the same image
mare orange.

Stroke

An outline round an Image or parl
af an image, ar the characteristics
of the ines created with ane of the
painting oF drawing tools, aspacially
Drushos.

Swatches
Preset colours that you can choose
from in the Colour Swatches pansi,

Thumbnail Image

A small, low resolution image
preview used on the wek o link to a
figh resolution version of the file,

TIFF

Tagged Image File Format. & digital
mage farmat widaly usaed for images
that are 1o be printed or published,
TIFF images can be compressad
lsslasshy,

Transform

Ta scale, shrink, enlarge. skew.
distort, rotate or change the
perspective af a layer, selaction or
shape.

Transparency

In digital photography, the
funclionality that supports
transparent areas in an image or
image fayer, Certain image faormats
do net support transgarency.

Underexposure

An underexposed image results fram
too little Hiaht being allowed to fall
anto the camera zensaor,

Unsharp mask

A technigue that sharpens details in
an mage by increasing the conlrast
between light and dark areas. The
name ongnates from traditionsl
photography, where contrast is
increased by adding a shightly
blurrad negative over the original,

Vibrance

YVibrance iz a form of intelligant
Saturation. As you increase the
Vibrance in an image, only the
middle tones of your image are
altered first

Vignetting
An effect whers the edges of an
image fade aut.

Warping

A distortion of an image, often text,
to conform o a variely of shapes
For instance, a line of text can be
warped in the shape of an arc or
WaEVE.

White balance

A function that compen=ates for
the different rendering af identical
colours under different sources of
llght: incandescent. fluorescent.
cunlicht and 5o on

White point

A reftergnce point used to represant
white, This reference paint 15 usead
to calculate all other colours in the
image.
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